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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Proper use of Siemens products

Trademarks

Note the following:

AAWARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be adhered to. The information in the relevant documentation must be observed.

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG Ordernumber: 6AV6691-1DJ01-0ABO Copyright © Siemens AG 2009.
Industry Sector ® 03/2009 Technical data subject to change
Postfach 48 48

90026 NURNBERG

GERMANY



Preface

Purpose of the operating instructions

These operating instructions provide information for manuals derived from the requirements
for mechanical engineering documentation according to DIN EN 62079. This information
relates to the place of use, transport, storage, mounting, use and maintenance.

These operating instructions are intended for:

® Users

o Commissioning engineers

® Maintenance personnel

Pay particular attention to the section "Safety Instructions (Page 31)".

The help integrated in WinCC flexible, the WinCC flexible Information System, contains
detailed information. The information system contains instructions, examples and reference
information in electronic form.

Required knowledge

General knowledge of automation technology and process communication is needed to
understand the operating instructions.

It is also assumed that those using the operating instructions have experience with personal
computers and knowledge of Microsoft operating systems.

Scope of the operating instructions

The operating instructions apply to the HMI device MP 277 in conjunction with the software
package WinCC flexible.

Position in the information landscape

These operating instructions form part of the SIMATIC HMI documentation. You can obtain
an overview of SIMATIC hardware and SIMATIC software products and SIMATIC systems
and information that can be called up in PDF format in various languages at the following
address:

"http://www.automation.siemens.com/simatic/portal/html_76/techdoku.htm"

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01 3



Preface

Conventions

The following text notation will facilitate reading this manual:

Notation Scope

"Add screen" e Terminology that appears in the user interface, for example
dialog names, tabs, buttons, menu commands

e Required input, for example, limits, tag values.
e Path information

"File > Edit" Operational sequences, for example, menu commands, shortcut
menu commands.
<F1>, <Alt+P> Keyboard operation

Please observe notes labeled as follows:

Note

A note contains important information about the product and its use or a specific section of
the manual to which you should pay particular attention.

lllustrations in this manual

This manual contains illustrations of the described devices. The illustrations may differ from
devices actually delivered.

Trademarks

The following designations marked with the symbol ® are registered trademarks of
Siemens AG:

e HMI®

e SIMATIC®

e WinCC®

o SIMATIC MP 277®

MP 277 (WinCC flexible)
4 Operating Instructions, 03/2009, ASE02479740-01
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Additional information

You can find additional information about products described in the manual under "Contact"

in the following table:

Request

Contact

Contact persons and office locations

"http://www.siemens.com/automation/partner"”

Additional technical documentation

"http://www.automation.siemens.com/portal/index.htm"

Training Center

"http://sitrain.automation.siemens.com/sitrain/"

Technical Support

"http://support.automation.siemens.com"

Online support request form

"http://www.siemens.com/automation/support-request”

Service

"http://www.siemens.com/automation/service"

Recycling and disposal

The HMI devices described in these operating instructions can be recycled due to the low
levels of pollutants. Contact a certified disposal service company for environmentally sound
recycling and disposal of your old devices.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01
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Overview

1.1 Product overview

Possible applications of the MP 277
The Multi Panel MP 277 units are an extension of the 270 series.

The HMI devices are based on the innovative standard operating system, Microsoft
Windows CE 5.0. The Multi Panel MP 277 units belong to the "Multifunctional Platform"
product category. The HMI devices offer enhanced communication options to the office
world. The Pocket Internet Explorer is already installed on the HMI devices.

The MP 277 offers a variety of application uses, high performance and a favorable
cost/performance ratio.

The devices are equipped with:

PROFIBUS port

Ethernet port for connection to PROFINET
e 2 USB ports

® TFT screen with up to 64k color

Thanks to the wide range of devices, you get to use the device that is suited to you.

In addition to the classic HMI application WinCC flexible, the HMI devices also support
additional applications, for example:

® Sm@rtService
® Sm@rtAccess
® OPC server

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01
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Overview

1.2 Design of the HM/I Device MP 277 8" Touch

1.2 Design of the HMI Device MP 277 8" Touch

Front view and side view

SIMATIC MULTI PANEL

st

® Oblong holes for mounting clamps
® Slot for a memory card
® Display / touch screen
@ Mounting seal

Bottom view
©) Oblong holes for mounting clamps
® Interfaces

14
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Overview

1.2 Design of the HM/I Device MP 277 8" Touch

Rear view

) Rating plate

® Slot for a memory card

® DIP switch

® Interface name

® Fixing elements for strain relief
MP 277 (WinCC flexible)
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1.3 Design of the HM/I Device MP 277 8" Key

1.3 Design of the HMI Device MP 277 8" Key

Front view and side view

0] Slot for a memory card

® Display

® Oblong holes for mounting clamps
@ Mounting seal

Bottom view

@ Oblong holes for a mounting clamp

® Interfaces

MP 277 (WinCC flexible)
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Overview

1.3 Design of the HM/I Device MP 277 8" Key

Rear view

O] Rating plate

@) Slot for a memory card

® DIP switch

@ Interface name

® Fixing elements for strain relief
MP 277 (WinCC flexible)

Operating Instructions, 03/2009, ASE02479740-01 17



Overview

1.4 Design of the HM/I Device MP 277 10" Touch

14 Design of the HMI Device MP 277 10" Touch

Front view and side view

SIMATIC MULTI PANEL

@ Slot for a memory card
® Display / touch screen
® Oblong holes for mounting clamps
@ Mounting seal
Bottom view
I LLLLT] T | ]
o il e e gy O
@
©) Interfaces
® Oblong holes for mounting clamps
MP 277 (WinCC flexible)
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Overview

1.4 Design of the HM/I Device MP 277 10" Touch

Rear view

SIEMENS -

P12 Toush
EAV’&O'lSiDCDD‘-‘iAKl

Rating plate

Slot for a memory card

DIP switch

Interface name

Fixing elements for strain relief

®@® e 00
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1.5 Design of the HM/I Device MP 277 10" Key

1.5 Design of the HMI Device MP 277 10" Key

Front view and side view

Display

0] Slot for a memory card
®

® Oblong holes for a mounting clamp
®

Mounting seal

Bottom view

@ Interfaces

@ Oblong holes for a mounting clamp

MP 277 (WinCC flexible)
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1.5 Design of the HM/I Device MP 277 10" Key

Rear view

) Rating plate

® Slot for a memory card

® DIP switch

® Interface name

® Fixing elements for strain relief
MP 277 (WinCC flexible)
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1.6 Accessory kit

1.6 Accessory kit

The accessory kit contains the following:

e Mains terminal for the power supply

® Mounting clamps for mounting the HMI device

Additional documents may be enclosed with the accessory kit.

Mounting clamps

Spring clamps or metal mounting clamps are provided for mounting. The mounting clamps
hook into oblong holes on the HMI device. The main dimensions of the HMI device are not

exceeded by this.

Spring clamp

Metal mounting clamp

@® Slot
® Hook

SO

——@

o)~
@® Threaded pin
® Hook

A product information with notes on mounting of the HMI device with mounting clamps is

supplied with the HMI device.

The product information is available in the Internet at the following links:

® Product Information "Metal mounting clamp":
"http://support.automation.siemens.com/WW/view/en/34915725"

® Product Information "Spring clamp":

"http://support.automation.siemens.com/WW/view/en/34916893"

22
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1.7 Accessories

1.7 Accessories

Accessories are not included in the product package of the HMI device, but can ordered in
the Internet at "http://mall.automation.siemens.com".

Converter RS 422-RS 232

PC/PPI cable

The converter is required for the connection of controllers of other manufacturers. Connect
the RS 422 to RS 232 converter to the RS 422 / RS 485 interface. The converter converts
the input signals to RS-232 signals.

Order number: 6AV6 671-8XE00-0AX0

You need the cable to update the operating system with reset to factory settings. You can
also use the cable for data transfer. Connect the PC/PPI cable to the RS 422/RS 485 port.
The cable converts the input signals to RS-232 signals.

Order number: 6ES7 901-3CB30-0XA0

Note

Set a lower bit rate if the connection is lost during the operating system update. If you use a
high bit rates, you need to use PC/PPI cable version 3 or higher. The version code is printed
on the cable ("E stand 3," for example, corresponds to version 3).

90° elbow adapter

Protective foil

If space is limited, you can use an elbow adapter at the RS 422/RS 485 interface.
Order number: 6AV6 671-8XD00-0AX0

The protective foil prevents the touch screen from being scratched.

Protective foil is available under the following order numbers:

Protective foil HMI device Order number
MP 277 8" Touch 6AV6671-3CC00-0AX0
MP 277 10" Touch 6AV6671-3DC00-0AX0

MP 277 (WinCC flexible)
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1.7 Accessories

Clamping frame

IP65 degree of protection or enclosure type 4X/type 12 can be achieved with a clamping
frame even with little material thickness at the mounting cut-out. For additional information,
see Section Preparing for Mounting (Page 42).

Clamping frames are available with the following order numbers:

Clamping frame for HMI device Order number

MP 277 8" Touch 6AV6671-3CS00-0AX0
MP 277 8" Key B6AV6671-3CS01-0AX0
MP 277 10" Touch B6AV6671-8XS00-0AX0

Memory card

Only use SD memory cards, CF memory cards or MultiMediaCards tested and approved by
Siemens AG.

Service pack
Content of the service package for all HMI devices:
® Mounting seals
® Mounting clamps
® Power supply terminal, 2-pin
Order number: 6AV6671-3XA01-0AX1

MP 277 (WinCC flexible)
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1.8 The HMI device in the operating process

1.8 The HMI device in the operating process

Project design

The HMI device is part of the operating process. The following two phases are key to the
way the HMI device is integrated in the operating process:

® Project design

® Process management

Visualization of the operating process is known as project design. Project design comprises:
® writing project data

® saving project data

® testing project data

® simulating project data

Project design is undertaken independently of the HMI device and results in a project. Once
this has been generated, the project can be transferred to the HMI device to control the
operating process.

L]l = |

[\
Configuring PC HMI device

Process management

Process management is marked by two-way communication between HMI device and
controller. This lays the foundations for operator control and monitoring.

%m Control 1
Control 2
HMI device

The operator can intervene in the operating process on the HMI device for control purposes.
The controller in turn supplies the results of the operating process which are displayed on
the HMI device.

MP 277 (WinCC flexible)
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1.9 Functional Scope with WinCC flexible

1.9 Functional Scope with WinCC flexible

The following tables show the objects that can be integrated in a project for an MP 277.

Messages
Object Specification MP 277
Messages Number of discrete alarms 4 000
Number of analog alarms 200
Length of the alarm text 80 characters
Number of tags in an alarm Max. 8
Display Alarm line, Alarm
window, Alarm view
Acknowledge error alarm individually Yes
Acknowledge multiple error alarms simultaneously 16 alarm groups
(group acknowledgement)
Edit alarm Yes
Alarm indicator Yes
ALARM_S Display S7 alarms Yes
Alarm buffer, Alarm buffer capacity 512 alarms
retentive Simultaneously queued alarm events Max. 250
View alarm Yes
Delete alarm buffer Yes
Print alarm by line Yes
Tags, values and lists
Object Specification MP 277
Tags Number 2048
Limit monitoring Input/output Yes
Linear scaling Input/output Yes
Text lists Number 500"
Graphics lists Number 400
N The maximum total of text and graphics lists is 500.
Screens
Object Specification MP 277
Screens Number 500
Fields per screen 200
Tags per screen 200
Complex objects per screen (for example, bars) 10
Template Yes
MP 277 (WinCC flexible)
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1.9 Functional Scope with WinCC flexible

Recipes
Object Specification MP 277
Recipes Number 300
Data records per recipe 500
Entries per recipe 1000
Recipe memory 64 KB
Storage location e Memory card "
e USB memory stick 9
e Network drive
N The number of recipe data records might be restricted by the capacity of the storage
medium.
Logs
Note
The HMI devices are suitable for the logging of relatively small volumes of data.
Manage the data in several adjacent archives in a segmented circular log. The use of a large
circular log has a negative effect on performance.
Object Specification MP 277
Logs Number of logs 20
Number of partial logs in a segmented circular log 400
Entries per log 10 000
Filing format e CSV with ANSI
character set
Storage location e Memory card "
e USB memory stick )
e Network drive
N The number of entries in the log may be restricted by the capacity of the storage
medium.
Safety
Object Specification MP 277
Safety Number of user groups 50
Number of users 50
Number of authorizations 32

MP 277 (WinCC flexible)
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1.10 Software options

Info texts
Object Specification MP 277
Info texts Length (no. of characters) 320
(depending on font)
For alarms Yes
For screens Yes
For screen objects (for example, for 1/O field, switch, Yes

button, invisible button)

Additional functions

Object Specification MP 277
Screen settings Calibrating the touch screen " Yes
Brightness setting Yes
Language switching | Number of languages 16
VBScript User-specific extension of the functionality Yes
Number of scripts 50
Graphic objects Vector and pixel graphics Yes
Trends Number 300
Scheduler Number of tasks 48
Text objects Number 10 000
Direct keys PROFIBUS DP direct keys Yes
PROFINET IO direct keys Yes

N Only MP 277 Touch

1.10 Software options
The following software options are available for the MP 277:
® Sm@rtService

The Sm@rtService option enables you to access a remote HMI device from the HMI
device or PC via Ethernet.

® Sm@rtAccess

The Sm@rtAccess option enables you to set up communication between different HMI
systems.

® /Audit

The /Audit option extends the HMI device to include functions for recording operations in
an audit trail and electronic signature.

® OPC server (OPC XML)

The OPC-Server option enables you to create communications to OPC-capable
applications from an HMI device or PC via Ethernet.

MP 277 (WinCC flexible)
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1.17 Communications

1.11 Communications

Number of connections
Connection MP 277
Number using a bus connection 6
Number of connections based on "SIMATIC HMI HTTP Protocol" 8

Note

In the following cases, you may not enable PROFINET IO in the Control Panel of the HMI

device:

e Use of PLCs from other manufacturers
e Use of SIMATIC 500/505 via NITP

PLCs

The following table shows the PLCs which can be used with the HMI devices and the
protocols or profiles which can be used.

PLC Protocol MP 277
SIMATIC S7 e PPI Yes
e MPI M
¢ PROFIBUS DP
e TCP/IP (Ethernet)
SIMATIC S5 ¢ PROFIBUS DP Yes
SIMATIC 500/505 e NITP Yes
¢ PROFIBUS DP
SIMATIC HMI HTTP Protocol |e HTTP/HTTPS (Ethernet) Yes
Allen-Bradley PLC series SLC500, SLC501, SLC502, SLC503, Yes
SLC504, SLC505, MicroLogix and PLC5/11,
PLC5/20, PLC5/30, PLC5/40, PLC5/60, PLC5/80
e DF129
e DH+ via KF2 module ¥
e DH485 via KF3 module 4
e DH4854
GE Fanuc Automation PLC series 90-30, 90-70, VersaMax Micro Yes
e SNP
LG Industrial Systems (Lucky | PLC series GLOFA GM (GM4, GM6 and GM7) / Yes
Goldstar) / IMO Series G4, G6 and G7
e Dedicated communication
Mitsubishi Electric PLC series MELSEC FX and MELSEC FX0 Yes
e FX
MP 277 (WinCC flexible)
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1.17 Communications

PLC Protocol MP 277
Mitsubishi Electric PLC series MELSEC FX0, FX1n, FX2n, AnA, AnN, Yes
AnS, AnU, QnA and QnAS
e Protocol 4

OMRON PLC series SYSMAC C, SYSMAC CV, SYSMAC Yes
CS1, SYSMAC alpha and CP

e Hostlink/Multilink (SYSMAC Way)
Modicon PLC series Modicon 984, TSX Quantum and TSX Yes
(Schneider Automation) Compact

e Modbus RTU 9

PLC series Quantum, Momentum, Premium and
Micro
PLC series Compact and 984 via Ethernet bridge

e Modbus TCP/IP (Ethernet)

N Not possible when connected to S7-212.

2) Applies to controllers SLC503, SLC504, SLC505, PLC5, MicroLogix
3) Applies to controllers SLC504, PLC5 over DF1

4) Applies to controllers SLC500 to SLC 505 and MicroLogix

5) Only with converter RS 422-RS 232 6AV6 671-8XE00-0AXO0 (option)

MP 277 (WinCC flexible)
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Safety instructions and approvals 2

2.1 Safety Instructions

Working on the control cabinet

A WARNING

Open equipment

The HMI device is open equipment. This means that the HMI device may only be mounted
in housings or cabinets, whereby the device can be operated from the front panel.

The cubicle or cabinet in which the HMI device is installed may only be accessed with a key
or tool and only by trained, authorized personnel.

Dangerous voltage
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal.

Disconnect the cabinet from the mains before opening it.

Potentially explosive atmospheres

When operating the HMI device in hazardous areas the following warning applies.

A WArRNING

Explosion Hazard

Do not disconnect while circuit is live unless area is known to be non-hazardous.
Substitution of components may impair suitability for Class |, Division 2 or Zone 2.

High frequency ra

diation

NOTICE

Unintentional operating situations

High frequency radiation, for example, from cellular phones, can trigger unwanted operating
states.

MP 277 (WinCC flexible)
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Safely instructions and approvals

2.2 Standards, certificates and approvals

Installation as intended

AWARNING

Installation only in machinery that conforms to the machinery directive

Commissioning the HMI device is prohibited until it has been absolutely ensured that the
machine in which the HMI device is to be installed complies with Directive 98/37/EC or
Directive 2006/42/EC as of December 29, 2009.

2.2 Standards, certificates and approvals

Approvals

A\ caution

The following overview shows possible approvals.

The HMI device itself is certified as shown on the label on its rear panel.

CE approval

The automation system meets the general and safety-related requirements of the following
EC directives and conforms to the harmonized European standards (EN) for programmable
logic controllers published in the official gazettes of the European Union:

® 2004/108/EC "Electromagnetic Compatibility" (EMC Directive)

® 2006/95/EC "Electrical equipment for use within specific voltage limits"
(Low-Voltage Directive)

EC Declaration of Conformity

The EC Declarations of Conformity are available to the relevant authorities at the following
address:

Siemens AG
Industry Sector
1A AS R&D DH A
P.O. Box 1963
92209 Amberg
Germany

MP 277 (WinCC flexible)
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UL approval

CUS
CUS

HAZ. LOC.

FM approval

APPROVED

2.2 Standards, certificates and approvals

Underwriters Laboratories Inc., conforming to

e UL 508 (Industrial Control Equipment)

® (CSA C22.2 No. 142 (Process Control Equipment)
or

Underwriters Laboratories Inc., conforming to

e UL 508 (Industrial Control Equipment)

® (CSA C22.2 No. 142 (Process Control Equipment)
e UL 1604 (Hazardous Location)

® (CSA-213 (Hazardous Location)

Approved for use in

® C(Class I, Division 2, Group A, B, C, D or

® C(Class I, Zone 2, Group IIC or

® non-hazardous locations

Factory Mutual Research (FM) conforming to

® Approval Standard Class Number 3611, 3600, 3810
Approved for use in

® C(Class I, Division 2, Group A, B, C,D T4

® (Class |, Zone 2, Group IIC T4

Marking for Australia

N117

IEC 61131

The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A).

The HMI device satisfies the requirements and criteria conforming to IEC 61131-2,
Programmable Logic Controllers, Part 2: Operating resource requirements and tests.

MP 277 (WinCC flexible)
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2.3 Notes about usage

2.3 Notes about usage

Industrial applications
The HMI device is designed for industrial applications. It conforms to the following standards:
® Requirements for emissions EN 61000-6-4: 2007
® Requirements for interference immunity EN 61000-6-2: 2005

Use in residential areas

Note

The HMI device is not intended for use in residential areas. Operation of an HMI device in
residential areas can have a negative influence on radio/TV reception.

If the HMI device is used in a residential area, you must take measures to achieve Limit
Class B conforming to EN 55011 for RF interference.

Suitable measures for achieving the degree of noise suppression for Limit Class B include,
for example:

® |[nstallation of the HMI device in grounded control cabinets
e Use of filters in electrical supply lines

Individual acceptance is required.

MP 277 (WinCC flexible)
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2.4 Electromagnetic compatibility

24 Electromagnetic compatibility

Introduction

The HMI device fulfills, among other things, the requirements of the EMC law pertaining to
the domestic European market.

EMC-compatible installation of the HMI device

The EMC-compliant installation of the HMI device and the application of interference-proof
cable is the basis for interference-free operation. The "Directives for interference-free
installation of PLCs" and the "PROFIBUS Networks" manual also apply for the installation of
the HMI device.

Pulse-shaped disturbance

The following table shows the electromagnetic compatibility of modules with regard to pulse-
shaped interference. The precondition for electromagnetic compatibility is that the HMI
device meets the specifications and guidelines for electrical installation.

Pulse-shaped disturbance Tested with Degree of
severity

Electrostatic discharge Air discharge: 8 kV 3

in accordance with IEC 61000-4-2 | Contact discharge: 6 kV

Burst pulses 2 kV power supply cable 3

(high-speed transient interference) | 2 kV signal cable, > 30 m

in accordance with IEC 61000-4-4 | 1 kV signal cable, < 30 m

High-power surge pulses in accordance with IEC 61000-4-5, external protective circuit required
(refer to the manual Automation System S7-300, Installation, "Lightning and overvoltage protection”
section)

Asymmetrical coupling 2 kV power cable 3
DC voltage with protective elements

2 kV signal/data cable, > 30 m,
with protective elements as required

Symmetrical coupling 1 kV power cable 3
DC voltage with protective elements

1 KV signal cable, > 30 m,
with protective elements as required

MP 277 (WinCC flexible)
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2.4 Electromagnetic compatibility

Sinusoidal interference

The following table shows the EMC behavior of the modules with respect to sinusoidal
interference. This requires the HMI device to meet the specifications and directives for

electrical installation.

fields) in accordance with
IEC 61000-4-3

Sinusoidal interference Test values Degree of
severity
HF radiation (in electromagnetic | ® 80% amplitude modulation at 1 kHz 3

with 10 V/m in the range of 80 MHz to 1 GHz
with 3 V/m in the range 1.4 GHz to 2 GHz
with 1 V/m the range 2 GHz to 2.7 GHz

e 10 V/m with 50% pulse modulation at 900 MHz
10 V/m with 50% pulse modulation at 1.89 GHz

RF interference current on
cables and cable shielding
conforming to IEC 61000-4-6

Test voltage 10 V, with 80% amplitude modulation 3
of 1 kHz in the 9 MHz to 80 MHz range

Emission of radio interference

The following table shows the unwanted emissions from electromagnetic fields in
accordance with EN 55011, Limit Value Class A, Group 1, measured at a distance of 10 m.

From 30 to 230 MHz

< 40 dB (uV/m) quasi-peak

From 230 to 1000 MHz

<47 dB (pV/m) quasi-peak

Additional measures

If you want to connect an HMI device to the public power supply system, you must ensure
Limit Value Class B in accordance with EN 55022.

36
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2.5 Transport and storage conditions

2.5 Transport and storage conditions

Mechanical and climatic conditions for transportation and storage

This HMI device meets the requirements for IEC 61131-2 relating to transportation and
storage conditions. The following specifications apply to the transportation and storage of an
HMI device in its original packaging.

The climatic conditions conform to the following standards:

e |EC 60721-3-3, Class 3K7 for storage

e |EC 60721-3-2, Class 2K4 for transport

The mechanical conditions correspond to IEC 60721-3-2, Class 2M2.

Type of condition Permitted range
Drop test (in transport package) <1m
Temperature From -20 to +60° C
Atmospheric pressure From 1 140 hPa to 660 hPa,
corresponds to an elevation of =1 000 to 3 500 m
Relative humidity From 10 to 90%, without condensation
Sinusoidal vibration in accordance with 5109 Hz: 3.5 mm
IEC 60068-2-6 9 Hz to 500 Hz: 9.8 m/s?2

Shock in accordance with IEC 60068-2-29 | 250 m/s2, 6 ms, 1 000 shocks

NOTICE

Avoid condensation

If the HMI device is subjected to low temperatures or extreme fluctuations in temperature
during transportation, moisture could occur on or inside the HMI device. Condensation can
occur. This can cause malfunctions.

The HMI device must have acquired room temperature before it is put into operation. Do
not expose the HMI device to direct radiation from a heater in order to warm it up. If there is
condensation, wait approximately 4 hours until the HMI device has dried completely before
switching it on.

Proper transport and storage, installation and assembly as well as careful operation and
maintenance are required to ensure trouble-free and safe operation of the HMI device.

The warranty for the HMI device will be deemed void if these stipulations are not heeded.

MP 277 (WinCC flexible)
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2.5 Transport and storage condifions

MP 277 (WinCC flexible)
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Planning application

3.1 Notes about usage

Mechanical and climatic conditions of use

The HMI device is designed for use in a location protected from the effects of the weather.
The conditions of use meet the requirements for DIN IEC 60721-3-3:

e (Class 3M3 (mechanical requirements)

® (Class 3K3 (climatic requirements)

Use with additional measures

The HMI device should not be used at the following locations unless additional measures are

taken:

® |n locations with a high degree of ionizing radiation

® |n locations with severe operating conditions, for example, due to:
— Corrosive vapors, gases, oils or chemicals
— Electrical or magnetic fields of high intensity

® |n plants that require special monitoring, for example:
— Elevators

— Systems in especially hazardous rooms

Mechanical environmental conditions

The mechanical environmental conditions for the HMI device are specified in the following
table in terms of sinusoidal vibration.

Frequency range Constant Occasional
10Hz<f<58 Hz Amplitude 0.0375 mm Amplitude 0.075 mm
58 Hz < f< 150 Hz | Constant acceleration 0.5 g Constant acceleration 1 g

Reducing vibrations

If the HMI device is subjected to greater shocks or vibrations, you must take appropriate
measures to reduce acceleration or amplitudes.

We recommend mounting the HMI device on damping materials (on rubber-metal vibration
dampers, for example).

MP 277 (WinCC flexible)
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3.1 Notes about usage

Testing mechanical environmental conditions

The following table provides information on the type and scope of tests for mechanical
environmental conditions.

Test for

Test standard

Comments

Vibrations

Vibration test in accordance
with IEC 60068, part 2-6
(sinusoidal)

Type of vibration:

Transitional rate of the frequency:
1 octave/minute.

10 Hz < f < 58 Hz,

constant amplitude of 0.075 mm
58 Hz < f < 150 Hz,

constant acceleration 1 g

Vibration duration:
10 frequency cycles per axis at each of the three
associated vertical axes

Shock

Shock test in accordance
with IEC 60068, Part 2 —29

Type of shock: Half-sine

Shock intensity:
Peak value 15 g, duration 11 ms

Direction of impact:
3 shocks in + direction at each one of the three
associated vertical axes

Climatic environmental conditions

The following table shows the climatic conditions for operation of the HMI device.

Environmental conditions

Permitted range

Comments

Temperature
e Vertical mounting
e Mounting at an angle

From 0 to 50° C
From 0 to 40° C

See the "Mounting positions and
type of fixation" section

Relative humidity

10 to 90%, without condensation

Atmospheric pressure

1140 to 795 hPa

Corresponds to an elevation
of —1 000 to 2 000 m

Pollutant concentration

S02: < 0,5 ppm;
Relative humidity < 60%,
no condensation

Test: 10 cm3/m3; 10 days

H2S: < 0.1 ppm;
Relative humidity < 60%,
no condensation

Test: 1 cm3/m3; 10 days
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Planning application
3.2 Mounting positions

3.2 Mounting positions

Mounting position
The HMI device is suitable for installation in:
® Mounting cabinets
e Control cabinets
e Switchboards
® Consoles

In the following, all of these mounting options are referred to by the general term "cabinet".

The HMI device is self-ventilated and approved for vertical and inclined mounting in
stationary cabinets.

Mounting position Deviation from the vertical
® Inclined <35°
® Vertical 0°
CAUTION

Damage due to overheating

Convection through the HMI device is reduced with installation at an angle.This fact also
reduces the maximum permitted operating temperature for operation.

With sufficient forced ventilation, you can operate the HMI device at an inclined mounting
position up to the permitted ambient temperature for vertical installation.

Otherwise the HMI device may be damaged and the approvals and warranty may become
obsolete.

MP 277 (WinCC flexible)
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Planning application

3.3 Preparing for Mounting

3.3

Preparing for Mounting

Select the mounting location of the HMI device
Points to observe when selecting the mounting location:

Position the HMI device so that it is not subjected to direct sunlight.

Position the HMI device such that it is ergonomically accessible for the user. Choose a
suitable mounting height.

Ensure that the air vents of the HMI device are not covered as a result of the mounting.

Observe the permissible mounting positions for the HMI device.

NOTICE

Stability of the mounting cut-out

The material in the area of the mounting cut-out must provide sufficient strength to
guarantee enduring and safe mounting of the HMI device.

The force of the clamps or operation of the device may not lead to deformation of the
material in order to achieve the degrees of protection described below.

The material thickness at the mounting cut-out must be at least 1.0 mm.

Degrees of protection
The protection ratings are only ensured if the mounting cutout conforms to the following:

42

® Permitted deviation from plane at the mounting cutout: < 0,5 mm

This condition must be fulfilled for the mounted HMI device.
Permissible surface roughness in the area of the seal: < 120 pm (Rz 120)

With IP65 degree of protection or for enclosure type 4X/type 12 (indoor use only), the
material thickness at the mounting cut-out can be a maximum of 6 mm.

Spring clamps or metal mounting clamps, each with or without clamping frames, are used
depending on the material thickness at the mounting cut-out.

The relationships are shown in the table below:

Material thickness Spring clamp Metal mounting clamp | Clamping frame required
1,0 mmto 1,5 mm X X Yes
1,5t0 2 mm X - No
- X Yes
2to4 mm X - No
4 t0 6 mm - X No

The clamping frame is available as an accessory, see section Accessories (Page 23).

MP 277 (WinCC flexible)
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Planning application

Dimensions of the mounting cut-out

The following table shows the dimensions of the required mounting cut-out:

3.3 Preparing for Mounting

Mounting cut-out | MP 277 8" Touch MP 277 8" Key |MP 277 10" Touch | MP 277 10" Key
Width 226*" mm 338*1T mm 310*" mm 434+ mm
Height 166*" mm 206 *" mm 248*1 mm 291*" mm
Depth 61 mm 61 mm 61 mm 60 mm

Mounting compatibility

The mounting cut-outs of the Multi Panels are compatible with the mounting cut-outs of the
following SIMATIC HMI devices:

Multi Panel mounting cut-out

Compatible to the mounting cut-outs of the HMI device

MP 277 10" Touch

Thin Client 10" Touch
KTP1000 Basic
TP 270 10"

MP 270B 10" Touch

MP 277 INOX 10" Touch

MP 377 12" Touch

MP 277 10" Key

MP 270B 10" Key

OP 270 10"

Maintaining clearances

The HMI device must be installed with the following clearances:

e Always allow 50 mm above and below the mounting cutout respectively for ventilation

e Right and left of the mounting cut-out respectively for attaching the mounting clamps:

— When using a clamping frame: 25 mm each

— Without clamping frame, with spring clamps: 25 mm each

— Without clamping frame, with metal mounting clamps: 15 mm each

® At least 10 mm behind the rear panel of the HMI device

NOTICE

Ensure that the maximum ambient temperature is not exceeded when mounting the
device in a cabinet and especially in a closed enclosure.

MP 277 (WinCC flexible)
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Planning application
3.4 Specifications for Insulation Tests, Protection Class and Degree of Protection

34 Specifications for Insulation Tests, Protection Class and Degree of
Protection
Test voltages

Insulation stability is demonstrated in the type test with the following test voltages in
accordance with IEC 61131-2:

Circuits with a nominal voltage of Ue to other | Test voltage
circuits or ground

<50V 500V DC

Protection class

Protection Class | in accordance with IEC 60536, i.e. protective conductor connection to
profile rail required.

Protection against foreign objects and water

Degree of protection in accordance with Explanation

IEC 60529

Front When mounted:
e |PG5

e Enclosure Type 4X/Type 12 (indoor use only)

Rear panel IP20

Touch protection test with standard test probes.
There is no protection against ingress by water.

The degree of protection provided by the front side can only be guaranteed when the
mounting seal lies completely against the mounting cut-out.

3.5 Rated voltages

The following table shows the rated voltage and the corresponding tolerance range.

Nominal voltage Tolerance range
+24 VDC 20.4 V10 28.8 V (-15 %, +20 %)

MP 277 (WinCC flexible)
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Mounting and connecting 4

4.1 Checking the package contents

Check the package contents for visible signs of transport damage and for completeness.

NOTICE

Damaged parts
A damaged part will cause the HMI device to malfunction.

Do not install parts damaged during shipment. In the case of damaged parts, contact your
Siemens representative.

The following is supplied along with the HMI device:

o HMI device

® Accessory kit with mounting clamps and mains terminal

Additional documents may be included in the product package of all HMI devices.

The documentation belongs to the HMI device and is required for subsequent
commissioning. Retain all enclosed documentation for the entire service life of the HMI

device. You must pass on the enclosed documentation to any subsequent owner or user of

the HMI device. Make sure that every supplement to the documentation that you receive is
stored together with the operating instructions.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01
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Mounting and connecting

4.2 Mounting the HMI Device

4.2 Mounting the HMI Device

Requirement

Mounting

46

All packaging components and protective foils should be removed from the HMI device.

To install the HMI device, you need the mounting clamps from the accessories. The
mounting seal must be fitted on the HMI device. If the mounting seal is damaged, order a
replacement seal. The mounting seal is part of the associated service pack.

NOTICE

Always mount the HMI device according to the instructions in this manual.

Proceed as follows:

1.

Check that the mounting seal is fitted on the HMI device.

Do not install the mounting seal turned inside out. This may cause leaks in the mounting
cut-out.

2. Insert the HMI device into the mounting cutout from the front.

3. Insert a mounting clamp into a recess on the HMI device.

4. Fasten the mounting clamp as described in the corresponding product information. The

product information on metal mounting clamps or spring clamps is available in the
Internet at the following link:

— Product Information "Metal mounting clamp":
"http://support.automation.siemens.com/WW/view/en/34915725"

— Product Information "Spring clamp":
"http://support.automation.siemens.com/WW/view/en/34916893"

. Repeat steps 3 and 4 for all mounting clamps that are required for the installation of the

HMI device.

NOTICE

Check the fit of the mounting seal on the front. The mounting seal must not protrude
from the HMI device.

Otherwise, repeat steps 1 to 5.

MP 277 (WinCC flexible)
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Mounting and connecting

4.2 Mounting the HM/ Device

Positions of mounting clamps on the MP 277 8" Touch

You will need 10 mounting clamps in total. The following figure shows the positions of the
mounting clamps.
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Positions of mounting clamps on the MP 277 10" Touch

You will need 12 mounting clamps in total. The following figure shows the positions of the
mounting clamps.
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Mounting and connecting

4.2 Mounting the HMI Device

Positions of the mounting clamps on the MP 277 8" Key

You will need 14 mounting clamps in total. The following figure shows the positions of the
mounting clamps.

[> 1-2 :> 9-11 [> 17-19 4-6 <j
Hq (| IIIIPHIITIIIH?H IIIIIIIIIIIPHIIE%

Pﬂllllpﬂllllluq
?
|
|
|
1
|
|
I
\
|
|
|
|
|
|
|
1

o

11 H nd 11 nd G

Positions of the mounting clamps on the MP 277 10" Key

You will need 10 mounting clamps in total. The following figure shows the positions of the
mounting clamps.
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Mounting and connecting

4.3 Connecting the HMI device

4.3 Connecting the HMI device

431 Overview

Requirement

® The HMI device must be mounted according to the specifications of these operating
instructions.

e Always use shielded standard cables.

Additional information is available in the catalog and online order system at
"http://mall.automation.siemens.com".

Connection sequence

NOTICE

Damage to the HMI device

If you do not keep to the connection sequence you could damage the HMI device.

Ensure you connect the HMI device in the sequence described above.

1. Equipotential bonding
2. Power supply

Perform a power-up test to ensure the power supply is connected with the correct
polarity.

3. Controller
4. Configuration PC as necessary
5. 1/Os as necessary

Disconnect the HMI device by completing the above steps in reverse order.

Connecting the cables

When connecting the cables, ensure that the contact pins are not bent. Secure the cable
connectors by screwing the connector onto the socket.

See also
Safety Instructions (Page 31)

MP 277 (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HM/ device

43.2 Ports
The following figure shows the interfaces of the MP 277 HMI device.

0] Power supply connector
® RS-422/RS-485 interface X10 / IF1b
® Ethernet interface
O] USB ports X20 and X21
See also
Power supply (Page 260)

X10/IF 1B (RS 422/RS 485) (Page 260)
X20, X21 (USB) (Page 261)
X1 (Ethernet/LAN) (Page 261)

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

43.3 Connecting the equipotential bonding circuit

Differences in electrical potential

Differences in potential may occur between spatially separated system parts. Such
differences in electrical potential can lead to high equalizing currents over the data cables
and therefore to the destruction of their interfaces. Equalizing currents can develop if the
cable shielding is terminated at both ends and grounded to different parts of the system.

Differences in potential can develop when a system is connected to different mains.

General requirements of equipotential bonding

Differences in electrical potential must be reduced using equipotential bonding to ensure
trouble-free operation of the relevant components of the electronic system. The following
must therefore be observed when installing the equipotential bonding circuit:

MP 277 (WinCC flexible)

The effectiveness of equipotential bonding increases as the impedance of the
equipotential bonding conductor decreases or as its cross-section increases.

If two plant parts are interconnected by means of shielded data cables and their shielding
is bonded at both ends to the grounding/protective conductor, the impedance of the
additionally installed equipotential bonding cable must not exceed 10% of the shielding
impedance.

The cross-section of a selected equipotential bonding conductor must be capable of
handling the maximum equalizing current. Experience has shown that equipotential
bonding conductors with a minimum cross-section of 16 mm? should be fitted between
the control cabinets or the ground point of the supporting arm or the stand for PRO HMI
devices.

Use equipotential bonding conductors made of copper or galvanized steel. Establish a
large surface contact between the equipotential bonding conductors and the
grounding/protective conductor and protect them from corrosion.

Use a suitable cable clip to clamp the shield of the data cable flush to the equipotential
bonding rail. Keep the length of cable between the HMI device and the equipotential
bonding rail as short as possible.

Route the equipotential bonding conductor and data cables in parallel and with minimum
clearance between them.

Operating Instructions, 03/2009, ASE02479740-01 51



Mounting and connecting

4.3 Connecting the HMI device

Configuration graphic

@E [

Chassis terminal on the HMI device, example

Equipotential bonding conductor cross-section: 4 mm?2
Control cabinet

Equipotential bonding conductor cross-section: min. 16 mm?2
Ground connection

Cable clip

Equipotential bonding rail

CNCNCNCNONCECNC)

Parallel routing of the equipotential bonding conductor and data cable

CAUTION

Damage to the interface modules possible

Cable shielding is not suitable for equipotential bonding.

Use only the prescribed equipotential bonding conductors. The equipotential bonding
conductor ® must have a minimum cross-section of 16 mm?. The interface modules may
otherwise be damaged or destroyed.

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

434 Connecting the Power Supply

Configuration graphic

The following figure shows the connection of the HMI device and the power supply.

| N |
=)= MP 277 8* Touch
I}

- -

1'

== I

| MP 277 8" Key

|uuuuuu e o |
nooooo i1} “
poooooonooooOoOODOODODOOOO MP 277 10" Touch
000000000000000000000 DOODODDODOOOOODOOOOODD
’J_\ H=a MP 277 10* Key
H H [ 'H H L 1 I IH H I H

| — -

Note when connecting

The mains terminal for connecting the power supply is contained in the accessory kit. The
mains terminal is designed for cables with a maximum cross-section of 1.5 mm>.

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Connecting the mains terminal

NOTICE

Damage

Do not tighten the screws of the power supply terminal if it is plugged into the HMI device.
The pressure from the screwdriver may otherwise damage the HMI device socket.

Only connect the wires when the mains terminal is withdrawn.

p GND

+24 VDC

Connect the power supply terminal to the cables of the power supply as shown in the figure
above. Ensure that the lines are connected properly to the correct terminals. Refer to the
label for the contact pins on the rear of the HMI device.

Reverse polarity protection
The HMI device is equipped with reverse polarity protection.

Connecting the power supply

CAUTION

Safe electrical isolation

Use only 24 VDC power supply units with safe electrical isolation in accordance with
IEC 60364-4-41 or HD 384.04.41 (VDE 0100, Part 410), for example, in accordance with
the PELV standard.

The supply voltage must be within the specified voltage range. Malfunctions in the HMI
device may otherwise result.

Applies to non-isolated system design:

Connect the connection for GND 24 V from the 24 V power supply output to equipotential
bonding for uniform reference potential. You should always select a central point of
termination.

See also
Ports (Page 50)

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

435 Connecting the PLC

Configuration graphic

The following figure shows the connection of the HMI device and the controller.
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Mounting and connecting

4.3 Connecting the HMI device

NOTICE

Use only the approved cables to connect a SIMATIC S7 controller.

Standard cables are available for the connection. You can find additional information on this
in the Internet at "http://mall.automation.siemens.com".

Connecting PROFINET

NOTICE

Use a cross-cable for the PROFINET connection when using a point-to-point connection.

NOTICE
PROFINET 10

If you use PROFINET IO direct keys, the HMI device must be connected with a switch. For
detailed instructions regarding the installation of PROFINET networks, please refer to the
PROFINET system description manual.

Only connect the HMI device to public Ethernet networks using a switch or comparable
device.

MP 277 (WinCC flexible)
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Mounting and connecting

Configuring an RS-422/RS-485 interface
A DIP switch for the configuration of the RS-422/RS-485 interface is located on the back of

See also

the HMI device.

4.3 Connecting the HMI device

In the factory state, the DIP switch is set for communication with the SIMATIC S7 PLC via

RS 485.

Note

Note the diagrams of DIP switch settings on the rear panel of the HMI device.

The following table shows the DIP switch settings. The send and receive direction is toggled
internally by the RTS signal.

Communication | Switch setting Meaning
RS 485 4321 No RTS on plug, for data transfer between PLC and
HMI device
ON (factory state)
4321 RTS on pin 4, same as PLC,
for example for commissioning
on
4321 RTS on pin 9, same as programming device,
for commissioning, for example
on
RS 422 4321 RS-422 interface is active.
on

Ports (Page 50)

Accessories (Page 23)

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

4.3.6 Connecting a Configuring PC

Configuration graphic
The following figure shows the connection of the HMI device and the configuration PC.
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Use a cross-cable for the PROFINET connection when using a point-to-point connection.
The interfaces are described in the specifications.
For RS-485-RS-232 conversion, you can order the PC/PPI cable from Siemens AG.

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Configuring the PC/PPI cable
Use the DIP switches to configure the transfer rate of the PC/PPI cable.

Note

Set a lower bit rate if the connection is lost during the operating system update. If you use a
high bit rates, you need to use PC/PPI cable version 3 or higher. The version code is printed
on the cable ("E stand 3," for example, corresponds to version 3).

@ DIP switch
@) LEDs

Set the DIP switches 1 to 3 to the same value as in WinCC flexible. DIP switches 4 to 8 must
be set to "0".

L LET T e

12345

) DIP switch
The following bit rates can be set:

Bit rate in kbps DIP switch 1 DIP switch 2 DIP switch 3
115.2 1 1 0
57.6 1 1 1
38.4 0 0 0
19.2 0 0 1
9.6 0 1 0
4.8 0 1 1
2.4 1 0 0
1.2 1 0 1

In the figure, the bit rate is set to 115.2 kbps.

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Note when connecting

NOTICE

USB connection sequence

Observe the following sequence when connecting by USB:
1. HMI device

2. PC

USB host-to-host cable

Use only the driver for the USB host-to-host cable that is included in the WinCC flexible
package. Never use the driver supplied with the USB host-to-host cable.

Update operating system.

If there is no serviceable HMI device image on the HMI device, you can only update the
operating system by restoring the factory setting. Use the RS-422/485 interface with the
PC/PPI cable on the HMI device.

Replacing the HMI device

If you connect more than one HMI device with the same IP address in succession to a
single configuration PC, you need to ping the configuration PC once from the HMI device
on each time you replace the HMI device.

See also
Accessories (Page 23)
Ports (Page 50)

MP 277 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

43.7 Connecting a USB device

Note
Use only devices approved for connection to the HMI device.

The list of devices approved for connection to HMI devices via the USB port is available in
the Internet at "http://support.automation.siemens.com/WW/view/en/19188460" and
"http://support.automation.siemens.com/WW/view/en/11376409".

Below are examples of devices you can connect to the USB port of the HMI device:

See also

Mouse

Keyboard

Printer

Industrial USB Hub 4
USB memory devices

Barcode reader

NOTICE

Malfunction from external device possible

If you connect external devices with their own power supply to the USB port and without
using an non-insulated installation, you may experience functional problems.

If you wish to connect external devices with their own power supply to the USB port,
ensure that the installation is non-isolated.

NOTICE

Rated load of the interface

Malfunctions may occur on a USB device that presents an electrical overload on the
port.

Adhere to the values for the maximum load on the USB port.

Connecting the Power Supply (Page 53)
X20, X21 (USB) (Page 261)

MP 277 (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

4.3.8 Connecting a Printer.

Configuration graphic
The following figure shows the connection of the HMI device and the printer.
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Note when connecting

NOTICE

Use only cables with metal-braided shielding grounded at both ends to connect the HMI
device and printer.

Use a cross-cable for the Ethernet connection when using a point-to-point connection.

Some printers may require the ASCII character set used in the project to also be defined on
the printer.

You can find the list of current printers and required settings for HMI devices in the Internet
at "http://support.automation.siemens.com/WW/view/en/11376409".

Read the documentation supplied with the printer when connecting it.

MP 277 (WinCC flexible)
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Mounting and connecting
4.4 Swifching on and Testing the HMI device

See also
Ports (Page 50)
Connecting a USB device (Page 61)

4.4 Switching on and Testing the HMI device

Procedure
Proceed as follows:
1. Switching on the power supply.

The screen lights up after power is switched on. A progress bar is displayed during
startup.

If the HMI device fails to start, you have probably crossed the wires on the mains
terminal. Check the connected wires and change their connection. The Loader opens
once the operating system has started.

Transfer

Skart

Contraol
Panel

Taskbar

The HMI device automatically switches to "transfer" mode during initial startup under the
following conditions:

— No project is loaded on the HMI device.
— At least one data channel has been configured.

During this process the following dialog appears:

Zonnecting ko host ..

Zancel

2. Press "Cancel" to stop the transfer.

MP 277 (WinCC flexible)
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Mounting and connecting

4.5 Securing the cables

Result

Function test

The Loader appears again.

Note

When restarting the system, a project may already be loaded on the HMI device. The system
then skips "Transfer" mode and starts the project.

Use the relevant operator control to close the project.

Refer to your plant documentation to find any available additional information on this topic.

Perform a function test following commissioning. The HMI device is fully functional when one
of the following states is indicated:

® The "Transfer" dialog is displayed.
® The loader is displayed.

® A project is started.

Shutting down the HMI device

Terminate the project at the HMI device before switching it off.
You have the following options for switching off the HMI device:
e Switch off the power supply.

® Remove the mains terminal from the HMI device.

4.5 Securing the cables

64

After the power-on test, to ensure strain relief, use cable ties to secure the connected cables
to the marked fixing elements.

L

Gl T
Ve
s -

5 = B

E E £33 - Fastening element

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01



Operator controls and displays 5

5.1 Front operator controls

MP 277 Touch

) Display with touch screen

The assignment of the operator controls for the MP 277 8" Touch and the MP 277 10" Touch
is basically the same.

You can operate the MP 277 Touch using the touch screen. All operator controls required for
operator input are displayed on the touch screen once the HMI device has started.

MP 277 Key

uﬂuuuuu'_u']q

Function keys with LED

Display

Function keys without LED
System keys - alphanumeric keys
System keys - control keys

®@Oe 60600 06

System keys - cursor keys

MP 277 (WinCC flexible)
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Operafor controls and displays

5.1 Front operator confrols

See also

66

The assignment of the operator controls for the MP 277 8" Key and the MP 277 10" Key is
basically the same.

The MP 277 Key is operated using the system keys and the function keys.

The function assigned to a specific function key is defined during configuration. The function
keys have no function prior to the project being opened.

NOTICE

Unintentional action possible

Do not carry out several operations simultaneously. You may otherwise trigger
unintentional actions.

¢ Using the touch screen: Always touch only one operator control on the screen.
e Using the keys: Do not press more than two keys simultaneously.

NOTICE

Damage to the touch screen possible

Never touch the touch screen with pointed or sharp objects. Avoid applying excessive
pressure to the touch screen with hard objects. Both these will substantially reduce the
useful life of the touch screen and even lead to total failure.

Always operate the HMI touch screen with your fingers or with a touch pen.
Damage to the keyboard
Use only your fingers to operate the keys of your HMI device.

Using hard instruments to press the keys considerably reduces the service life of the key
mechanism.

Design of the HMI Device MP 277 8" Touch (Page 14)
Design of the HMI Device MP 277 8" Key (Page 16)
Design of the HMI Device MP 277 10" Touch (Page 18)
Design of the HMI Device MP 277 10" Key (Page 20)
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5.2 Using Memory Cards with the HMI Device

5.2 Using Memory Cards with the HMI Device

Introduction

The following can be saved to the memory card of the HMI device:

HMI device image (backup)
Logs

Recipes

Operating system
Applications

Additional specifications

The memory card can be inserted and removed during operation. Do not remove the
memory card while data is being accessed by an application, for example during backup or
recipe transfer.

NOTICE

Multimedia card
The multimedia card of the SIMATIC S7 controller is not compatible with the HMI device.

Procedure - inserting a memory card
Proceed as follows:

Insert the memory card into the memory card slot.

O]
®

Memory card
Memory card slot

When inserting the memory card, please note that it can only be inserted as shown in the
diagram. When the memory card is correctly inserted into the slot, it stands approx. 3 mm
proud of the slot.

MP 277 (WinCC flexible)
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5.2 Using Memory Cards with the HMI Device

Using a memory card for the first time

NOTICE

Data loss

The first time you use a memory card the HMI device will request that you format the card.
Save a backup copy of memory card data to a PC beforehand.

Proceed as follows in order to prevent data loss:
1. Cancel the formatting procedure by pressing "ESC".
2. Save a backup copy of vital data to a PC.
3. Format the memory card on the HMI device.
4. Transfer the backup data from the PC to the memory card.
You can now transfer the backup data from the memory card to the HMI device.

Procedure — removing a memory card

NOTICE

Data loss
The data on the memory card may be lost if you attempt to remove it while the HMI device
is accessing its data.

Do not remove the memory card while data is being accessed. Observe the corresponding
alarms on the screen.

Proceed as follows:
1. Unplug the memory card from the memory card slot.

2. Store the memory card in a safe place.

MP 277 (WinCC flexible)
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5.3 Labeling the Function Keys at the MP 277 Key

5.3 Labeling the Function Keys at the MP 277 Key

Introduction

You can label the function keys as required for your project. Use the labeling strips for this
purpose.

Note
Do not write on the keyboard to label the function keys.

Any printable and writable foil can be used as labeling strip. The permitted thickness of the
labeling strip is 0.13 mm. Paper labeling strips are inappropriate.

You can use transparent foil, the keyboard membrane of the HMI device is printed on the
reverse side. Use transparent foil so that the LEDs of the function keys can be seen.

Printing labeling strips

WinCC flexible comes with a range of labeling strip templates. You will find further
information regarding the location of the templates in the WinCC flexible Online Help.

MP 277 (WinCC flexible)
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5.3 Labeling the Function Keys at the MP 277 Key

Dimensions of the labeling strip for the MP 277 8" Key

14.5 2 x45°
16_4
19.5 | 19.5 | 19.5 | 19.5 7.8

203

2 x45°

16

19.5 7.8
80
Dimensions of the labeling strip for the MP 277 10" Key
15.5 R0.5
‘o)
S 17
(m] (m] T
8.5 23.5 | 235
93.15
15.5 R0.5
Yo]
S 17
o o o | o | o | o =
8.5 232 | 232 | 232 | 232 | 232
e \ \ \ \
248.9
MP 277 (WIinCC flexible)
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Procedure

5.3 Labeling the Function Keys at the MP 277 Key

Proceed as follows:

1.

Edit the template and then it on the foil.
Another option is to print blank templates and later label them manually.
Apply a fixing spray to the labeling strips.

The fixing spray ensures that the text is water resistant and does not smear, and that the
printer ink on the keyboard membrane does not run.

Cut out the labeling strip.

Ensure that the corners are cut according to the diagram shown above as this makes it
easier to slide them into the slot.

Remove any existing labeling strips.

Note
Wait for the printed labeling strips to dry before you insert them.

Slide the labeling strips @ into the slot @®.

Slide the labeling strips into the slot up to the stop.

The labeling strip will protrude approximately 3 cm out of the slot. The template
dimensions for the labeling strips are designed so that the labeling is correctly placed for
the function keys. It is not necessary to secure the labeling strip.

When mounting the HMI device, ensure that the labeling strips do not become jammed
between the mounting cut-out and the HMI device.

MP 277 (WinCC flexible)
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5.3 Labeling the Function Keys at the MP 277 Key
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Configuring the operating system 6

6.1 Loader

Loader
The following figure shows the loader.

Transfer
Skart
Contral
Panel
Taskbar

The loader buttons have the following functions:
® Press the "Transfer" button to set the HMI device to "Transfer" mode.

The transfer mode can only be activated when at least one data channel has been
enabled for the transfer.

® Press the "Start" button to start the project on the HMI device.

If you do not perform an operation, the project on the HMI device will automatically start
after a delay.

MP 277 (WinCC flexible)
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Configuring the operating system

6.1 Loader
® Press the "Control Panel" button to open the Control Panel of the HMI device.
You can change various settings in the Control Panel, for example, the transfer settings.
® Press the "Taskbar" button to activate the taskbar with opened Windows CE Start menu:
€
My
Computer
Transfer
Start
TaskBar
" Control
K| Pans
secUre mode
Taskbar
& Programs ) B corrrmand Prormpt
fa Favorites L4 ﬁ Internet Explorer
D Documents * afg’i Softkeyboard
[F Settings * 8 Windows Explorer
&7 Run...
I_I;Dader
Open loader

The following options are available to open the loader:
® The loader appears briefly after starting the HMI device.
® The loader appears when the project is closed.
If configured, use the relevant operator control to close the project.

Refer to your plant documentation to find any available additional information on this
topic.

Key operation in the loader

The following table shows the key combinations for navigating in the loader.

Key combination Function
Iz' IZ' The next or previous entry is selected.
- The selected button is operated.

MP 277 (WinCC flexible)
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6.1 Loader

Protection against unauthorized use
You can protect the control panel against unauthorized access by using a password.

You can also protect the taskbar and the Desktop with the help of SecureMode. If the HMI
device is protected, "secure mode" is displayed on the Windows CE desktop. You can find
additional information on this in the section "Setting up and disabling SecureMode

(Page 77)".

The "Transfer" and "Start" buttons can always be used without having to enter a password.

Password protection prevents maloperation. This increases the security of the system or

equipment because settings for the current project can only be changed after entering the
password.

NOTICE

Loss of data possible

If the password is no longer available, you can only cancel password protection by updating
the operating system. All data on the HMI device will be deleted when you update the
operating system.

Back up the HMI device's data.

Pocket Internet Explorer

The Pocket Internet Explorer is installed on the HMI device.

| view Tools ”[I“Ql@lﬁlﬂ;l ‘

[I]Address I Wwwincowesydefault EI

Welcome to Microsoft Pocket Internet Explorer

.-ﬂ
2y

&
icrosoft: '-f
Wit .CE

@ 2004 Microsoft Corporation. ANl rights reserved, Terms of use,

Note

The Pocket Internet Explorer and the PC version of the Internet Explorer differ in terms of
functional range.

Internet Explorer for Windows CE has separate proxy settings that are independent of the
settings in the control panel of the HMI device.

You can find additional information at the Microsoft's website.

MP 277 (WinCC flexible)
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6.1 Loader

Key operation in the user interface
The following table shows the key combinations for navigating in the user interface.

Key combination Function

g The task bar is activated with the open Windows CE start menu.
N The next active program is displayed.
.\ The Task Manager is opened.

Key operation in the Explorer
The following table shows the key combinations for navigating in the Explorer.

Key combination Function

e Toggles the active window.
e Toggles between the Windows CE Desktop and the window.

. Selects the first entry.
Selects the last entry.
N | +

CTRU & | [ Selects everything, if the left LED of the key lights up

TAB

Activates the menu bar.

Changes to the higher level.

ALT
-
L lerre Opens the shortcut menu.

Displays the properties.

See also
Switching on and Testing the HMI device (Page 63)
Configuring the data channel (Page 115)
Changing Password Protection (Page 94)

MP 277 (WinCC flexible)
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6.2 Setting up and disabling SecureMode

6.2 Setting up and disabling SecureMode

Overview

You can protect the control panel against unauthorized access with a password. You can
also protect the taskbar and the Desktop with the help of the SecureMode.

Function of SecureMode

You set up SecureMode by setting up a password in the control panel. SecureMode is then
automatically activated. The label "secure mode" is displayed in the Windows CE Desktop.

If you now want to use a function on the taskbar or Desktop, you have to enter the password.
When you have entered the password, the label "secure mode" is no longer displayed. All

the functions of the taskbar and Desktop can now be used freely. To reactivate SecureMode,

double-click the g icon on the Desktop. The "secure mode" label is displayed again. The

HMI device is protected again.

Canceling SecureMode
To completely cancel SecureMode, delete the password.

MP 277 (WinCC flexible)
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6.3 Conftrol Panel

6.3 Control Panel

6.3.1 Overview

Control Panel of the HMI device

File View
o 'Tt'
Backup/R... Certificates InputPanel
@] G5 i .-".';\-;\-
T % @
Metveork 1D op Passwaord Printer
M) B e
e Lﬂilzl o = |=
Systemn Transfer LIPS yolurmne &
Sounds

e

P @ D @

Internet Keyboard Mouse  Metwork and
Options Dial-up Co...

w9 d& =

FROFIMET Regional  S7-Transfer ScreenSaver
Settings Settings

"

WinCC
Intern...

You can configure the following settings in the Control Panel of the HMI device:

e Date/time

® Screen saver

® Regional settings
® Transfer settings
e Network settings
® Delay time

® Password

78
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Opening the Control Panel

The Control Panel can be opened as follows:

® |n the startup phase

6.3 Conftrol Panel

Press "Control Panel" to open the HMI device Control Panel in the Loader.

® |n a running project

Operate the operating element provided for the respective task, if configured.

Alternatively you can open the Control Panel from the Windows CE start menu.

1. Open the Windows CE start menu.

— For HMI devices with key operation use the key combination +

— For HMI devices with touch operation, select the key on the alphanumeric screen

keyboard twice.

2. Open the Control Panel with "Settings > Control Panel".

6.3.2 Reference for functions

The following table shows the settings in the Control Panel.

Symbol

Function

Saving to external storage device (backup) (Page 131)
Restoring from external storage device (Page 133)

Importing and Deleting Certificates (Page 129)

Setting the Date and Time (Page 95)

Configuring the Screen Keyboard (Page 88)

Changing General Internet Settings (Page 126)

Setting the Proxy Server (Page 127)

Changing Privacy Settings (Page 128)

Setting the Character Repetition of the Keyboard (Page 89)

Setting the Double-click (Page 91)

Changing the Network Configuration (Page 122)
e IP address
¢ Name server

Changing the Logon Data (Page 124)

MP 277 (WinCC flexible)
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6.3 Conftrol Panel

80

Function

Backing up Registry Information (Page 98)

Changing monitor settings (Page 99)

Displaying Information about the HMI Device (Page 106)

Restarting the HMI Device (Page 105)

Calibrating the Touch Screen (Page 92)

Activate Memory Management (Page 136)

Changing Password Protection (Page 94)

Changing the Printer Properties (Page 102)

Enabling PROFINET 10 (Page 117)

Changing Regional Settings (Page 97)
e Number format

e Currency

e Time format

e Date format

Changing S7 transfer settings (Page 112)

\E) .5

Setting the screen saver (Page 100)

e Screen saver
¢ Reducing screen backlighting

';ﬁ Displaying System Properties (Page 107)
Setting the device name of the HMI device (Page 121)
= Configuring the data channel (Page 115)
L Setting the Delay Time (Page 108)
e Setting the uninterruptible power supply (Page 109)
= State of uninterruptible power supply (Page 111)
.ﬁ...__ Set the volume (Page 103)
..'f Changing E-Mail Settings (Page 125) 2

N Only with MP 277 Touch

2) The "WinCC flexible Internet Settings" tab can contain additional tabs. This depends
on the options that have been enabled for network operation in the project.

MP 277 (WinCC flexible)
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6.3 Control Panel

6.3.3 Operating the Control Panel

6.3.3.1 Overview

Operator input options

The hardware of the HMI device determines which of the following operator control options
are available:

® Touch screen

The operating elements shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operating elements
by touching them with your finger. To double-click them, touch an operating element
twice in succession.

e HMI device keyboard

The operating elements shown in the dialogs are selected and operated using the keys of
the HMI device.

e External USB keyboard

o External USB mouse

Entries using an external keyboard

An external keyboard can be used to operate the Control Panel in exactly the same way as
the HMI device keyboard. Use the keys of the external keyboard which correspond to the
HMI device keys in the description.

Operator entries using an external mouse

An external mouse can be used to operate the Control Panel in exactly the same way as the
HMI device touch screen. Click the described operating elements with the mouse.

MP 277 (WinCC flexible)
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6.3 Conftrol Panel

6.3.3.2 Input with the Touch Screen

Introduction
The Control Panel is operated with the HMI device touch screen.

Procedure
Proceed as follows to change settings in the Control Panel:
1. Close the project.
Use the provided operating element.
The Loader appears.
Open the Control Panel by pressing the "Control Panel" button.
To open the required dialog, double-click its symbol.

Change as required by touching the tab.

o > 0N

Now make the necessary changes.

Touch the respective input object to make entries.

— Use the screen keyboard of the HMI device to enter the new values in the text boxes.
— Touch a button to operate it.

— Touch the selection box to open a drop down list box. Touch the required entry from
the drop down list box.

— Touch the check box to activate or deactivate a check box.
— Touch a radio button to select it.
6. Confirm the selection with the button or abort the entry with the button.

The dialog closes.

7. Close the Control Panel with the button.
8. Start the project by pressing the "Start" button in the Loader.

Input with the screen keyboard

A screen keyboard is available for data input. The screen keyboard is displayed as soon as
you touch a text box. You can also call up the screen keyboard directly from the Control
Panel.

MP 277 (WinCC flexible)
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6.3 Control Panel

Display methods for the screen keyboard

You can change the display method for the screen keyboard and the position on the screen
can be fixed. Confirm the entry with the button or abort the entry with the key. Either

action closes the screen keyboard.

® Numerical screen keyboard

7| 81 g« [FEx]

4 5|6 el | Ins
123‘J

U- ESC| | —»

|Num

® Alphanumerical screen keyboard

“T1]213[als]e][7]8]e]o]-[=]« [&= =Ix]

—quertyuiop[]JmsHomeT

g |a|s|d|(flg|h|j|k|P]:]"]|}\ pel | End | ¥
tly|[z|x|ec|¥|b|n|m| ,|.|/f| & [Ec| rmm|$
I E: | acer | B ow | ¥ |

The alphanumerical screen keyboard has various levels.

— Normal level

— Shift level

® Reduced screen keyboard

Changing the display of the screen keyboard

Function
Switching between the numerical and alphanumerical keyboard

A
<

)

Switching between the normal level and Shift level of the alphanumerical screen
keyboard

Activation and deactivation of the numerical and alphanumerical keys of the
alphanumerical screen keyboard

Switching from full display to reduced display

o

[2]| [ |E

Switching from reduced display to full display

Closing of reduced display of the screen keyboard

] | |

MP 277 (WinCC flexible)
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6.3 Conftrol Panel

Moving the screen keyboard

See also

In order to move the screen keyboard, proceed as follows:

Configuring the Screen Keyboard (Page 88)

Entering and Editing Numerical Values (Page 167)

Entering and editing alphanumerical values (Page 170)

Front operator controls (Page 65)

6.3.3.3 Input with the Keyboard

Introduction

Procedure

84

The Control Panel is operated with the system keys of the HMI device.

Proceed as follows to change settings in the Control Panel:

1.

Close the project.

Use the provided operator control.
Open the Control Panel.

The loader is displayed.

— Select the "Control Panel" button in the loader using the cursor keys.

— Press .

The Control Panel is opened.

Select the symbol of the required dialog with the cursor keys.
Press to open the dialog.
Change the tab as required.

Press until the name of the tab is selected. Now switch to the other tabs using the

cursor keys.

MP 277 (WinCC flexible)
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6.3 Conftrol Panel

6. Press to return to the input area and make the necessary changes.

Select the respective input object by pressing the key to make entries.

Use the system keys of the HMI device to enter the new values in the text boxes.

To operate a button, select the button with the cursor keys and then press .

— Open the selection lists with the key combination + E

Select the required entry from the selection list using the cursor keys.
Confirm the selected entry by pressing .

{ 1}
- Press to activate or deactivate a check box.

— Select a option button of a group using the cursor keys.

7. Confirm your entries with or discard your entries with .

If you have selected an input object, you first have to complete entry.
The dialog box closes.

8. Close the Control Panel.

Press . This opens the Control Panel menu.

— Select the "Close" entry using the cursor keys.

— Press .

The loader is displayed.
9. Start the project.

— Select the "Start" button in the loader using the cursor keys.

— Press .

The project is started.

Control keys
The tables below show the control keys used to operate the Control Panel.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01 85



Conlfiguring the operating system

6.3 Conftrol Panel

Select operator controls

Key Function Description
_— Tabulator Selects the next/previous operator control in the
tab sequence.
+ TAB
Cursor keys Selects the next operator control to the left, right,
| > ,
above or below the current screen object.
ViA Navigates in the operator control.

Using operator controls

86

&
<

Function

Description

Scroll back

Scrolls back a page in a list.

+
3
S
m

Scroll to the beginning

Scrolls to the beginning of a list.

Scroll forward

Scrolls one page forward in a list.

+
m
H

Scroll to the end

Scrolls to the end of a list.

™ T

z Bl il Bl o
E H 5 = =

2 m

Enter key e Operates a button.
e Accepts and ends an entry.
Cancel e Deletes the characters of a value entry and

restores the original value.
¢ Closes the active dialog.

INS

Delete characters

Deletes the character to the right of the current
cursor position.

Delete characters

Deletes the character to the left of the current
cursor position.

H n H
m
= e

=
+

Open selection list

Opens a selection list.

ENTER|

(¢}
=
Py
P
+

Accept value

Accepts the selected value in the selection list
without closing the list.

MP 277 (WinCC flexible)
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Enter key combinations

6.3 Conftrol Panel

Key

Function

Purpose

Toggle key assignment

Toggles the assignment for a key with multiple
assignment.

e No LED is lit:
The number assignment is enabled. Pressing
the button once toggles to letter assignment.
e AnLEDislit:

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
between the left letter assignment, the right letter
assignment and the number assignment.

Toggle between upper-case
and lower-case

Used in key combinations, for example for entering
upper-case letters.

2]
il Iz
z !
3

Switch to additional key
assignment

Some of the keys contain a key assignment
imprinted blue, for example the "%" character.

Used in key combinations for the blue key
assignment.

@]
4
)
.

General control function

Used in key combinations

ALT

General control function

Used in key combinations

See also

Entering and editing numerical values (Page 178)

Entering and editing alphanumerical values (Page 179)

Front operator controls (Page 65)

MP 277 (WinCC flexible)
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6.4 Changing settings for operation

6.4 Changing settings for operation

6.4.1 Configuring the Screen Keyboard

Introduction
You can change the layout and the position of the screen keyboard as follows.

Requirement

You have opened the "Siemens HMI InputPanel - Options" dialog by pressing the

Siemens HMI Input Panel - Options m

Z#  Ppsition and Size

Currently not in resizeing-rmode. ..

1 Start Resize I @
|

Close Input Panel l @

@ Button for displaying the screen keyboard
® Button for saving the screen keyboard settings
® Button for closing the screen keyboard

Procedure
Proceed as follows:

1. Display the screen keyboard by pressing the "Open Input Panel" button.

2. By pressing the button, you can switch between the numerical and alphanumerical
screen keyboard.

Set the position of the screen keyboard by moving the screen keyboard on the screen.
Save your settings by pressing the "Save" button.

Close the screen keyboard by pressing the "Close Input Panel" button.

o g ko

Close the dialog.

Result
The screen keyboard settings have been modified.

See also
Input with the Touch Screen (Page 82)

MP 277 (WinCC flexible)
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6.4.2

Introduction

Requirement

Setting the Character Repetition of the Keyboard

6.4 Changing settings for operation

You can set the character repeat for the keyboard or screen keyboard in the Control Panel.

You have opened the "Keyboard Properties" dialog box by pressing the "Keyboard" @

icon.

oK
Rmu
™

tnable character repeak

Keyboard Properties

short )

Repeat delay: Long 000000000000080 '
" e

Repeat rake:  Slow Fast )

™ G e B

Tap here and hold down a ke to

bo o

® e 0

Test field
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6.4 Changing settings for operation

Procedure
Proceed as follows:
1. Select the "Enable character repeat" check box to enable the character repeat.

2. Use the buttons to set the delay and rate of the character repeat. You can also use the
slider control for this.

3. Verify your settings.
For HMI devices with touch operation.
— Touch the test field. The screen keyboard opens.
— Move the screen keyboard as needed.
— Touch any character and keep it pressed.

— Check the implementation of the character repetition and the rate of the character
repetition in the test field.

— Correct your setting if necessary.

For HMI devices with key operation.

— Select the test field.

— Press an alphanumeric key and keep the key pressed down.

— Check the implementation of the character repetition and the rate of the character
repetition in the test field.

— Correct your setting if necessary.
4. Confirm your entries.

The dialog box closes.

Result
The character repeat for the keyboard is now set.

MP 277 (WinCC flexible)
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6.4 Changing settings for operation

6.4.3 Setting the Double-click

Introduction

You can start applications in the Control Panel and in Windows CE with a double-click. A
double-click corresponds to two brief touches in sequence.

In the "Mouse Properties" dialog, make the following adjustments for touch screen operation
and operation with external mouse:

® |nterval between touch contacts on the touch screen

® |nterval between mouse clicks

Requirement

You have opened the "Mouse Properties" dialog with the "Mouse" i/:‘:_.) icon.

Double-Click |

Double-click this grid to set the double-click
sensitivity For both the speed and phyvsical 1
distance between clicks,

Daouble-click this icon ko test wour double-click.
settings. IF this icon doesn't change, adjust
wour settings using the arid abowe.

—®
=

@ Pattern
® Symbol
Procedure
Proceed as follows:
1. Double-click the pattern twice.
After one double-click, the pattern is shown in inverse colors.
2. Double-click the symbol twice.
If the double-click is valid, the symbol is displayed as follows:
3. If the symbol remains unchanged, double-click on the pattern again.
4. Confirm your entries.
The dialog box closes.
Result

The double-click adjustment is completed.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01 91



Conlfiguring the operating system

6.4 Changing settings for operation
6.4.4 Calibrating the Touch Screen

Introduction

Depending on the mounting position and viewing angle, it is possible that parallax may occur
when operating the touch screen. In order to prevent any operating errors as a result,
calibrate the touch screen again in the startup phase or during runtime.

Requirements

You have opened the "Touch" tab in the "OP Properties" dialog box by pressing the "OP"
4@ icon.

Persistent Storage l Display l Device  Touch l

If vour Windows CE device is not responding

EE/ properly ko wour baps, wou may need to

recalibrate your screen,

To start, bap Recalibrate,

Recalibrate @

@ Button for calibrating the touch screen

MP 277 (WinCC flexible)
92 Operating Instructions, 03/2009, A5E02479740-01



Configuring the operating system
6.4 Changing settings for operation

Procedure
Proceed as follows:

1. Touch the "Recalibrate" button to open the following dialog:

Carefully press and briefly hold stylus on the center of
the target. Repeat as the target moves around the screen.

+ ®

2. Briefly touch the middle of the calibration crosshairs @.

The calibration crosshairs is then displayed at four more positions. Touch the middle of
the calibration crosshairs for each position. If you do not touch the middle of the
calibration crosshairs, the procedure is repeated.

Once you have touched the calibration crosshairs for all positions, the following dialog
appears:

New calibration settings have been measured.
Tape the screen to register saved data.
Wait for 30 seconds to cancel saved data and
keep the current setting.

Time limit: 30 sec

3. Touch the screen within 30 seconds.

The new calibration is saved. If you wait longer than 30 seconds, the new calibration is
discarded and the original calibration remains in effect.

The "OP Properties" dialog, "Touch" tab is displayed again.
4. Close the dialog.

Result
The HMI device touch screen is now recalibrated.
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6.5 Changing Password Protection

Introduction
You can protect the Control Panel and Windows CE taskbar with a password.

Requirements

You have opened the "Password Properties" dialog box by pressing the "Password" @

icon.

Password Properties m

Password Settings ]

Password
Fel% Passward: @
Confirm password; @
® Password text box
® Text box for entering the password a second time

NOTICE

If the password is no longer available, you cannot do the following until you have updated
the operating system.

e Making changes to the Control Panel
e Operating the Windows CE task bar

All data on the HMI device will be overwritten when you update the operating system!

Procedure for activating password protection
Proceed as follows:
1. Enter a password in the "Password" text box.
2. Repeat the password entry in the "Confirm Password" text box.
3. Confirm your entries.

The dialog closes.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\""

Result
You cannot open the Control Panel or Windows CE taskbar without entering a password.

MP 277 (WinCC flexible)
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Procedure for deactivating password protection
Proceed as follows:
1. Delete the entries in the "Password" and "Confirm password" text boxes.
2. Confirm your entries.

The dialog closes.

Result
Password protection for the Control Panel and Windows CE taskbar is disabled.

6.6 Changing HMI device settings

6.6.1 Setting the Date and Time

Introduction

You can set the date and time on the HMI device. The HMI must be restarted in the following
cases:

® You have changed the time zone setting.

® You have changed the setting of the "Daylight savings time currently in effect" check box .

Requirement
You have opened the "Date/Time Properties" dialog box by pressing the

122

"Date/Time Properties" -aJ icon.

DatefTime Properties m

Date/ Ti_rge l

Time Zone |(GMT) Greerwich Mean Time : Dublin, Edinbtlll—

n Januar 2006 n Current Tirme

M DMDF 5 s  |06:03:28 =

1
2 3 4 5 6 7 B
9 10 11 12 13 14 15
16 17 18 19 20 21 22
23 24 B e 27 28 29

= Davylight savings kime
currently in effect

5t

30 31 |
apphy 1
pply

Time zone
Time
Date

"Daylight savings" check box

® 600 0

Button for applying changes
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Procedure

Result

Proceed as follows:
. Select the appropriate time zone for the HMI device in the "Time Zone" selection box.

. Touch the "Apply" button to confirm your entry.

The time of day shown in the "Current Time" field is adjusted correspondingly to the
selected time zone.

3. Set the date in the selection box.

. Set the current time of day in the "Current Time" text box.

Note

The system does not automatically switch between standard time and daylight saving
time.

. If you want to switch from standard time to daylight saving time, select the

"Daylight saving time currently in effect" check box.

When you press the "Apply" button, the time is brought forward by one hour.

. If you want to switch from daylight saving time to standard time, clear the

"Daylight saving time currently in effect" check box.

When you press the "Apply" button, the time is brought back by one hour.

. Confirm your entries.

The dialog box closes.

The settings for the date and time of day have now been changed.

Synchronizing the date and time with the PLC

See also

96

The date and time of the HMI device can be synchronized with the PLC if this has been
configured in the project and the PLC program.

You can find additional information on this subject in the "WinCC flexible" system manual.

NOTICE

You have to synchronize the date and time when time-controlled responses are triggered in
the PLC by the HMI device.

Restarting the HMI Device (Page 105)

MP 277 (WinCC flexible)
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6.6.2 Changing Regional Settings

Introduction

In different countries, for example, the date, time and decimal points are displayed
differently. You can adjust the display format to meet the requirements of different regions.

The country-specific settings apply to the current project. If the project language is changed,
the country-specific settings are also changed.

Requirements
You have opened the "Regional and Language Settings" dialog box by pressing the

"Regional Settings" ._'H?icon.

Regional and Language Settings

oK
Regional Settings | Murnker I CUrrency I Time I Date |

Mary programs have different

- |international settings, Regional

adjustrnents in date-, time-,

currency- and numbers-

corwentions for displaying and

. |sorting data can be achieved in
E changing those intermational

@ Region selection box

Procedure
Proceed as follows:
1. Select the region from the selection box.

2. Change to the "Number", "Currency", "Time" and "Date" tabs and set the selection boxes
to the desired settings.

3. Confirm your entries.

The dialog closes.

Result
The HMI device's regional settings have been changed.
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6.6.3 Backing up Registry Information

Registry information and temporary data

You can install and uninstall your own programs on the HMI devices under Windows CE.
You must save the registry settings after installation or uninstallation.

You can save the following data to the flash memory:
® Registry Information

® Temporary files

Restoring the file system of a memory card

Requirements

98

If memory cards are used, the file system on the memory card may become damaged,
perhaps due to a power failure. The HMI device detects the defective file system on start-up
or when the memory card is inserted. The HMI device can restore the file system
automatically or on request.

You have opened the "Persistent Storage" tab in the "OP Properties" dialog box by pressing

the "OP" & icon.

Display l Device l TDEICI‘l ]

Save actual registry settings tao Flash,
Swyskem will start with saved registry | Save Reqistry
settings next time, |

Save all files from kemporary memory
(&.g. the "\Program Files' directary) ko Sawe Files
flash. The files will be restored during
system starkup, The 1 Temp’ directary

will nat be saved. e |

N Autornatically repair File swstem errors on storage
cards at syskem starbup and card insertion kime

©) Meaning of the text in the dialog:

Saves the current registry information to the flash memory. The HMI device loads the saved
registry information the next time it boots.

Button for saving registry information
Button for saving temporary files

® 0

Meaning of the text in the dialog:

Saves all the files in temporary storage to the flash memory (for example, from the "Program
Files" directory). These files are written back when the HMI device is started. The "\Temp"
directory is not saved.

® Check box for automatically restoring the file system on the memory card when the HMI
device starts up and when a memory card is inserted.

MP 277 (WinCC flexible)
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Procedure

Result

6.6.4

6.6 Changing HM/ device settings

Proceed as follows:

1.

2.
3.

Select the "Save Registry" button to save the current registry settings.

Select the "Save Files" button to save temporary files.

Specify how the file system on the memory card should be restored.

— Activate the check box "Automatically Repair ..." to activate automatic restore.

— Deactivate the check box "Automatically Repair ..." if you wish to have the files system
restored only upon prompting.

Confirm your entries.

The dialog closes.

The HMI device uses the saved registry information the next time it starts. The temporary
files are copied back.

Changing monitor settings

Requirements

Procedure

Result

You have opened the "OP Properties”, dialog "Display" tab with the "OP" 4@ icon.

OP Properties

Persiskent Storage

i| Device

Brightness

Up DOWH

Proceed as follows:

1.
2.
3.

If you want to increase the brightness, press the "UP" button.
If you want to decrease the brightness, press the "DOWN" button.
Confirm your entries.

The dialog closes.

The screen settings have been changed.
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6.6.5 Setting the screen saver

Introduction
You can set the following time intervals on the HMI device:
® For the automatic activation of the screen saver
® For the automatic reduction in the screen's backlighting

When you do not undertake an operation within the configured interval, the configured
function will be activated automatically.

The screen saver and the reduced screen backlighting functions are switched back off by
means of the following actions:

® By pressing any key
e By touching the touch screen

The function associated to the key or button will not be executed by this.

NOTICE

Deterioration of the backlight brightness

The brightness of the backlighting decreases incrementally during its operational life. In
order to increase the operational lifetime of the backlighting, activate the backlighting
reduction.

Burn-in effects

The prolonged display of screen contents can occasionally lead to a burn-in effect in the
background.

This burn-in effect automatically disappears after a certain amount of time, for example,
after the screensaver was activated. The longer the same content is displayed on the
screen, the longer it will take for the burn-in effect to disappear.

Generally, you should always activate the screen saver.

When the screen saver is active, the backlighting is reduced at the same time.

MP 277 (WinCC flexible)
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Requirements

You have opened the "Screensaver" dialog box by pressing the "ScreenSaver" @ icon.

Screensaver m
Dim Backlight becomes active after 13 ¥ mindtes @

Screensaver becomes active after |o i @

@ Standard (") Blank Screen) @

Enker a0 to disable the function,
The rninirurn ke is 5 and the maximonn is 71582 minukes,

@ Time interval in minutes until backlighting is reduced
® Period of time in minutes before the screen saver is activated
® Screen saver setting

Procedure
Proceed as follows:
1. Enter the interval in minutes after which the backlighting is to be reduced.
Entering "0" will deactivate the backlighting reduction.
2. Enter the number of minutes before the screen saver is to be activated.
The minimum time is 5 minutes and the maximum time is 71582 minutes.
Entering "0" disables the screen saver.
3. Select either the standard screen saver or an empty screen.
— In order to select the standard screen saver, activate the "Standard" option.
— In order to select an empty screen as screen saver, activate the "Blank Screen"
option.
4. Confirm your entries.
The dialog closes.
Result

The screen saver and the reduced backlighting for the HMI device is set.
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6.6.6 Changing the Printer Properties

Introduction

Requirement

Procedure

102

HMI devices can print on local printers or network printers. You can print hardcopy and logs
on network printers. Line printing of alarms is not possible on a network printer.

You can find the list of current printers and required settings for HMI devices in the Internet

at "http://support.automation.siemens.com/WW/view/en/11376409".

2
You have opened the "Printer Properties" dialog box by pressing the "Printer" 'iT " icon.

Printer Properties m

i : |
Printer Language: |E|:|son9 s
0 X 1
Part: |Network. =

Metwork: _|'I,'I,server32'|,printer01
. | 1
Paper Size: ]M b=
Crrientation |
@) Portrait { ) Landscape =T

[ oraft Mode [

%0

—®
—®
—®

®©@ 600

Printer selection box

Interface

Network address of the printer
Paper size selection box
Orientation setting

Print quality setting

Proceed as follows:

1.
2.
3.

5. Select the required option button in the "Orientation" group:

Select the printer in the "Printer Language" selection box.

Select the port for the printer in the "Port" selection box.

If you wish to print via the network, enter "Network:" in the text box the network address

of the printer.

Select the paper format in the "Paper Size" selection box.

"Portrait" for vertical format

"Landscape" for horizontal format

Select the print quality.

— Select the "Draft Mode" check box if you want to print a draft.

— Clear the "Draft Mode" check box if you want to print with higher quality.

MP 277 (WinCC flexible)
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7. Set the color mode.
— Select the check box "Color" if you wish to print in color.
8. Confirm your entries.

The dialog box closes.

Result
The settings for the printer have now been changed.

6.6.7 Set the volume

Introduction

You can activate an acoustic feedback for keyboard and touch screen operations. With each
touch or activation of a key, an acoustic signal is emitted.

Requirements

You have opened the dialog "Volume & Sounds Properties” using the icon

"Volume & Sounds" .

Volume & Sounds Properties m

Wolume ] Sounds ] o
| & |Laud Enable sounds for:

[w| Events (warnings, beeps and system events)

; [v| applications {program specific and all other sounds)
z [w| Motifications (alarms, appointments and reminders)

Enable clicks and taps
[v] Hardware buttons @ Loud O Saoft

O,
[ ] Sereen taps: @ Lod ) @

@ Check boxes and radio buttons for acoustic feedback when using the keyboard

® Check boxes and radio buttons for acoustic feedback when using the touch screen
® Buttons for adjusting the volume

Note

If you deactivate the settings under "Enable sounds for:" no more acoustic signals will be
emitted during inadvertent operations.
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Procedure
Proceed as follows:
1. For HMI devices with keys:
— Click the check box "Hardware buttons" to activate the acoustic signal.
— Choose between a loud and soft acoustic signal using the "Loud" and "Soft" radio
buttons.
2. HMI devices with touch screen:
— Activate the "Screen Taps" check box to activate the acoustic signal.
— Choose between a loud and soft acoustic signal using the "Loud" and "Soft" radio
buttons.
3. Choose the required volume using the "Loud" and "Soft" radio buttons.
4. Confirm your entries.
The dialog closes.
Note
The entries in the "Sounds" tab are of no relevance to the HMI device.
Result
The properties of the acoustic operation feedback are now set up.
See also

Overview (Page 161)

MP 277 (WinCC flexible)
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6.6.8 Restarting the HMI Device

Introduction

The HMI device must be restarted in the following cases:
® You have activated or deactivated the PROFINET IO direct keys

® You have changed the time zone setting.

® You have changed the automatic daylight savings and standard setting

Requirements

A\ caution

Data loss when the HMI device is restarted

All volatile data is lost when the HMI device is rebooted.

Check the following:
e The project on the HMI device is not open
¢ No data is being written to the flash memory

You have opened the "OP Properties" dialog box by pressing the "OP" icon.

Procedure

Result

. Change to the "Device" tab in the "OP Properties" dialog.

Press "Reboot" to restart the HMI device.
A warning is displayed.

The HMI device reboots immediately if you confirm this warning.

The HMI device starts.

See also

Enabling PROFINET IO (Page 117)
Setting the Date and Time (Page 95)

MP 277 (WinCC flexible)
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6.6.9 Displaying Information about the HMI Device

Introduction
You will need the device-specific information when you contact Technical Support.

Requirement

You have opened the "Device" tab in the "OP Properties" dialog box by pressing the

"OP" 6@ icon.

| Persistent Storage ] Display | Mernary Mo L4
| (D
S

Device: MP 277 10" Keyv

Irnage Version: Y01.00.00.00_01.12 — | /@
Bootloader Yersion: 0.85 @
Bootloader Rel,Date: 22.11,2005 @
Flashsize: 64ME —— | _\@
MAC-Address: 00-08-29-08-43-d7 — | \@

| .Rieboot =——— \@

HMI device name

Version of the HMI device image

Version of the boot loader

Boot loader release date

Size of the internal flash memory in which the HMI device image and project are stored
MAC address of the HMI device

Button for restarting the HMI device

Dialog "OP Properties", tab "Device", example MP 277 10" Key

QOeO®®e 0O

Procedure
Proceed as follows:
1. The device-specific information is displayed in the "Device" tab.

2. Close the dialog when the information is no longer required.

Note

The size of the internal flash memory does not correspond to the available working
memory for a project.

MP 277 (WinCC flexible)
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6.6.10 Displaying System Properties

Introduction

Requirements

The system-specific information provides you with information about the processor,
operating system and memory of the HMI device.

Ny

You have opened the "System Properties” dialog box by pressing the "System" &7 icon.

General ]Memury | Devicn‘eir\_lél:ne]

System: Computer:

MicrosoftE WindowsE CE Processor Type: [Intel, ARMSZOT-PXA2
Wersion 5,00 (Build 14007 e o Sl | J
@ 2004 Microsoft Corp, &l rights Memoary: 96096 KB RAM

reserved, This computer program is
protected by LS, and international
copyright laws,

Reqgistered to:

@ ©)
@ Copyright to Microsoft Windows CE

® Information about the processor, size of the internal flash memory, and capacity of a memory
card when inserted

Displaying the system information

The system information is displayed. This dialog is read-only.

Close the dialog.

Procedure for displaying memory information

NOTICE

"Memory" tab
Do not change the memory distribution in the "Memory" tab.

Only applies for the usage of options:
An alteration to the memory distribution may be necessary. Please refer to the

accompanying documentation for further information.
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Proceed as follows:
1. Change to the "Memory" tab.

The memory information is displayed.

System Properties

' General | Memory | Devics Nams |

CX E3

Mowe slider to the left for more mernory to run programs, Move slider to
the right for rmore storage room. Only unused RAM can be adjusted.

Sturage At e Prugram
Memory Eﬁ Memory

Allocated 512KB
In Use B0KE

Allocated 95584KB
In Use 993GkE

2. Close the dialog.

6.7 Setting the Delay Time

Introduction

Requirements

108

The project is opened following a delay time when the HMI device is switched on. The

Loader is displayed during the delay time.

You have opened the "Directories" tab in the "Transfer Settings" dialog box by pressing the

=
"Transfer" ¢,m icon.

Transfer Settings m bl |
Channel | Directaries
r ~'

Praject File
|'|,FIash'l,Simatic'l,

Project Backup
1'|,Storage Card MM\ Simatich,

©

9

Autostart application:

®©@

Path: W ait [sec]:
|'|,FIash'|,5imatic'|,HmiRTm.exe |3 Ll
@ Directory where the project file is saved
® Directory where the compressed source file of your project is saved

The external memory card or the network connection can be defined as the storage location.
During the next backup process, the project's source file is stored in the specified location.

® Storage location and initialization file of the HMI device for process operation

@ Region selection box

MP 277 (WinCC flexible)
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NOTICE
Settings in "Project File" and "Path"

Do not change the setting in the "Project File" and "Path" fields. The project may not open
at the next start of the HMI device if changes are made here.

Procedure for setting the delay time
1. Select the desired delay time in seconds in the "Wait [sec]" selection box.

With the value "0", the project starts immediately. It is then no longer possible to call the
Loader after switching on the HMI device. If you still wish to access the Loader, an
operating element must be configured to close the project.

2. Confirm your entries.

The dialog closes.

Result
The delay time for the HMI device is now set.

6.8 Setting the uninterruptible power supply

Introduction
UPS monitoring is an option you load as an add-on with ProSave.

A UPS ensures that the HMI device is shut down in a controlled manner after a buffer time in
the event of a power failure. This avoids the loss of data.

The following uninterruptible power supplies are supported:
SITOP DC UPS modules as of a rated power value of 6 A, e.g. 6EP1931-2DC42

Connect the UPS to the 24-V input and a USB port. Configure the USB port for UPS
monitoring.
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Requirements

M
You have opened the "UPS Properties", dialog "Configuration" tab with the "UPS" j\"j icon.

Interface: USE
Battery mode

D Send "Shutdown” signals after

Port disturbed

[send | vl aftat I min | 5

Text box for the time after which the "Battery mode activated" message is displayed

COIOQ,

Check box for enabling battery mode
Text box for the time after which the "Faulty port" message is displayed

® e 00

Check box for the "Faulty port" message

Procedure
Proceed as follows:
1. If you want to enable battery mode, activate the "Battery mode" check box.
2. Enter the time for terminating applications in the "min" and "s" text boxes.

You will receive a message when UPS takes effect. Applications such as HMI Runtime
and WIinAC MP are then terminated depending on the time entered.

3. If the port to which the UPS is connected is faulty and you therefore want to receive a
message, activate the "Port disturbed" check box.

4. Select the message you want from the list box.

5. Enter the time after which the "Faulty port" message is displayed in the "min" and "s" text
boxes.

Result
Port monitoring for the UPS is set.
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6.9 State of uninterruptible power supply

Introduction
If you have connected a UPS to a USB port, you can display the monitoring state of this port.

Requirements

ME
You have opened the "UPS Properties", dialog "Current status" tab with the "UPS" _jfﬂ icon.

UPS Properties m m
Configuration | Current status |—

Current skakus:

UP3 programm is nok running. @

Mo current status available!

) The "UPS program is not running. No current status available." message appears when the
UPS is not connected.

Procedure
Proceed as follows:
1. Installing the UPS monitoring software.
2. Connect the UPS.
3. If you want to update the monitoring state, press the "Update" button.

The message is changed according to the current setting. The message will remain
unchanged if no check boxes in the "Configuration" tab have been activated.

Result
The current monitoring state for the UPS is displayed.
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6.10 Change the communication settings

6.10.1 Changing S7 transfer settings

Introduction

The communication settings between the HMI device and PLC are defined in the HMI device
project. In the following cases, the communication settings might have to be changed:

® The first time the project is transferred

e |f changes are made to the project but are only applied later

NOTICE

Transfer mode using MPI/PROFIBUS DP
The bus parameters are read from the project currently loaded on the HMI device.

You can change the settings for MPI / PROFIBUS DP transfer. The following steps are
required:

e Close the project.

e Change the settings on the HMI device.

e Then return to "Transfer" mode.

The changed MP/PROFIBUS DP settings will be overwritten in the following cases:
e The project is started again

e A project is transferred

Transfer settings

A project can only be transferred from the configuration PC to the HMI device when at
least one of the data channels is enabled on the HMI device.

If the HMI device is in "Transfer" mode while changes are made to the transfer settings,
the settings only go into effect after the transfer function is restarted.

MP 277 (WinCC flexible)
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Requirement

6.10 Change the communication settings

You have opened the "S7-Transfer Settings" dialog box by pressing the

"S7-Transfer Settings" ﬁgﬂ- icon.

S7-Transfer Settings m

—®
@

Properties. ..

O]
@

Procedure

Network selection

Button for opening the properties dialog

Proceed as follows:

1. Select a network.

MP 277 (WinCC flexible)

If you have selected "S7 Ethernet", click the "Properties" button to open the
"SMC LAN91C111 Ethernet Settings" dialog and proceed as described in the
Changing the Network Configuration (Page 122) section to edit the Ethernet settings.

If you have selected "MPI" or "PROFIBUS", proceed with the tasks described below.
2. Open the "MPI" or "PROFIBUS" dialog with the "Properties" button:

MPI

o] x|

Skation Parameters
[w Panel is the anly master on the bus

@

address: 1

Tirme-ouk: 1s =
Metwork, Parameters

Transmission Rate: 187,5 kbitsis [

Highesk Station 126 I

Skation Parameters

[ Panel is the only master on the bus

@® @ |

Address: 45
Time-out: 1s =
Metwork, Parameters

12 Mbitsis

Transmission Rake:

Highest Station Address: 126
P

LlLadl

Prafile

|

Bus Parameters, .,

OONOCRONSO
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3. If more masters are connected to the bus, deactivate the check box "Panel is the only
master on the bus".

4. Enter the bus address for the HMI device in the "Address" text box.

NOTICE

The bus address in the "Address" text box must be unique throughout the
MPI/PROFIBUS DP network.

)]

. Select the transmission rate in the "Transmission Rate" text box.

(2]

. Select the highest station address on the bus in the "Highest Station Address" or "Highest
Station" text box.

~

. Select the desired profile from the "Profile" selection box.

[oo)

. The profile information is displayed when you select "Bus Parameters" button in the
PROFIBUS dialog. The "Profile" dialog is read-only.

NOTICE

The bus parameters must be the same for all stations in the MPI/PROFIBUS DP

network.

Profile 0K |
Tslat; 00 tBit| | Trdw 11 1Bit
Min Tadl: 11 tBit| | Tidl 27 1Bit
May Tl 150 Bt | | TidZ: 150 tBit
Teet: 1 it
Toui: 0 iBit
Gap factor 10
Retry limit: 1

9. Close the "Profile" dialog.
10. Confirm your entries in the "MPI" or "PROFIBUS" dialog.

The dialog box closes.

Result
The MPI/PROFIBUS DP settings of the HMI device have been changed.
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6.10.2 Configuring the data channel

Introduction

Requirement

If you block all data channels, the HMI device is protected against unintentional overwriting
of the project data and HMI device image.

Note

A project can only be transferred from the configuration PC to the HMI device when at least
one of the data channels is enabled on the HMI device.

=
You have opened the "Transfer Settings" dialog box by pressing the "Transfer Settings" g

icon.

Transfer Settings m

Channel | Directories

Channel 1: @

Serial:via R3232/PPI Multi-Masker Cable

|:| Enable Channel D Remate Control

Channel 2: @
= THERMET

Enable Charnel Remake Cantrol| | g, o0 ced @

@ Group for data channel 1 (Channel 1)
@) Group for data channel 2 (Channel 2)
® Button for the dialog "S7 Transfer Settings" or "Network and Dial-Up Connections."

Note
"Remote Control" for channel 1

Only select the "Remote Control" check box in the "Channel 1" group, if serial transfer is in
progress. Clear the check box before changing to "Online" mode.
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6.10 Change the communication settings

Procedure

Result

116

Proceed as follows:

1. You can clear the required data channel by activating the associated "Enable Channel"

check box in the "Channel 1" or "Channel 2" group.

In the "Channel 1" group, the RS-422/RS-485 port is configured for the serial data
transfer.

— Select the "Enable Channel" check box to enable the data channel.

— Clear the "Enable Channel" check box to lock the data channel.

. Enable automatic transfer by activating the respective "Remote Control" check box in the

"Channel 1" or "Channel 2" group.

AWARNING

Unintentional transfer mode

Ensure that the configuration PC does not inadvertently switch the HMI device to
transfer mode while the project is in runtime. This could cause unintentional actions to
be triggered in the plant.

3. Select the required protocol for "Channel 2" in the selection box.

. Enter further parameters if required.

— Applies to "MPI/Profibus/S7-Ethernet:"

Press the "Advanced" button to change to the "S7-Transfer Settings" dialog. There
you can change the settings for MPI/PROFIBUS or S7 Ethernet.

Confirm your entries.
The "S7-Transfer Settings" dialog box closes.

— Applies to "ETHERNET":
Press the "Advanced" button to change to the "Network&Dial-Up Connections."
Open the "LAN9001" entry. You can change the TCP/IP settings there.
Confirm your entries.

Close "Network&Dial-Up Connections".

— Applies to "USB:"

No further settings are required for "USB".

. Confirm your entries.

The dialog box closes.

The data channel is configured.
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General information

Note
Changes during "Transfer" mode

If the HMI device is in "Transfer" mode while changes are made to the transfer settings, the
settings only go into effect after the transfer function is restarted.

This may occur if the Control Panel is opened to change the transfer properties in an active
project.

NOTICE

Serial transfer mode via channel 2

The bus parameters, for example address of the HMI device, are read out of the project
that is currently running on the HMI device.

You can change the settings for the transfer via channel 2.
The following steps are required:

e Close the project.

e Change the settings on the HMI device.

e Then return to "Transfer" mode.

The next time the project is started on the HMI device, the settings will be overwritten by
the values from the project.

See also
Changing S7 transfer settings (Page 112)
Changing the Network Configuration (Page 122)
Operating modes (Page 138)

6.10.3 Enabling PROFINET 10

PROFINET 10

If the HMI device is connected to the PLC via PROFINET, function keys or buttons, for
example, can be configured as PROFINET IO direct keys. If PROFINET 10 direct keys are
used in the project, they must be enabled.

Note

If you enable PROFINET IO direct keys, you cannot use the RS 422/RS 485 port for serial
communication.

PROFINET IO direct keys and PROFIBUS DP direct keys are mutually exclusive.
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Requirement

You have opened the "PROFINET" dialog with the "PROFINET" Loy icon.

[+ PROFINET 10 enabled im0 @

Device name: (max, 255 characters)

|HMI—PanE| ——@
MAC-Adress: 08-00-06-2B-AC-93 —@

@ Enabling or disabling the PROFINET 1O direct keys
® Text box for the device name
® MAC address of the HMI device

NOTICE

Inconsistent device name

If the device name does not match the device name entered in the HW Config of STEP 7,
the direct keys do not work.

Use the device name from the HW Config of STEP 7. This device name does not
correspond to the device name used under Windows CE.

Within the ETHERNET data network, the device name must be unique and satisfy the DNS
conventions. These include:

® Restriction to 127 characters in total (letters, digits, hyphen or point)

® A name component within the device name, e.g. a string between two points, may not
exceed 63 characters.

® Special characters such as umlauts, brackets, underscores, slashes, spaces etc. are not
permitted. The hyphen is the one exception.

® The device name must not start or end with a the "-" character.
® The device name must not take the form n.n.n.n (n = 0 to 999).

® The device name must not start with the character sequence "port-xyz-" (x, y, z= 010 9).

Procedure
1. If you want to enable the PROFINET 1O direct keys, select the "PROFINET 0" check
box.
2. Enter the device name of the HMI device.
3. Confirm your entries.
The dialog box closes.
4. Reboot the HMI device after saving the settings.
Result

The PROFINET IO direct keys are enabled.
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See also
Restarting the HMI Device (Page 105)

6.11 Configuring network operation

6.11.1 Overview of network operation

Introduction
You can connect the HMI device to a PROFINET network via the Ethernet port.
The connection to a network offers, for example, the following options:
® Printing via a network printer
® Saving, exporting and importing of recipe data records on or from a server
® Setting up of message and data archives
® Transferring a project

® Saving data

NOTICE
The HMI device can only be used in PROFINET networks.

The HMI device only has client functionality in the PC network. This means that users
can access files of a node with TCP/IP server functionality from the HMI device via the
network. However, you cannot, for example, access data on the HMI device from a PC
via the network.

Note

Information on communication using SIMATIC S7 via PROFINET is provided in the
"WinCC flexible communication" user manual.
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Addressing

Within a PROFINET network, computers are usually addressed using computer names.
These computer names are translated from a DNS or WINS server to TCP/IP addresses.
This is why a DNS or WINS server is needed for addressing via computer names when the
HMI device is in a PROFINET network.

The corresponding servers are generally available in PROFINET networks.

Note
The use of TCP/IP addresses to address PCs is not supported by the operating system.

Consult your network administrator if you have questions in this regard

Printing via a network printer

Preparation

The HMI device's operating system does not support line by line alarm logging via a network
printer. All other printing functions, for example hardcopy or logs are available without
restriction via the network.

Before beginning the configuration, request the following network parameters from your
network administrator.

® Does the network use DHCP for dynamic assignment of network addresses?
If not, get a new TCP/IP network address for the HMI device.

e \Which TCP/IP address does the default gateway have?

o |f a DNS network is used, what are the addresses of the name server?

e [f a WINS network is used, what are the addresses of the name server?

General procedure for configuring the network

120

The HMI device must be configured prior to network operation. The configuration is basically
divided into the following steps:

Proceed as follows:

1. Enter the computer name of the HMI device.
2. Configure the network address.

3. Set the logon information.
4

. Save the settings.

MP 277 (WinCC flexible)
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6.11.2 Setting the device name of the HMI device

Introduction

The HMI device uses the device name to identify itself in the network.

Requirements

You have opened the "System Properties" dialog box by pressing the "System" &Z77 icon.

_,‘G-er-werall Memory | Device Mame ]

These settings are used to identify your Windows CE device to
other cormputers,
Pleaze type a name (without any spaces) and a short description.

Device name:; | skl MEEE]

®
Device description; [HHI Device —_@

©) Device name of the HMI device

® Description for the HMI device (optional)

Note

Change the device name for the HMI device in the "Device name" text box to activate the
network functions.

Procedure
Proceed as follows:
1. Enter the device name for the HMI device in the "Device name" text box.
2. Enter a description for the HMI device in the "Device description” text box.
3. Confirm your entries.
The dialog closes.
Result
The device name for the HMI device is now set.
See also

Overview of network operation (Page 119)
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6.11.3 Changing the Network Configuration

Overview

You can change the network settings for the LAN connection under "Network & Dial-Up
Connections".

Requirement - changing LAN connection settings

You have pressed the "Network&Dial-Up Connections" e;; icon to open the following view.

[z1[x]

|Fi|E Edit View Advanced ||}(||E

LARNSO001

Procedure
Proceed as follows:
1. Open the "LAN90001" entry.
— The "SMC LAN91C111 Ethernet' Settings" dialog opens.

"SMC LANO1C111 Ethernet’ Settings [

IP Address lName Servers | Ethermet Parameters |

& IP address can be (") Ohtain an IP address via DHCP
autornatically assigned to this
computer, If your netwerk ® =0 5

does not autornatically assign ) :
IP addresses, ask your network IP Address: 152,168 56 8

adrministratar for an address, Subnet Mask: 555 255 255 .0
and then type it in the space -
provided, Default Gateway: |:|

2. Select either automatic address assignment via DHCP or manual address assignment.

3. If you assign the address manually, enter the respective addresses in the text boxes for
"IP Address", "Subnet Mask" and, if used, "Default Gateway".

4. If a name server is used in the network, change to the "Name Servers" tab.

'SMC LANO1C111 Ethernet’ Settings [

IP Address | Mame Servers ]Ethernet Parameters |

Marme server addresses may be  Primary DMS: |:|
autornatically assigned if DHCP

is enabled on this adapter. Secondary DhS: l:|
You can specify additional

WINS or DMS resokvers in the PRIETY LA lII
spare provider. Seconclry s [ ]
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5. Enter the respective addresses in the text boxes.

6. Change to the "Ethernet Parameters" tab.

"SMC LANO1C111 Ethernet’ Settings ok}

IP Address ] Marme Servers | Ethernet Parameters ]

Port:

Mode and Speed:

100 MEit) Fullduples:

7. In the "Mode and Speed" selection list, select the transmission speed and mode.
8. Confirm your entries.

The dialog box closes.
9. Close the "Network&Dial-Up Connections" view.

The Control Panel is displayed again.

Result
The LAN connection parameters for the HMI device have been changed.

See also
Overview of network operation (Page 119)
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6.11.4

Introduction

Requirements

Procedure

Result

See also

124

Changing the Logon Data

Windows CE uses this information to gain access to the network resources. Enter the user
name, password and domain you have received from your administrator.

You have opened the "Network ID" dialog box by pressing the "Network ID" =

]
= icon.

Identification |

Windows CE uses this User namme: |
inforrmation to gain access to

network resources, Enter the  Password: |
Liser narme, password, and

dormain provided by your Darnair: |

retwork adrinistrator,

Proceed as follows:

1. Enter the user name in the "User name" text box.
2. Enter your password in the "Password" text box.

3. Enter the domain name in the "Domain" text box.
4. Confirm your entries.

The dialog closes.
The logon information has now been set.

Overview of network operation (Page 119)

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01



Configuring the operating system

6.117 Configuring network operation

6.11.5 Changing E-Mail Settings

Requirement

You have opened the "WinCC flexible Internet Settings" dialog box by pressing the

SMTP server
@ IJse the default of the project file

O

Mame

Marne of sender: I

eMail address I
of sender:

©O ©

@ Setting the SMTP server
® Name for the sender

® E-mail account

Note
Options

The "WinCC flexible Internet Settings" tab can contain additional tabs. This depends on the
options that have been enabled for network operation in the project.

Procedure — changing e-mail settings
Proceed as follows:
1. Specify the SMTP server.

— Select the "Use the default of the project file" option button if you want to use the
SMTP server configured in the project.

— Deactivate the "Use the default of the project file" option button if you do not want to
use the SMTP server configured in the project.

— Specify the required SMTP server.
2. Enter the name for the sender in the "Name of sender" text box.
3. Enter the e-mail account for your e-mail in the "E-mail address of sender" text box.

Some e-mail providers only allow you to send mail if you specify the e-mail account. The
"E-mail address of sender" text box can remain empty if your e-mail provider allows you
to send mail without checking the account.

4. Confirm your entries.

The dialog box closes.
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Result

See also

The e-mail settings have been changed.

Overview of network operation (Page 119)

6.11.6 Changing internet settings

6.11.6.1  Changing General Internet Settings

Requirements

Procedure

126

You have opened the "General" tab in the "Internet Options" dialog box by pressing the

"Internet Options" 9 icon.

Internet Options m
G3Eneral |C0nnectinn I Privacy IAdvanced |
Start Page: Ihttp:waw.siemens.cumfautumation
Search Page; Ihttp:waw.siemens.cnmfautnmatinnfservice
User Agent (requires browser restart): |Defau|t (Windows CE) El
Cache Size (in KB): |512 |Clear Cache | |Clear Histurvl

Note

Do not change the settings in the "User Agent" field.

Proceed as follows:

o gk 0N~

Confirm your entries.

The dialog closes.

Enter the required start page for the browser in the "Start Page" text box.
Enter the address of the required search engine in the "Search Page" field.
Enter the required cache memory size in the "Cache" text box.

The cache can be deleted by means of the "Clear Cache" button.

The history can be deleted by means of the "Clear History" button.

MP 277 (WinCC flexible)
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Result

The general parameters for the Internet browser have been set.

See also

Overview of network operation (Page 119)

6.11.6.2 Setting the Proxy Server

Requirements

You have opened the "Connection" tab in the "Internet Options" dialog box by pressing the

"Internet Options" i\) icon.

Internet Options m
- Connection |Pri\tacy | sdvanced |
[[]Use L&N (no autodial)  Autodial name: | El
Network

|:| #ccess the Internet using a proxy server:

Address: I Paort: IBEI

|:| Bypass prowy server for local addresses

Procedure
Proceed as follows:
1. Activate the "Use LAN (no autodial)" check box.

2. If you use a proxy server, activate the "Access the Internet using a proxy server" check
box in the network group.

Specify the address of the proxy server and the port.

Note

The proxy settings in the Control Panel apply to all applications that are running on the
HMI device.

The Pocket Internet Explorer requires independent proxy settings that you must specify in
the properties of the Pocket Internet Explorer. You can find additional information at the
Microsoft's website.

3. If you want to bypass the proxy server for local addresses, activate the
"Bypass proxy server for local addresses" checkbox.

4. Confirm your entries.

The dialog closes.
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See also

Overview of network operation (Page 119)

6.11.6.3 Changing Privacy Settings

Cookies and encryption

Requirements

Procedure

128

Cookies are pieces of information sent by a web server to a browser. In the event of
subsequent access to the web server, the cookies are sent back. This enables information to
be stored between the accesses.

In order to ensure a high level of privacy, data are sent via the Internet in encrypted form.
Common encryption protocols include SSL and TLS. You can activate or deactivate the
usage of encryption protocols.

The required settings can be obtained from your network administrator.

You have opened the "Privacy" tab in the "Internet Options" dialog box by pressing the

"Internet Options" ;“"‘!’icon.

Internet Options m
| General | Conmection | Privacy | Advanced |

Cookies

First-party Cookies Third-party Cookies

@ accept () Accapt

() Black {7 Block

) Prompt {® Prompt

Always allow session cookies

Proceed as follows:
1. Select the required cookie behavior by means of the option buttons.
"Accept"
Cookies are stored without request.
— "Block"
Cookies will not be stored.
- "Prompt"
Cookies will be stored on request.

2. If you want allow cookies which are restricted to a single session, activate the "Always
allow session cookies" checkbox.

MP 277 (WinCC flexible)
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3. Change to the "Advanced" tab.

6.117 Configuring network operation

Internet Options

okf %

[General I Connection I Privacy | Advanced |

Use 55L 3.0
Use TLS 1.0

warn if changing between secure and not secure mode

4. Activate the required encryption protocol.
5. Confirm your entries.

The dialog closes.

Result
The logon information has now been set.

See also

Overview of network operation (Page 119)

6.11.6.4 Importing and Deleting Certificates

Overview

You can import, view and delete certificates that have been imported for the HMI device. The

certificates differ in the following ways:
e (Certificates that you trust
® Own certificates

e Other certificates

You can import additional certificates and delete certificates that are not required.

The required settings can be obtained from your network administrator.

MP 277 (WinCC flexible)
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Requirements

Procedure

Result

See also

130

You have opened the "Certificates" dialog box by pressing the "Certificates" icon.

Stares |

Class 2 Public Prirnary Certification Authority E
Class 3 Public Prirnary Certification Authority
Entrust.net Certification authority (2048) l
Entrust.net Secure Server Certification Authorit

Lists the certificates Equifax Secure Certificate Autharity
trusted by you GlobalSign Root C& E|
Import.. | | View.. | | Remove |

Proceed as follows:
1. Select the type of certificate from the selection box:
"Trusted Authorities"
"My Certificates"
"Other Certificates"
2. You can start the import by pressing the "Import" button.
A dialog with source details will open.
3. Ifrequired, delete the certificate.
— Mark the desired certificate.
— Delete the selected certificate by pressing the "Remove" button.
4. Press the "View" button to list the properties of the selected certificate.

5. Close the dialog.

The changes to the certificates have been undertaken.

Overview of network operation (Page 119)
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6.12 Saving to external storage device (backup)

Introduction

A backup involves copying the operating system, applications and data from the internal in
flash memory of the HMI device to an external storage device.

The following external storage devices are possible:
e External memory

® USB memory stick

Requirements

e The HMI device features an external storage device with sufficient free space.

® You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup [ Restore

Al other application rust be ended before
starting <BACKUP= or <RESTORE:=.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE

Procedure - using a memory card for the first time

NOTICE

Loss of data possible

The first time you use a memory card the HMI device will request that you format the card.

Save a backup copy of memory card data to a PC before formatting.

Proceed as follows:

1. Cancel the formatting procedure by pressing "ESC".
Remove the memory card from the HMI device.
Save a backup copy of vital data to a PC.

Insert the memory card into the HMI device.

o~ wDd

Format the memory card on the HMI device.
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Procedure

Result

132

Proceed as follows:

1.

Press the "BACKUP" button to open the "Select Storage Card" dialog.

The "--- no storage card available ---" message appears if there is no external memory in
the HMI device or if this memory is defective. Insert an external memory or a different
one.

Select the external memory for backup from the "Please select a Storage Card" list box.

3. Click on the "Start Backup" button.

The HMI device checks the external memory.

If the "This storage card..." message appears, an external memory with a greater memory
capacity is needed. Acknowledge this message. Backup is aborted. Insert an external
memory with a greater memory capacity and restart the backup process.

If the "You may have an old backup on the storage card. Do you want to delete it?"
message appears, there is already a backup on the external memory. If you do not want
to overwrite the backup, press the "No" button. Otherwise click on the "Yes" button.

Several messages are displayed in sequence during the backup process:
— Saving registry data
— Copy files

A progress bar shows the status of the backup process. When the backup process is
completed, the following message is displayed:

"The operation completed successfully."

. Acknowledge this message.

The dialog closes.

The HMI device data is now saved on the external memory.
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6.13 Restoring from external storage device

Introduction

A restore operation deletes the old data from flash memory of the HMI device on

confirmation. The data stored on the external memory is then copied to the internal flash
Flash memory.

Requirements

® The external memory holding the backed up data is inserted in the HMI device.

® You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup f Restore

&l ather application must be ended before
starting <BACKUP> or <RESTORE:.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE

NOTICE

Loss of data possible

All data on the HMI device will be deleted during a restore operation. License keys are
deleted after counter-inquiry.

Back up the HMI device's data before restoring if required.
External memory with data backup

If several external memories with data backups are plugged in, the data cannot be
restored.

Remove the external memory with the data backups not needed.
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Procedure

134

Proceed as follows:
Press the "RESTORE" button to open the "Storage Card" dialog.

1.

3.

Storage Card H

Storage Card with Backup detected:

--- nio storage card available ---

Refresh

Orly one Storage Card containing Backup is allowed.

0

Mo Storage Card detected, please insert Storage
Card and press =Refreshiz.

| Cancel | Start Restore

®  No storage card available

®  Only one storage card containing backup is allowed. No storage card detected. Insert a

storage card and press the "Refresh" button.

detected" selection box.

2. Select the external memory with the backup from the "Storage Card with Backup

The "--- no storage card available ---" message appears if there is no external memory in

the HMI device or if this memory is defective.

If the "--- no storage card available ---" message appears, press the "Cancel" button.

Restoring is then aborted.
— Insert a memory card or a different one.
— Click on the "Refresh" button.

The content of the selection box will be changed.

— Select the external memory with the backup from the "Storage Card with Backup

detected" selection box.

4. Click on the "Start Restore" button.

Restoring is started.

5. The data to be restored is checked.

The following messages are displayed in sequence during the check.

"Starting Restore"
"Checking data"

When the data has been checked, the following message is displayed:

"You are starting RESTORE now. All files (except files on storage cards) and the registry

will be erased. Are you sure?"

The message means that the restore process can be started. All files files except those
located on the external memory will be deleted. Tab entries are also deleted. Are you

sure?
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If you do not want to allow the data to be deleted from the HMI device, abort the restore
process by pressing the "ESC" button.

. Start to restore the data by selecting "Yes".

The following messages are displayed in sequence during the restore:
"Deleting files on flash"
"Restore CE Image"

A progress bar shows the status of the restore process.

When restore is completed, the following message is displayed:

"Restore succesfully finished. Press ok, remove your storage card and reboot your
device."

8. Remove the external memory.

9. Acknowledge this message.

Result

The HMI device starts.

The data from the external memory is now on the HMI device.

Note
Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.
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6.14 Activate Memory Management

Memory management

Requirements

Procedure

Result

136

If reorganization of the memory is required during the runtime of project, the HMI device can
shut down the project autonomously.

The project is shut down and the HMI device will display a message. You have to restart the
project.

NOTICE

If you do not activate memory management, undefined states can occur during the runtime
of the project.

You have opened the "Memory Monitoring” tab in the "OP Properties" dialog box by pressing

the "OP" ééicon.

[ Diisplay l Device Mernory Monitoring l 4
MMaximum used memory: 13°fq
Current used memary: ID%J

OXC,

[ 5hut down HMI Runtime iF memory is running low,:

@ The maximum used memory since last power on of the HMI device and the current used
memory in percent.

® Control box for activation of memory management

Proceed as follows:
1. In order to start memory management, activate the control box.
2. Confirm your entries.

The dialog closes.

Memory management is activated.
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7.1 Overview

Configuration phase

A project — the process image of the working process — is produced during configuration to
visualize automated working processes. The process displays for the project contain
displays for values and messages which provide information about process statuses. The
process control phase follows the configuration phase.

Process control phase

The project must be transferred to the HMI device if it is to be used in process control.
Another precondition for process control is that the HMI device is connected online to a
controller. Current working processes - operating and observing - can then be subject to
process control.

Transferring the project to the HMI device
You can transfer a project to an HMI device as follows:
e Transfer from the configuring PC
® Restore from a PC using ProSave

In this case, an archived project is transferred from a PC to the HMI device. The
configuration software need not be installed on this PC.

Commissioning and recommissioning
Initial and re-start-ups differ in the following respects:
® \When the HMI device is commissioned there is no project at first.
The HMI device is also in this state after the operating system has been updated.

® \When recommissioning, any project already on the HMI device is replaced.

MP 277 (WinCC flexible)
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7.2 Operating modes

Operating modes
The HMI device may be in the following operating modes:
o Offline
® Online
® Transfer

"Offline mode™" and "Online mode" can be set on both the configuring PC and the HMI
device. To set these modes on the HMI device, use a corresponding operating element of
the project.

Changing the operating mode

The configuration engineer must have configured an appropriate operating element to allow
a change of the operating mode on the HMI device during ongoing operation.

Further information on this may be available in your plant documentation

"Offline" operating mode

In this mode, there is no communication between the HMI device and PLC. Although the
HMI device can be operated, it cannot exchange data with the PLC.

"Online" operating mode

In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI
device according to your system configuration.

"Transfer" mode

In this mode, you can transfer a project from the configuring PC to the HMI device or backup
and restore HMI device data, for example.

The following options are available for setting "Transfer" mode on the HMI device:
® \When the HMI device starts up

Start "Transfer" mode manually in the HMI device Loader.
® During ongoing operation

Start the "Transfer" mode manually within the project using an operating element. The
HMI device toggles to "Transfer" mode when automatic mode is set and a transfer is
initiated on the configuring PC.

MP 277 (WinCC flexible)
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7.3 Using existing projects

The following table shows how you can reuse existing projects, while observing the screen
size:

HMI device in the existing project New HMI device

TP 270 10" MP 277 10" Touch or MP 277 8" Touch

OP 270 10" MP 277 10" Key

MP 270 6" Touch TP 277 6" "

MP 270 10" Touch MP 277 10" Touch or MP 277 8" Touch

MP 270 10" Key MP 277 10" Key

N If you have set options on the MP 270 6" Touch, you must use the MP 277 8" Touch as the
successor.
The following cases are possible:
1. Project in ProTool exists:
Migrate the project to WinCC flexible and subsequently carry out an HMI device switch.
2. Project in WinCC flexible exists:
Carry out an HMI device switch in WinCC flexible.

Further information on the subject can be found in the WinCC flexible Online Help or in the
"WinCC flexible Migration" manual.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, A5E02479740-01 139



Commissioning a project

7.4 Data Transmission Options

7.4

Overview

140

Data Transmission Options

The following table shows the options for data transfer between the MP 277 and the

configuration PC.

Type Data channel MP 277
Backup Serial 1) Yes
MPI/PROFIBUS-DP Yes
USB Yes
Ethernet Yes
Restoring Serial 1) Yes
MPI/PROFIBUS-DP Yes
USB Yes
Ethernet Yes
Update operating system. Serial, with reset to factory state Yes
Serial » Yes
MPI/PROFIBUS-DP Yes
USB Yes
Ethernet Yes
Transferring a project Serial " Yes
MPI/PROFIBUS-DP Yes
USB Yes
Ethernet Yes
Installing or removing an option Serial 1) Yes
MPI/PROFIBUS-DP Yes
USB Yes
Ethernet Yes
License key transferring or Serial 1) Yes
transferring back MPI/PROFIBUS-DP Yes
USB Yes
Ethernet Yes
N Applies when PC/PPI cable is used
MP 277 (WinCC flexible)
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7.5 Transfer

7.5.1 Overview

Transfer
Transfer the executable project from the configuring PC to the HMI device.
You can start the "Transfer" mode manually or automatically on the HMI device.

Transferred data is written directly to the internal flash memory on the HMI device. For the
transfer, you use a data channel which you have to configure before starting a transfer.

Backtransfer

You have the option to transfer the compressed project file together with the runtime project
to the HMI device. If necessary, the compressed project file can be transferred back to the
configuring PC and edited.

The HMI device must be equipped with an external memory card to which the compressed
project file can be saved.

NOTICE
Compressed project file

WinCC flexible does not check whether the compressed project file stored on the HMI
device corresponds to the existing runtime project.

7.5.2 Starting manual transfer

Introduction
You can manually switch the HMI device to "Transfer" mode as follows:
e \With a configured operating element during ongoing operation.
® |n the Loader of the HMI device.

Requirements
® The project "™.hmi" is opened in WinCC flexible.
e The HMI device is connected to a configuring PC
® The data channel is configured on the HMI device

® The HMI device is in "Transfer" mode

MP 277 (WinCC flexible)
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7.5 Transfer

Procedure

Result

See also

7.5.3

Introduction
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Proceed as follows:

1. On the configuring PC, select the "Transfer settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the
HMI device:

Select the "Enable backtransfer" check box.
6. Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The project is transferred to
the HMI device. If the connection is not available or is defective, an error message is
displayed on the configuring PC.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

Operating modes (Page 138)
Configuring the data channel (Page 115)

Data Transmission Options (Page 140)

Starting automatic transfer

The HMI device can be automatically switched to "Transfer" mode during runtime as soon as
transfer is started on the configuring PC connected.

Automatic transfer is particularly suited for the test phase of a new project since transfer is
completed without interfering with the HMI device.

MP 277 (WinCC flexible)
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7.5 Transfer

Automatic transfer is available for the following data channels:
® Serial

e MPI/PROFIBUS DP

e USB

e FEthernet

NOTICE

If the automatic transfer has been activated on the HMI device and a transfer is initiated
on the configuring PC, the project currently running is automatically stopped. The HMI
device then automatically switches to "Transfer" mode.

After the commissioning phase, deactivate the automatic transfer so that the HMI device
cannot be inadvertently switched to transfer mode. The transfer mode can trigger
unintentional actions in the device.

You can set a password for the Loader of the HMI device to restrict access to the
transfer settings and thus avoid unauthorized modifications.

Requirements
® The project *.hmi is opened in WinCC flexible.
® The HMI device is connected to a configuring PC
® The data channel is configured on the HMI device
® The automatic transfer is activated in the data channel for the transfer.

® The project is started on the HMI device.

Procedure
Proceed as follows:

1. On the configuring PC, select the "Transfer settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the
HMI device:

Select the "Enable backtransfer" check box.
6. Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The HMI device shuts
down the current project and automatically switches to "Transfer" mode The project is
transferred to the HMI device. If the connection is not available or is defective, an error
message is displayed on the configuring PC.

MP 277 (WinCC flexible)
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7.5 Transfer

Result

See also

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

Operating modes (Page 138)
Configuring the data channel (Page 115)
Data Transmission Options (Page 140)

754 Starting backtransfer

Requirements

Procedure

Result
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No project is open on the configuring PC in WinCC flexible
The HMI device is connected to this configuring PC

The data channel is configured on the HMI device

The HMI device is in "Transfer" mode

The memory card containing the compressed project file is inserted into the HMI device

Proceed as follows:

. On the configuring PC, select the "Communication settings" command in the menu

"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Transfer" > "Backtransfer" command in the "Project”" menu.

The "Backtransfer" dialog opens.

. Click "OK" to start the backtransfer process.

The configuring PC checks the connection to the HMI device. The compressed project file
is transferred back from the HMI device to the configuring PC. If the connection is not
available or is defective, an error message is displayed on the configuring PC.

After successful backtransfer, the project is opened on the configuring PC in WinCC flexible.

MP 277 (WinCC flexible)
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7.5 Transfer

7.5.5 Testing a project

Introduction

There are two options to test a project:

Test the project on the configuring PC

You can test a project at a configuring PC, using a simulator. For detailed information,
refer to the "WinCC flexible" user manual and to the WinCC flexible Online Help.

Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and PLC is down
while the test is being carried out.

Online testing of the project on the HMI device

Online testing means that the HMI device and PLC communicate with each other during
testing.

Perform the tests, starting with the "Offline test", followed by the "Online test".

Note
You should always test the project on the HMI device on which the project will be used.

Check the following:

1.
2.
3.
4.

Check the correct layout of the screens
Check the screen navigation
Check the input objects

Enter the tag values

The test increases the certainty that the project will run error-free on the HMI device.

Requirements for offline testing

Procedure

The project has been transferred to the HMI device

The HMI device is in "Offline" mode

In "Offline" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags, therefore, are not updated.

Test the operating elements and visualization of the project as far as possible without
connecting to the PLC.

Requirements for online testing

MP 277 (WinCC flexible)

The project has been transferred to the HMI device

The HMI device is in "Online" mode
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7.6 Backup and restore

Procedure

7.6

7.6.1

In "Online" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags are updated in this case.

You have the option to test all communication-dependent functions, for example alarms, etc.

Test the operating elements and views of the project.

Backup and restore

Overview

Backup and restore

NOTICE
License keys

License keys are not taken into account for backups and restores. License keys are saved
in the working memory of the HMI device and cannot be deleted.

You can back up and restore the following data found in the internal flash memory of the HMI
device with a PC:

® Project and HMI device image

® Password list

® Recipe data

Use one of the following tools for backup and restore:
® WinCC flexible

® ProSave

General information

146

NOTICE

Power failure

If a complete restore operation is interrupted due to power failure on the HMI device, the
operating system of the HMI device may be deleted! The operating system then has to be
updated.

Compatibility conflict

If a message is output on the HMI device warning of a compatibility conflict during the
restore operation, the operating system must be updated.

MP 277 (WinCC flexible)
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7.6.2 Backup and restore using WinCC flexible

Requirements
® The HMI device is connected to a configuring PC
® No project is open in WinCC flexible

® The data channel is configured on the HMI device

Procedure for backup
Proceed as follows:

1. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.
The "Backup Settings" dialog opens.

6. Select the data to be backed up.

7. Select a destination folder and a file name for the "*.psb" backup file.

8. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

9. Start the backup operation in WinCC flexible with "OK" on the configuring PC.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

Result
The system outputs a message when the backup is completed.

The relevant data is now backed up on the configuring PC.

MP 277 (WinCC flexible)
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7.6 Backup and restore

Procedure for restore

Result

See also
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Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible.

The "Restore Settings" dialog opens.
Select the "*.psb" backup file to be restored from the "Open" field.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

Start the restore operation in WinCC flexible with "OK" on the configuring PC.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the configuring PC is

now on the HMI device.

Overview (Page 146)

Data Transmission Options (Page 140)

Operating modes (Page 138)

Configuring the data channel (Page 115)
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7.6 Backup and restore

7.6.3 Backup and restore using ProSave

Requirements

The HMI device is connected to a PC on which ProSave is installed

The data channel is configured on the HMI device

Procedure for backup
Proceed as follows:

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the data to be backed up in the "Backup" tab.

5. Select a destination folder and a file name for the "*.psb" backup file.

6. Set "Transfer" mode on the HMI device.

Result

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

Start the backup operation in ProSave with "Start Backup".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

The system outputs a message when the backup is completed.

The relevant data is now backed up on the PC.

MP 277 (WinCC flexible)
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7.6 Backup and restore

Procedure for restore

Result

See also
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Proceed as follows:

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "*.psb" backup file to be restored from the "Restore" tab.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

Start the restore operation in ProSave on the PC with "Start Restore".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the PC is now on the
HMI device.

Overview (Page 146)

Data Transmission Options (Page 140)

Operating modes (Page 138)

Configuring the data channel (Page 115)
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7.7 Updating the operating system

7.7 Updating the operating system

7.71 Overview

Updating the operating system

A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuration PC.

There are two ways to match the versions:

e Update the HMI device image if the project was created with the most recent version of

MP 277 (WinCC flexible)

the configuration software.

Transfer a matching version of the HMI device image if you do not want to adapt the
project for the HMI device to the most recent version of the configuration software for the
project.

NOTICE

Data loss

All data on the HMI device, such as the project and licenses, will be deleted when you
update the operating system.

Note

When WIinAC MP is used, all data channel parameters are reset.

Note
Calibrating the touch screen

After the update, you may have to recalibrate the touch screen.
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7.7.2 Resetting factory settings

In ProSave or WinCC flexible, you can update the operating system with or without resetting

to factory settings.
e Updating the operating system without resetting to factory settings

First, switch into "Transfer" mode on the HMI device or use the automatic transfer
function if the project is active. Then start the operating system update in ProSave or

WinCC flexible.
e Updating the operating system with resetting to factory settings

NOTICE

Loss of license keys

without resetting to factory settings.

The license keys on the HMI device will be deleted when resetting to factory settings.
The license keys on the HMI device will be retained when updating the operating system

NOTICE

Data channels

can only be started following reconfiguration of the data channels.

When resetting to factory settings, all data channel parameters are reset. The transfer

Note

You have to perform an operating system update with reset to factory settings if the HMI
device does not yet have an operating system or if the HMI device's operating system is

corrupt.

First, start the operating system update in ProSave or WinCC flexible and switch the

power on the HMI device off and on again when prompted.

7.7.3 Updating the Operating System using WinCC flexible

Requirement
® No project is open on the configuration PC in WinCC flexible.

® The HMI device is connected to this configuration PC.

® \When updating the operating system without reset to factory state:

The data channel on the HMI device is configured.

MP 277 (WinCC flexible)
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Procedure

Result

See also

7.7 Updating the operating system

Proceed as follows:

1.

10.

11

12.

When updating the operating system with reset to factory state only:
Switch off power to the HMI device.

On the configuration PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuration PC, then set
the connection parameters.

Close the dialog box with "OK".
Select the "OS Update" command from the "Project > Transfer" menu in WinCC flexible.

Select whether to update the operating system with or without restoring the factory state
by setting the "Reset to factory settings" check box accordingly.

"

Select the HMI device image file "*.img" under "Image path".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

The output area provides information on the version of the successfully opened HMI
device image file.

When updating without reset to the factory state only:
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

In WinCC flexible, select "Update OS" on the configuration PC to run the operating
system update.

. When updating with reset to the factory state only:

Switch on the power supply to the HMI device.
Follow the instructions in WinCC flexible.

A progress bar indicates the progress of the operating system update.

A message is displayed when the operating system update is successfully completed.

The HMI device no longer contains any project data.

Overview (Page 155)

Configuring the data channel (Page 115)

Operating modes (Page 138)

Data Transmission Options (Page 140)
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1.74

Requirement

Procedure

Result
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Updating the Operating System using ProSave

® The HMI device is connected to a PC on which ProSave is installed.

® When updating the operating system without reset to factory state only:

The data channel is configured on the HMI device.

Proceed as follows:

1.

11.

When updating the operating system with reset to factory state only:
Switch off power to the HMI device.

Go to the Windows Start menu and start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC, then set the
connection parameters.

Select the "OS Update" tab.

Select whether to update the operating system with or without restoring the factory state
by setting the "Reset to factory settings" check box accordingly.

Select the HMI device image file ".img" under "Image path".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

The output area provides information on the version of the successfully opened HMI
device image file.

When updating without reset to the factory state only:
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

Select "Update OS" on the PC to run the operating system update.

. When updating with reset to the factory state only:

Switch on the power supply to the HMI device.
Follow the instructions in ProSave.

A progress bar indicates the progress of the operating system update.

A message is displayed when the operating system update is successfully completed.

The HMI device no longer contains any project data.

MP 277 (WinCC flexible)
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See also

Overview (Page 155)

Configuring the data channel (Page 115)

Operating modes (Page 138)

Data Transmission Options (Page 140)
7.8 Installing and removing options
7.8.1 Overview

Installing and removing options

You can install options on the HMI device, for example, additional programs developed
especially for the HMI device.

You can also remove the option from the HMI device again.

Note
License key

A license key may be needed to run an option. The license key unlocks the option for use.

7.8.2 Installing and removing options using WinCC flexible

Requirements
® The HMI device is connected to a configuring PC
® No project is open in WinCC flexible

® The data channel is configured on the HMI device

Procedure for installing an option
Proceed as follows:

1. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.
2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC, then set
the connection parameters.

4. Close the dialog with "OK".

5. Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.

MP 277 (WinCC flexible)
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7.8 Installing and removing options

6.
7.

Result

Select the desired option under "Available options".
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in WinCC flexible on the configuring PC with the ">>"
button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.

Procedure for removing an option
Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

*®
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Result

Select the type of connection between the HMI device and the configuring PC, then set
the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Select the desired option under "Installed options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

Start the removal of the option in WinCC flexible on the configuring PC with the "<<"
button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the removal.

The option has now been removed on the HMI device.

See also

Operating modes (Page 138)

Overview (Page 155)

Configuring the data channel (Page 115)

Data Transmission Options (Page 140)
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7.8 Installing and removing opftions

7.8.3 Installing and removing options using ProSave

Requirements

The HMI device is connected to a PC on which ProSave is installed

The data channel is configured on the HMI device

Procedure for installing an option

Proceed as follows:

N o g ks~ o=

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "Options" tab.

Select the desired option under "Available options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

8. Start the installation of the option in ProSave with the ">>" button.

9. Follow the instructions in ProSave.

Result

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.

MP 277 (WinCC flexible)
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7.9 Transferring and transferring back license keys

Procedure for removing an option

Result

See also

7.9

7.9.1
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Proceed as follows:

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "Options" tab.

Press the "Device status" button to update the display.

Select the desired option under "Installed options".

© N o Ok w2

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

9. Start the removal of the option in ProSave with the "<<" button.
Follow the instructions in ProSave.

A status display appears indicating the progress of the removal.

The option has now been removed on the HMI device.

Overview (Page 155)

Configuring the data channel (Page 115)
Operating modes (Page 138)

Data Transmission Options (Page 140)

Transferring and transferring back license keys

Overview

With the purchase of an add-on package, you obtain a specific user license with an
associated license key. Once you have installed an add-on, transfer a license key to the HMI
device. The license key unlocks an add-on for use.

You can also transfer back the license key from the HMI device to a license diskette.

Note

License keys can only be transferred and transferred back with the Automation License
Manager or WinCC flexible.

MP 277 (WinCC flexible)
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7.9 Transferring and transferring back license keys

7.9.2 Transferring and transferring back license keys

Requirements

The HMI device is connected to a configuring PC

When transferring or transferring back using WinCC flexible:
No project is open in WinCC flexible

The data channel is configured on the HMI device

The license diskette with the license key to be transferred must be inserted in the floppy
drive of the configuring PC

Procedure for transferring a license key

Proceed as follows:

1.
2.

Switch to "Transfer" mode on the HMI device.
When transferring using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When transferring using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect Target System" dialog opens.

4. Under "Device Type", select the appropriate HMI device type.

5. Select the type of connection in the "Connection" field and set the connection parameters.
6. Select "OK".

Result

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the source drive.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then transferred to the HMI device.

The license key has now been transferred from the license diskette to the HMI device.

MP 277 (WinCC flexible)
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7.9 Transferring and transferring back license keys

Procedure for transferring a license key back

Result

See also

160

Proceed as follows:

1.
2.

Switch to "Transfer" mode on the HMI device.
When transferring back using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When transferring back using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect Target System" dialog opens.

4. Under "Device Type", select the appropriate HMI device type.

5. Select the type of connection in the "Connection" field and set the connection parameters.
6. Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

. In the left window, select the HMI device.

The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then transferred back to the license diskette.

The license key has now been transferred back from the HMI device to the license diskette.

Overview (Page 155)

Configuring the data channel (Page 115)

Operating modes (Page 138)

Data Transmission Options (Page 140)
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8.1 Overview

Configuration and process control phase

HMI devices can be used to operate and monitor tasks in process and production
automation. The plant screens on the HMI devices are used to provide a clear overview of
the active processes.

The HMI device project, which includes the plant screens, is created during the configuration
phase. The configuration engineer defines which tasks the HMI device has in the process
and defines the following in detail:

e \Which process data is displayed on the individual HMI device
e Which plant components are controlled by this HMI device

The configuration engineer stores this information in the project's screens. The project is
transferred to the HMI device during commissioning.

After transfer to the HMI device, current processes can be operated and monitored in the
project's screens. The screens enable you to observe, for example, operational states,
current process data and faults in a plant. Operating elements which are used to operate the
process, for example buttons, I/O fields and alarm windows, are displayed in the screens.

Operator control options

The hardware of the HMI device determines which of the following operator control options
are available:

® Touch screen

The operating elements shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operating elements
by touching them with your finger. To double-click them, touch an operating element
twice in succession.

o HMI device keyboard

The operating elements shown in the screens are selected and operated using the keys
of the HMI device.

e External keyboard, connected via USB

o FExternal mouse, connected via USB

A\ crution

Do not use any pointed or sharp objects when operating the touch screen. Otherwise
this may damage the plastic membrane of the touch screen.

The following provides instructions for operating a project with the touch screen and the
keyboard.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01 161



Operating a project

8.1 Overview

Operating a project with an external keyboard

An external keyboard can be used to operate a project in exactly the same way as with the
HMI keyboard or screen keyboard.

Note
The function keys of the external keyboard are disabled.

Use the other keys of the external keyboard, which correspond to the HMI device keys in the
description.

Operating a project with an external mouse

An external mouse can be used to operate a project in exactly the same way as with the HMI
touch screen. Click the described operating elements with the mouse.

Unintentional actions

A\ caution

Do not carry out several operations simultaneously. You may otherwise trigger
unintentional actions.

e With touch control:

Always touch only one operating element on the screen
o With key control:

Do not press more than two keys simultaneously

Observing the plant documentation

Some operations with the project may require in-depth knowledge about the specific plant on
the part of the operator. Proceed with caution, for example, when you use jog mode. Further
information on this may be available in your plant documentation

Operation feedback from operating elements

The HMI device provides operation feedback as soon as it detects that an operating element
has been selected. This operation feedback is independent of any communication with the
PLC. Therefore, this operation feedback does not indicate whether the relevant action is
actually executed or not.

Optical feedback from operating elements

The operating element receives the focus and is selected. The configuration engineer can
also configure the selection of an operating element so that it deviates from the standard.
Further information on this may be available in your plant documentation

MP 277 (WinCC flexible)
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The type of optical feedback depends on the operating element:
e Buttons

The HMI device outputs different views of the "Pressed" and "Unpressed" states,
provided the configuration engineer has configured a 3D effect:

"Pressed" state:

"Unpressed" state:

The configuration engineer determines the appearance of a selected field, for example,
line width and color for the focus.

® |nvisible buttons

By default, invisible buttons are not displayed as pressed when they are touched. No
optical feedback is provided in this case.

The configuration engineer may, however, configure invisible buttons so that their outline
appears as lines when touched. This outline remains visible until you select another
operating element.

e |/O fields

When you select an 1/O field, the content of the I/O field is displayed against a colored
background. With touch operation, a screen keyboard is displayed for the entering of
values.

Acoustic feedback from operating elements

As soon as the HMI device detects a touch of the touch screen or that a key has been
pressed, an acoustic signal is issued. You can activate or deactivate this acoustic operation
feedback.

Note

The acoustic feedback is only possible if you interact with the project directly on the touch
screen or press one of the keys of the HMI device. If you use an external mouse or keyboard
for interaction, no acoustic signal is issued.

Acoustic signal for inadvertent operations

If you try to enter an invalid character, the HMI device issues an acoustic signal in
accordance with the setting.

See also
Set the volume (Page 103)
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8.2 Direct keys

Introduction
Direct keys on the HMI device are used to set bits in the I/O area of a SIMATIC S7.

Direct keys enable operations with short reaction times that are, for example, a jog mode
requirement.

NOTICE

Direct keys are still active when the HMI device is in "offline" mode.

NOTICE

If you operate a function key with direct key functionality in a running project, the direct key
function is always executed, independent of the current screen contents.

Note

You can only use direct keys when there is a connection via PROFIBUS DP or
PROFINET IO.

Direct keys result in additional basic load on the HMI device.

Direct keys
The following objects can be configured as a direct key:
e Buttons
® Function keys

You can also define image numbers in the case of HMI devices with touch operation. In this
way, the project engineer can configure the direct keys on an image-specific basis.

Further information on configuring direct keys can be found in the
"WinCC flexible Communication" system manual.

See also
Bit assignment of the direct keys (Page 258)

Enabling PROFINET 10 (Page 117)
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8.3 Setting the project language

Introduction

The HMI device supports multilingual projects. You must have configured a corresponding
operating element which lets you change the language setting on the HMI device during
runtime.

The project always starts with the language set in the previous session.

Requirements
® The required language for the project must be available on the HMI device

® The language switching function must be logically linked to a configured operating
element such as a button

Selecting a language

You can change project languages at any time. Language-specific objects are immediately
output to the screen in the new language when you switch languages.

The following options are available for switching the language:
e A configured operating element switches from one language to the next in a list
e A configured operating element directly sets the desired language

Please refer to your system documentation to check whether additional information on this
subject is available there.

See also
Changing Regional Settings (Page 97)
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8.4 Entering values using the touch screen

8.4.1 Overview

Screen keyboard

When you touch an operating element requiring entry on the HMI device touch screen, a
screen keyboard appears. The screen keyboard is displayed in the following cases:

® An |/O field is selected for input
e A password must be entered for accessing a password-protected function
The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen
keyboards for entering numerical or alphanumerical values.

Note

The screen keyboard display is independent of the configured project language.

General procedure
The operating elements of a screen are operated by touching the touch screen.
Proceed as follows:
1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:
— 1/O field: Enter numerical, alphanumerical or symbolic values in the I/O field
— Symbolic I/O field: Select an entry from the drop down list box

— Slider control: Move the slider control

MP 277 (WinCC flexible)
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Procedure for text boxes

Values are entered in the project text boxes. Based on your configuration, the values are
saved to tags and transferred, for example, to the PLC.

Proceed as follows:
1. Touch the desired text box within the screen.
The screen keyboard opens.

Depending on your configuration, you can enter values in the text box in the following
manner:

— Numerical values, for example decimal numbers, hexadecimal numbers, binary values
— Alphanumerical values, for example digits and letters
— Date/time

2. Enter the value.

3. Confirm your entry with 4|"E or discard your entry with the button El

8.4.2 Entering and Editing Numerical Values

Numerical screen keyboard

When you touch an operator control for numerical input on the HMI-device touch screen, the
numerical screen keyboard appears. This is the case, for example, for a text box. The screen
keyboard is automatically hidden again when input is complete.

8| 9|« [Ex

516 el | Ins
2 3‘J

= ESC| 4= | —»

|Num Help

ol o NN

Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select screen" has no function.
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Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Binary

® Hexadecimal

Note
Entry of hexadecimal values

When you enter values in hexadecimal format, the alphanumerical screen keyboard
opens.

Limit test of numerical values

Tags can be assigned limits. If you enter a value that lies outside of this limit, it will not be
accepted, for example, 80 with a limit of 78. In this case the HMI device will deliver a system
alarm, if an alarm window is configured. The original value is displayed again.

Decimal places for numerical values

The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.

® Decimal places in excess of the limit are ignored.

o Empty decimal places are filled with "0".

MP 277 (WinCC flexible)
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Procedure

Numerical values can be entered character-by-character via the buttons on the numerical
screen keyboard.

Proceed as follows:
1. Touch the desired operator control within the screen.

The numerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

The keys with for example the letters G to Z are available to enter a hexadecimal value;
however, the characters are not entered. Depending on the settings, the HMI device
outputs an audible signal.

You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter
the value.

Use the il and il keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the = | key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

The Cel | key deletes the character positioned to the right of the cursor. If the value is

selected, use this key to delete the selected part of the value.

Hel
— Usethe Ll key to display the info text of the 1/O field.

This key is only enabled if info text has been configured for the input object or the
current screen.

3. Use the 4|"‘E key to confirm your entry or cancel it with ESC| Either action closes the

screen keyboard.

Result
You have changed the numerical value or entered a new one.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, A5E02479740-01 169



Operating a project

8.4 Entering values using the fouch screen

8.4.3 Entering and editing alphanumerical values

Alphanumerical screen keyboard

When you touch an operator control for alphanumerical input on the HMI-device touch
screen, the alphanumerical screen keyboard appears. This is the case, for example, for a
text box. The screen keyboard is automatically hidden again when input is complete.

Keyboard levels

170
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Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select screen" has no function.

Language switching

Language switching in the project has no influence on the alphanumerical screen keyboard.
The entry of Cyrillic or Asian characters is therefore not possible.

The alphanumerical screen keyboard has various levels.
® Normal level
e Shift level

If you change the levels with key | the key assignments change.

MP 277 (WinCC flexible)
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Procedure
Alphanumerical values can be entered character-by-character via the buttons on the
alphanumerical screen keyboard.
Proceed as follows:
1. Touch the desired operator control within the screen.
The alphanumerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.
2. Enter the value.
You have the following options to enter a value:
— The selected value is deleted when you enter the first character. Completely reenter
the value.
— Use the il and il keys to move the cursor within the current value. You can
now edit the characters of the current value or add characters.
Use the = | key to delete the character to the left of the cursor. If the value is
selected, use this key to delete the selected part of the value.
The el | key deletes the character positioned to the right of the cursor. If the value is
selected, use this key to delete the selected part of the value.
- Usingkey % | it is possible to switch between the keyboard levels of the screen
keyboard. On switchover, the key assignments of the screen keyboard change.
Help . . .
— Use the 4| key to display the info text of the I/O field.
This key is only enabled if info text has been configured for the input object or the
current screen.
3. Use the 4|"‘E key to confirm your entry or cancel it with ESC| Either action closes the
screen keyboard.
Result

You have changed the alphanumeric value or entered a new one.
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8.4.4 Entering the date and time

Entering the date and time

See also

Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

Entering and Editing Numerical Values (Page 167)

Entering and editing alphanumerical values (Page 170)

8.4.5 Entering Symbolic Values

Selection list

Procedure

Result

172

Operator control for entering symbolic values offer you a list from which you can select the
input values. When you touch a symbolic I/O field on the HMI device touch screen, the
following selection list opens.

Proceed as follows:

1. Touch the required operator control.
The selection list of the operator control opens. Select =l and =l to scroll in the selection
list.

2. Touch the required entry in the selection list.

The selected entry is accepted as an entry.

You have changed the symbolic value or entered a new one.
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8.4.6 Displaying Infotext

Purpose

The configuration engineer uses info text to provide additional information and operating

instructions. The configuration engineer can configure info text on screens and operator
controls.

The infotext of an I/O field can contain, for example, information on the value to be entered.

Info text

Enter kemperature sekpoint For Tank_1
{Range 40 .., 50°C)

Opening info text for operator controls
1. Touch the required operator control.

The screen keyboard opens. You can see from the appearance of the i | key

whether info text has been configured for the operator control or the current screen.

Hel
2. Touch the il key on the screen keyboard.

The info text for the operator control is displayed. If there is no info text for the selected
screen object, the info text for the current screen is displayed, if it has been configured.

You can scroll through the contents of long info text with =land 2.

Note
Switching between displayed info text

The configuration engineer can configure infotext for an I/O field and the associated
screen. You can switch between two info texts by touching the info text window.

3. Close the displayed info text by pressing (X

Alternative procedure

Depending on your configuration, info text can also be called via a configured operator
control.

Refer to your plant documentation to find any available additional information on this topic.
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8.5

8.5.1 Control keys

Introduction

Entering values using the keys

The following tables show the control keys with which you operate the project. You will also
find detailed descriptions under the individual operating elements.

Select operating elements

Key

Functions

Description

TAB

SHIFT

+

Tabulator

Selects the next/previous operating element in the tab
sequence.

>
\4

>Jal|[f]

Cursor keys

Selects the next operating element to the left, right, above
or below the current screen object.

Navigates in the operating element.

Using operating elements

A

ey

Functions

Description

<]

+

Position the cursor

Positions the cursor within an operating element, e.g. in
the 1/0 field.

Scroll back

Scrolls back a page in a list.

s}
S

+
I
m

TR
N 2 = =3 =
= Had il il T T
m — — — —

+

Scroll to the beginning

Scrolls to the beginning of a list.

m
Z 44
o

Scroll forward

Scrolls one page forward in a list.

+
m
H

Scroll to the end

Scrolls to the end of a list.

2

-
m z
X

Enter key

e Operates buttons.

e Accepts and ends an entry.

e Opens a drop down list box.

e Toggles within a text box between character mode
and normal mode.

In character mode, a single character is selected. In
this mode, you can advance in the character set
using the cursor keys.
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A

ey

Functions

Description

ESC

Cancel

the original value.
¢ Closes the active dialog.

e Deletes the characters of a value entry and restores

INS

Delete characters

position.

Deletes the character to the right of the current cursor

n H
m
=

Delete characters

Deletes the character to the left of the current cursor
position.

Open drop down list box

Opens a drop down list box.

Accept value

Accepts the selected value in the drop down list box
without closing the list.

Enter key combinations

A

ey

Functions

Purpose

Toggle key assignment

Switches over key assignment of keys with multiple
assignment.

e No LED is illuminated:
The number assignment is enabled. Pressing the
button once toggles to letter assignment.

e AnLED s lit:

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
between the left letter assignment, the right letter
assignment and the number assignment.

SHIFT

Toggle between upper-
case and lower-case

Used in key combinations, for example for entering
upper-case letters.

-
H.

Switch to additional key
assignment

Some of the keys contain a blue imprinted key
assignment , for example the "%" character.

Used in key combinations for the blue key assignment.

()
=
)
2

General control function

Used in key combinations

ALT

General control function

Used in key combinations

Acknowledge alarms

Key

Functions

Description

ACK

Acknowledge

Acknowledges the currently displayed fault alarm or all

the alarms of an alarm group as group acknowledgment.

The LED lights up as long as unacknowledged fault
alarms are active.

MP 277 (WinCC flexible)
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Displaying infotext

Key Functions

Description

Displaying infotext

Opens a window with the configured infotext at the
selected object, e.g. alarm or I/O field. If an infotext
exists for the selected object, the LED lights up.

Multi-key operation

Unwanted actions may be triggered, if the operator unintentionally actuates a key

combination.

A\ cruTtion

Unintentional actions

actions in the plant.

In "Online" mode, simultaneous operation of more than two keys may cause unintentional

Never press more than two keys simultaneously.

8.5.2 Example: Enter characters using the alphanumeric keyboard

Using the same keys of the alphanumeric keyboard you can enter up to six different
characters. The entry result depends on the combination of the keys pressed.

The values "5", "M", "m", "N", "n" and "%" are entered using the same key of the

keyboard. You can use the keys , and to switch between the different

assignments..

The following table shows the entry options using the key .

176

Key Key Key Result
No LED is lit Not relevant Not pressed 5
Left LED is illuminated. Not pressed Not pressed m
Left LED is illuminated. Pressed Not pressed M
Right LED is illuminated. Not pressed Not pressed n
Right LED is illuminated. Pressed Not pressed N
Not relevant Not relevant Pressed %
MP 277 (WinCC flexible)
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8.5.3 Function keys

Function keys

Function key assignment is defined during configuration. The configuration engineer can
assign function keys globally and locally.

Function keys with global function assignment

A globally assigned function key always triggers the same action on the HMI device or in the
PLC irrespective of the screen displayed. Such an action could be, for example, the
activation of a screen or the closure of an alarm window.

Function keys with local function assignment

A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one.
The local assignment function takes priority over the global setting.

The configuration engineer can assign function keys in such a way that you can operate
operating elements with function keys, for example, the alarm view, trend view, recipe view
or status / force.

8.54 General procedures

Introduction

The control keys and function keys of the HMI device are available for key control

General procedure
The operating elements of a screen are operated using the control keys of the HMI device.

Proceed as follows:

1. Continue to press the key or the cursor keys until the required operating element is
selected on the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:
— 1/O field: Enter numerical, alphanumeric or symbolic values in the 1/O field

— Slider control: Move the slider control

3. Confirm the operation with the key or abort the operation with the key .
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8.5.5 Entering and editing numerical values

Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Hexadecimal

® Binary

Limit value test of numerical values

Tags can be assigned limit values. If you enter a value that lies outside of this limit, it will not
be accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver
a system alarm, if an alarm window is configured. The original value is displayed again.

Procedure

Numerical and alphanumerical values can be entered in character mode using the system
keys.

Proceed as follows:

1. Select the desired text box within the screen with .

The existing value is selected in the text box.
2. Enter the value using the numerical keypad.
You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter
the value.

— Press and a cursor key simultaneously. The selection of the field content is
canceled. Move the cursor in the existing value. You can now edit the characters of

the current value or add characters.

INS
The key deletes the character positioned to the right of the cursor. Use the

key to delete the character to the left of the cursor.

To enter the hexadecimal characters "A" to "F", switch the numerical keypad to letter

assignment using the key .

— If the LED of the key is lit, infotext is available for the selected object or the

current screen.

Use the key to display the infotext for the operating element or current screen.

3. Select to confirm your entry.
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Result

You have changed the numerical value or entered a new one.

8.5.6 Entering and editing alphanumerical values

Procedure
Alphanumerical values can be entered in character mode using the system keys.
Proceed as follows:

1. Select the desired text box within the screen with .

The existing value is selected in the text box.
2. Enter the value using the system keys.
You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter
the value.

— Press and a cursor key simultaneously. The selection of the field content is
canceled. Move the cursor in the existing value. You can now edit the characters of

the current value or add characters.

INS
The key deletes the character positioned to the right of the cursor. Use the

key to delete the character to the left of the cursor.

To enter letters, switch the numerical keypad to letter assignment using the key .

— If the LED of the key is lit, infotext is available for the selected object or the
current screen.

Use the key to display the infotext for the operating element or current screen.

3. Select to confirm your entry.

Result

You have changed the alphanumeric value or entered a new one.
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8.5.7 Entering the date and time

Entering the date and time
Enter the date and time in the same way you enter alphanumerical values.

See also

Note

When entering the date and time, please note that the format is determined by the

configured project language.

Entering and editing numerical values (Page 178)

Entering and editing alphanumerical values (Page 179)

8.5.8 Entering Symbolic Values

Selection list

Procedure

Result

180

When you select a symbolic IO field, a selection list opens.

Symbolic values are selected from the entries of a selection list.

Proceed as follows:

1. Select the desired symbolic text box within the screen with .

2. Open the selection list using the key. The selection list opens.

3. Select the required entry using the cursor keys IZI E or IEI

4. Confirm your entry with the key.

You have changed the symbolic value or entered a new one.

MP 277 (WinCC flexible)
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8.5.9 Displaying Infotext

Purpose
The configuration engineer uses info text to provide additional information and operating
instructions. The configuration engineer can configure info text on screens and operator
controls.
The infotext of an I/O field can contain, for example, information on the value to be entered.

Info text

Enter kemperature sekpoint For Tank_1
{Range 40 .., 50°C)
If the LED of the key lights up, an infotext has been configured for the selected display
object or for the current screen.

Procedure

1. Press .

The info text for the selected screen object is displayed. If there is no info text for the
selected screen object, the info text for the current screen is displayed, if it has been
configured.

You can scroll through the contents of long info texts using the cursor keys E and IZ'

Note
Switching between displayed info text

The configuration engineer can configure infotext for an I/O field and the associated

screen. You can switch between two infotexts by pressing the key.

2. Close the infotext by pressing the key.

Alternative procedure

Depending on your configuration, info text can also be called via a function key or via an
existing operator control.

Refer to your plant documentation to find any available additional information on this topic.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01 181



Operating a project

8.6 Bar and gauge

8.6 Bar and gauge

Bar

Layout

Gauge

Layout

Operation

182

The bar is a dynamic display object. The bar displays a value from the PLC as a rectangular
area. The bar allows you to recognize the following at a glance:

® The distance of the current value from the configured limit values
® Whether a set point value has been reached

The bar can display values such as fill levels or batch counts.
100

&0
30
0

The layout of the bar depends on the configuration:
® The bar may feature a scale of values
® The configured limit values can be indicated by lines

® (Color changes can signal when a limit value has been exceeded or has not been reached

The gauge is a dynamic display object. The gauge displays numerical values in analog form
by means of a pointer. This enables an operator at the HMI device to see at a glance if the
boiler pressure is in the normal range, for example.

The layout of the gauge depends on the configuration:

e A trailing pointer can display the maximum value reached so far on the scale. The trailing
pointer is reset when the screen is reloaded

® The label on the scale can show the measured variable, for example boiler pressure and
the physical unit, for example bar

The bar and the gauge are for display only. Both objects cannot be controlled by the
operator.

MP 277 (WinCC flexible)
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8.7 Operating the switch

Introduction
The switch is an operating element and display object with two predefined switching states,
for example "On" and "Off". Switches can signalize the state of a plant section, for example if
a motor is running or not. At the same time, you can use the switch to change the state of
the corresponding plant section via the HMI device, for example from "On" to "Off".

Layout

The layout of the switch depends on the configuration:
e Switch with slider

The two states are displayed by the position of the slider

Swyitch

@ Slider
e Switch with text or graphic
The two states are displayed by the label on the slider

Depending on the switching state, the switch is labeled with one of two texts or one of two
graphics.

Examples:

"Backward" or "Forward"

Procedure using the touch screen
® Switch with slider
Proceed as follows:
Move the slider to the other position or double-click the slider area
e Switch with text or graphic
Proceed as follows:

Touch the switch

Procedure using the keys
Proceed as follows:

1. Select the desired switch within the screen with .

2. Press .
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8.8 Operating the Slider Contro/

Result

The switch changes its appearance. The associated value is switched.

8.8 Operating the Slider Control

Introduction
The slider control can be used to monitor and change process values within a defined range.
The slider control can also be configured without a slider. In this case, you cannot enter a
value. The slider control is then only used for displaying values.
SIMATIC
@ Slider control for entering values
® Value display with current value
Layout

The layout of the slider control depends on the configuration:
® The slider control can contain a label and a setting range

® The current value can be displayed below the area of the slider control

Procedure using the touch screen
Proceed as follows:
1. Touch the slider of the desired slider control.
2. Move the slider to the required value.
If a value display has been configured, you can check the exact value that has been set.
3. Release the slider.

MP 277 (WinCC flexible)
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Key control

8.8 Operating the Slider Contro/

The following table shows the control keys used to set the slide to a desired value:

Key combination

Description

Increase value by 1

Reduce value by 1

Increase value in 5% increments.

Decrease value in 5% increments.

Set maximum value

Set minimum value

Procedure using the keys

Proceed as follows:

1. Use the key to select the desired slider control within the screen.

2. Move the slider to the required value.

If a value display has been configured, you can check the exact value that has been set.

Result

The set value is applied.

MP 277 (WinCC flexible)
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8.9 Operating the Trend View

8.9 Operating the Trend View

Trends

Trends continuously display the current process data or process data from a log.

Trend view

Trends are displayed in the trend view. A trend view can display several trends
simultaneously.

100°] ’
@
D_I , 1
| || | @ | & | & é 5 ———Q2)
Trend Tag assignment Value Date/time ~
Pressure Pressure pattern 2|5 31.01.2006 13:06:34 v
©) Ruler
® Buttons for trend operation

® Trend value in the value table

Layout and operation

The layout and operation of the trend view depends on the configuration. The configuration
engineer determines the following, for example:

® Appearance of the trend view, the axes, value ranges and labels
e QOperating options of the trend view

e Limits for the trend values

® The change of color of the trend in the event of limit violation

Refer to your plant documentation to find any available additional information on this topic.

Value table
The trend values can be read from the value table if this is configured:

® When the ruler is displayed, the trend values are shown at a position of the ruler in the
value table

e \When the ruler is hidden, the latest trend values are displayed in the value table

MP 277 (WinCC flexible)
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Ruler
When configured, a ruler is available to provide an exact reading of the trend values in the
value table.
You can move the ruler to the desired position of the trend view.

Operation

The trend view can be operated as follows:

Enlarge or reduce the time interval displayed

Scroll forward or back by one display width

Stop and resume trend recording

Move the ruler

Hide and display the ruler

The following table shows the trend view buttons:

Key combination Function

Stops or continues trend recording.

Button
.
#) ¥, ¥ 2 Enlarges the displayed time section.
=1 . e F Reduces the displayed time section.
- . IE' Scrolls one display width backward (to the left).
" . IE' Scrolls one display width forward (to the right).
4 ; Scrolls back to the beginning of the tren.d recording. The
start values of the trend recording are displayed there.
= . N IE' Moves the ruler backward (to the left).
55 . N IE' Moves the ruler forward (to the right).
o=

Shows or hides the ruler.

=
i
b

In addition, the configuration engineer can configure function keys or operator controls with
which you can control trend views.

Refer to your plant documentation to find any available additional information on this topic.

Touch operation
Touch the required button in the trend view.

The position of the ruler can also be changed by means of touching and dragging the ruler
on the touch screen.
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Procedure using the keys

Proceed as follows:

1. Use the key to select the desired button within the trend view.

2. Confirm your entry by pressing the key.

8.10 Operating the status force

8.10.1 Overview

You read or write access values of the connected PLC directly with status force. Status force
allows you to monitor or change addresses of the PLC program, etc. You don't need to
connect an additional programming device or additional PC to the PLC.

Status force can only be used in combination with SIMATIC S5 or SIMATIC S7.

The figure shows the general layout of status force. A value can be monitored or controlled

The configuration engineer specifies which columns appear in status force.

MP 277 (WinCC flexible)

Application
Note
Layout
The layout of status force depends on the configuration.
on every line.
The following figure shows an example of Status Force.
CDnnectiDnl Typel Ostetl FDrmatl Contral Yalue | [l
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PLC_1 T |40 |7 24,00
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] [ _>I_I
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8.10 Operating the status force

The table shows the significance of all configurable columns.

Column Functions

"Connection" The PLC whose address ranges must be displayed.

"Type", "DB Number", "Offset", "Bit" The address range of the value

"Data Type", "Format" The data type of the value
"Status Value" The value read from the specified address.
"Control Value" The value to be written to the specified address.

Further information on this may be available in your plant documentation

Operating elements

Depending on your configuration, you can operate the Status Force using the following
buttons:

Buttons Functions

G "Read" button
_m |

Updates the display in the "Status Value" column.

This button engages when it is pressed. You cannot operate any text boxes until
the button is actuated again and the refresh is stopped.

"Write" button

Applies the new value in the "Control Value" column. The control value is written
to the PLC.

8.10.2 Touch operation

Operator input options
Status Force can be operated as follows:
® (Change the column sequence
® Read the status values of the connected PLC

® Enter values and transfer them to the PLC

Change column sequence
Depending on the configuration, you can change the column sequence of Status Force.
Proceed as follows:
1. Touch the column header which you wish to exchange with a different column header

2. Keeping the touch screen pressed, move the column heading to the column heading you
wish to exchange it with

Result
The columns are displayed in the modified sequence.
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Procedure for reading the status value
Proceed as follows:
1. Enter the address and the desired format of a value for each line. Touch the respective
columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the ﬁ button.

Result

All values are read cyclically by the PLC and entered in the "Status value" column until the

i’ button is touched again.

Requirements for forcing
The following requirements must be fulfilled in order to force values:
® The "Control value" column must be available

® The "Write" button must be available

Procedure for forcing a value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired value in the "Control value'
column. Touch the respective columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the # button.

Result
The values from the "Control value" column are transferred once to the PLC.

MP 277 (WinCC flexible)
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8.10.3 Key control

Operator control options

8.10 Operating the status force

Status force can be operated as follows:

® (Change the column width.

® Read the status values of the connected PLC

® Enter values and transfer them to the PLC

Key control

The following table lists the key combinations for operating the status force:

Keys

Functions

[
e, [LJ]

Operates the "Read" button.

(9]

TRL

+
m

Operates the "Write" button.

[9)
=
)
2
+

Selects the first/last field in the current line.

[e)
=
P
z
+

(¢}
=
Py
P
+

Selects the first/last field in the current column.

INS
DEL

o
4
X
P
+

5| € ] W @] [

Deletes the current line.
Otherwise:

Do not select a PLC in the "Connection" column.

Opens selection box.

Increases the width of the current column.

() @] m
= = =
Py Py m
— — X
+
H -
[l r
— —
+

+

iz

Decreases the width of the current column.

=
N

5)
g
P
—
+

+

Optimizes column width.
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Procedure for reading the status value
Proceed as follows:

1. Enter the address and format of the status value for each status value you wish to read in
one line. Select the respective fields and enter the values using the keyboard.

{ }
CTRL .
2. Press + !

Result

All status values are read cyclically from the PLC and entered in the "Status Value" column

1}
until the + keys are pressed again.

Requirements for forcing
The following requirements must be fulfilled in order to force values:

® The "Control Value" column must be available

® The "Write" button must be available

Procedure for forcing a value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired control value in the "Control
Value" column. Select the respective fields and enter the values using the keyboard.

2. Once you have entered all of the desired control values, press the + key.

Result
The values from the "Control Value" column are transferred once to the PLC.

Alternative procedure

Alternatively, you can also select the buttons i and =2 using the key

and operate it using key .
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8.11

8.11.1

Application

Layout

Monitoring mode

Operation

8.11 Operating the Sm@rtClient view

Operating the Sm@rtClient view

Overview

The Sm@rtClient view enables you to monitor and remotely operate the current project of a
remote HMI device. With the correct configuration, several equal priority HMI devices can
access a remote HMI device.

Note

If another HMI device accesses your HMI device via the Sm@rtClient view, this leads to an
additional load on your HMI device.

In the Sm@rtClient view, the remote HMI is displayed with the complete layout.
Depending on the configuration, you can monitor and also operate this screen.

You can also operate the function keys like buttons on an HMI device with a touch screen.

On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the
remote HMI device. You cannot control its operation.

Note

It is not possible to operate the direct keys of the remote HMI device from the local HMI
device.

The available operator controls depend on the HMI devices used:
® Same type of HMI devices

You can operate the project of the remote HMI device with the operator controls of your
HMI device

e Operate keys from a local touch screen

All the keys of the remote HMI device are displayed as buttons on the touch screen. You
can touch them to operate them.

® Touch operation from a local HMI device using keys

You operate the buttons in the usual manner.
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8.11.2 Touch operation

Operator input options
The Sm@rtClient view can be operated as follows:

e Starting remote control

® [orcing permission

® Ending remote control

Procedure for starting remote control
Proceed as follows:

1.

On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote HMI
device:

— The connection is established automatically.
— The connection must be established by touching the appropriate button.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

The current screen of the project running on the remote device is displayed on the screen
of your HMI device.

You can now monitor or control this screen depending on your configuration.

Scroll bars are displayed if the screen of the remote HMI device is larger than that of the
current HMI device.

Procedure for forcing permission

If several HMI devices have access to a HMI device, only one HMI device has operating
permission at any one time.

Two cases must be distinguished for this case:

194

If another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

— You are now authorized to operate the remote HMI device

If another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device

— Touch the screen of your HMI device five times consecutively

— You are given permission to operate your local HMI device

MP 277 (WinCC flexible)
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Procedure for ending remote control

You can end monitoring and control of a remote HMI device with one of the following
methods depending on the configuration:

® Touch a button configured for this action
® Exit the screen containing the Sm@rtClient view

® |f configured, a menu is displayed after you have touched an empty space over a longer
period. Select the "Close" menu item.

Please refer to your system documentation to check whether additional information on this
subject is available there.

8.11.3 Key control

Operator control options
The Sm@rtClient view can be operated as follows:
e Starting remote control
® Forcing permission

® Ending remote control

Procedure for starting remote operation
Proceed as follows:
1. On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote HMI
device:

— The connection is established automatically.

— Continue to press the key until the Sm@rtClient view is selected.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

The connection is established. The current screen of the project running on the remote
device is displayed on the screen of your HMI device.

2. You can now monitor and control this screen depending on your configuration.

3. Scroll bars are displayed if the screen of the remote HMI device is larger than that of the

current HMI device. Move the scroll bars in the direction required using keys + IZI

orf +[¥].
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Procedure for forcing permissions

If several HMI devices access an HMI device, only one HMI device has permission to
operate.

Two cases must be distinguished for this case:

e |f another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

You are now authorized to operate the remote HMI device

e |f another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device
— Press five times consecutively.

You are given permission to operate your local HMI device

Procedure for ending remote control

You can end monitoring or control of a remote HMI device with one of the following methods
depending on the configuration:

® Press the key configured for this.

® Exit the screen containing the Sm@rtClient view

e [f configured, display a menu with + . Select the desired menu command with

and the respective identification letter.

Further information on this may be available in your plant documentation
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8. 12 Project security

8.12 Project security

8.12.1 Overview

Design of the security system

The configuration engineer can protect the operation of a project by implementing a security
system.

The security system is based on authorizations, user groups and users.

If operating elements protected by a password are operated, the HMI device first requests
that you log on. A logon screen is displayed in which you enter your user name and
password. After logging on, you can operate the operating elements for which you have the
necessary authorizations.

The logon dialog can be set up by the configuration engineer via an individual operating
element.

In the same way, the configuration engineer can set up an operating element to log off. After
logging off, objects assigned password protection can no longer be operated; to do so, log
on again.

Further information on this may be available in your plant documentation

User groups and authorizations

Project-specific user groups are created by the configuration engineer. The "Administrators"
and "PLC User" groups are included in all projects by default. User groups are assigned
authorizations. Authorization required for an operation is specifically defined for each
individual object and function in the project.

Users and passwords

Logoff times

Each user is assigned to exactly one user group.

The following people are allowed to create users and assign them passwords:
® The configuration engineer during configuration

® The administrator on the HMI device

® A user with user management authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

A logoff time is specified in the system for each user. If the time between any two user
actions, such as entering a value or changing screens, exceeds this logoff time, the user is
automatically logged off. The user must then log on again to continue to operate objects
assigned password protection.
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Backup and restore

The user data is encrypted and saved on the HMI device to protect it from loss due to power
failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be
backed up and restored. This prevents you having to enter all of the data again on another
HMI device.

NOTICE

The currently valid user data is overwritten in the following cases:
¢ Depending on the transfer settings, when the project is transferred again
e Upon restore of a backed-up project

e Upon import of the user administration via an operating element. Further information on
this may be available in your plant documentation

The retransferred or restored user data and passwords are valid with immediate effect.

Limits for user, password and user View

8.12.2

Application

Layout

198

Number of characters
Length of user name, maximum 40
Length of password, minimum 3
Length of password, maximum 24
Entries in user view, maximum 50

User view

The user view is used to display the users on the HMI device:

e All users on the HMI device are displayed in the user view to the administrator or to a
user with administrator authorizations

e |f you are a user without user management authorization, you can only see your personal
user entry

The authorizations of a user after logging on depends on the user group to which the user is
assigned.

Please refer to your system documentation to check whether additional information on this
subject is available there.

The configuration engineer can implement a simple or extended user view.

The two user views offer the same functions. They differ only in the display of information.

MP 277 (WinCC flexible)
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Simple user view

If you are not logged on to the HMI device, the only entry contained in the simple user view
is "<ENTER>".

If you are logged on to the HMI device, the simple user view only displays the user name
and user group.

Gr'l:ll_l[:l |::":4.'::|
PLC User Group (1)
Uszer 1 Group (1)
<Mew Lser=

Extended user view

The extended user view displays information about the users.

Logoff time

Adrmin Group (9% 9

PLIC Liger || ****wrs I Group (1) 5

User 1 | **wwswss | Group (1) 5

1| | B

The extended user view contains the following columns:
® Users

e Password

e Group

® [ ogoff time

The passwords are encrypted by appearing as asterisks.
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8.12.3 User logon

Logon dialog

Use the logon dialog to log on to the security system of the HMI device. Enter your user
name and password in the logon dialog.

x

Lser: I

Password: I

(04 | Cancel |

The logon dialog opens in the following cases:

You press an operating element with password protection

You press an operating element that was configured for displaying the logon dialog
Select the "<ENTER>" entry in the simple user view

Select a blank entry in the extended user view

The logon dialog will be automatically displayed when the project is started, depending on
the configuration

Please refer to your system documentation to check whether additional information on this
subject is available there.

Requirements

The logon dialog is open.

Procedure using the touch screen

Proceed as follows:

1.

2.

200

Enter the user name and password.
Touch the corresponding text box. The alphanumerical screen keyboard is displayed.

Select "OK" to confirm logon.
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Procedure using the keys

Result

Proceed as follows:

1. Using the key select the "User" text box within the logon dialog.

2. Enter the user name using the system keys.

To enter letters, switch the numerical keypad to letter assignment using the key .

3. Using the key select the "Password" text box.

4. Enter the password using the system keys.

5. Touch the "OK" button to confirm your entries.

Note
The user name is not case-sensitive.

The password is case-sensitive.

After successful logon to the security system, you can execute password-protected functions
on the HMI device for which you have authorizations.

If you enter a wrong password, an error message is displayed when an alarm window has
been configured.

8.124 User logoff

Requirements

Procedure

Result

You have logged into the security system of the HMI device.

You have the following options for logging off:
® You press an operating element that was configured for logoff

® You will be logged off automatically if you are not operating the project and if the logoff
time has been exceeded

You will also be automatically logged off if you enter an incorrect password.

You are no longer logged into the project. In order to activate an operating element with
password protection, you must first log on again.

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01 201



Operating a project

8. 12 Project security

8.12.5 Creating users

8.12.5.1 Creating users with touch operation

Requirements
You have opened a screen containing the user view.

You have user management authorization or you are the administrator.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\'"

Procedure for creating a user in the simple user view
Proceed as follows:
1. Touch the "<New User>" entry in the user view.
The following dialog opens:

RN x|

Liser: I

Password: I

Ok | Cancel |

2. Enter the desired user name and password.

Touch the corresponding text box. The alphanumerical screen keyboard is displayed.
3. Touch the "OK" button.

The following dialog opens:

DN x|
Group: {Group (1) |
Logoff time: |5

Cancel |

4. Assign the user to a group.

In order to do so, open the "Groups" drop down list by means of the =l button. Select 4

and =l to scroll in the drop down list box.

MP 277 (WinCC flexible)
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5. Touch the required entry in the drop down list box.
The selected entry is then accepted as input.
6. Touch the text box "Logoff time". The screen keyboard is displayed.

7. Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no
automatic logoff."

8. Touch the "OK" button to confirm your entries.

Procedure for creating a user in the enhanced user view
Proceed as follows:
1. Touch the desired field in the blank line of the user view.

The appropriate screen keyboard is displayed.

2. Switch into input mode by means of the 4|"‘E key.
3. Enter the respective user data in the field:
— Assign the user to one of the groups from the drop down list box.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

Result
The new user is created.

8.12.5.2 Creating users with key operation

Requirements
You have opened a screen containing the user view.

You have user management authorization or you are the administrator.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\""

MP 277 (WinCC flexible)
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Procedure for creating a user in the simple user view
Proceed as follows:

1. Select the user view using the key or using the cursor keys.

2. Select the entry "<New user>" in the user view with the cursor keys and confirm with .
The following dialog opens:

O x|

LIser: I

Password: I

Ok | Cancel |

3. Enter the desired user name using the system keys.

4. Select the next text box with the key and enter a password using the system keys.

5. Touch the "OK" button to confirm your entries.

The following dialog opens:

DN x|
Group: |Group (1) =|
Logoff tirme: |5

Cancel |

6. Select the "Group" selection box with .

7. Assign the user to a group.
— Select to open the drop down list box. The drop down list box opens.
— Select the required entry using IZI or E
— Confirm your entry by pressing the key .

8. Select the text box "Logoff time" with .

9. Enter the desired logoff time using the system keys.

Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no
automatic logoff."

10. Touch the "OK" button to confirm your entries.
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Procedure for creating a user in the enhanced user view

Proceed as follows:

Result

. Select the user view with the key via the configured tab order.

Select a blank line with the IZI or E keys.

Select the desired field in the blank line of the user view with the IE' or IEI keys.

Confirm your entry by pressing the key .

Enter the desired user data:

— Enter the data using the system keyboard. To enter letters, switch the numerical
keypad to letter assignment using the key .

— Assign the user to one of the groups from the drop down list box. Open the drop down

list box with the key and select the desired entry with the IZ' or Iz' keys.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

Confirm your entry by pressing the key .

The new user is created.

MP 277 (WinCC flexible)
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8.12.6 Changing user data

8.12.6.1 Changing user data with touch operation

Requirements
You have opened a screen containing the user view.
Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name

Group assignment

Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

— Password

— Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC

Procedure for changing user data in the simple user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Procedure for changing user data in the extended user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Result
The user data for the user is changed.

MP 277 (WinCC flexible)
206 Operating Instructions, 03/2009, A5E02479740-01



Operating a project

8. 12 Project security

8.12.6.2 Changing user data with key operation

Requirements
You have opened a screen containing the user view.
Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name

Group assignment

Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

— Password

— Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC

Procedure for changing user data in the simple user view
Proceed as follows:

1. Confirm your entry by pressing the key .

2. Inthe user view, use the cursor keys to select the user whose user data you want to
change. Confirm your entry by pressing the key _

3. When entering the data, use exactly the same procedure as for creating a user

Procedure for changing user data in the enhanced user view
Proceed as follows:

1. Confirm your entry by pressing the key .

2. Use the cursor keys to select the field in which you want to change data. Confirm your

entry by pressing the key .

3. When entering the data, use exactly the same procedure as for creating a user

Result
The user data for the user is changed.
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8.12.7 Deleting users

Requirements
You have opened a screen containing the user view.

To delete a user, you must be an administrator or have user management authorization.

Note

The "Admin" and "PLC_User" users exist by default. These users cannot be deleted.

Procedure
To delete a user, delete the user name entered.

Result
The user has been deleted and may no longer log onto the project.

8.13 Closing the project

Procedure
Proceed as follows:
1. Use the corresponding operating element object to close the project.
Wait for the Loader to open after you closed the project.

2. Switch off power to the HMI device.

MP 277 (WinCC flexible)
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9.1 Overview

Alarms

Alarms indicate events and states on the HMI device which have occurred in the system, in

the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:

The configuration engineer defines which alarms must be acknowledged by the user.

An alarm may contain the following information:

MP 277 (WinCC flexible)

Incoming
Outgoing

Acknowledge

Date

Time

Alarm text
Location of fault
State

Alarm class
Alarm number
Alarm group

Diagnostics capability

Operating Instructions, 03/2009, ASE02479740-01

209



Operating alarms

9.1 Overview

Alarm classes

Alarm groups

Alarm buffer

Alarm report

Alarm log

210

Alarms are assigned to various alarm classes:
e Error

Alarms in this class must always be acknowledged. Error alarms normally indicate critical
errors within the plant such as "Motor temperature too high"

® Operation

Warning alarms usually indicate states of a plant such as "Motor switched on"
® System

System alarms indicate states or events which occur on the HMI device
e SIMATIC diagnostic alarms

SIMATIC diagnostic alarms show states and events of the SIMATIC S7 or
SIMOTION PLCs

® User-specific alarm classes
The properties of this alarm class must be defined in the configuration

Please refer to your system documentation to check whether additional information on this
subject is available there.

The configuration engineer can group alarms into alarm groups. When you acknowledge an
individual alarm of an alarm group, you acknowledge all alarms which belong to the same
alarm group.

The alarm events are stored in an internal buffer. The size of this alarm buffer depends on
the HMI device type.

The configuration engineer can activate alarm reporting on the project. In this case, alarm
events are output directly on the connected printer.

The configuration engineer can define whether each individual alarm is logged. An alarm of
this type is printed when the alarm events "Incoming" and "Outgoing" occur.

If you want to print alarms of the "System" alarm class, you have to print the contents of the
associated alarm buffer. For this case the configuration engineer has to configure an
operating element for printing the alarm buffer.

Alarm events are stored in an alarm log, provided this log file is configured. The capacity of
the log file is limited by the storage medium and system limits.

MP 277 (WinCC flexible)
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9.2 Recognizing Pending Alarms

Introduction

You can recognize the presence of alarms which must be acknowledged by the following:

® For an HMI device with keys: The LED in the key lights up.

e Depending on the configuration: An alarm indicator is displayed on screen.

The configuration determines whether an alarm has to be acknowledged or not. This is also
defined by the alarm class which an alarm belongs to.

LED in the "ACK" key

Alarm indicator

On an HMI device with keys, an LED is integrated in the key. The LED is lit if there are

alarms requiring acknowledgment which must still be acknowledged.

The LED goes out when you acknowledge all alarms requiring acknowledgment.

The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring
acknowledgment, depending on the configuration.

/N

3

The alarm indicator flashes as long as alarms are pending for acknowledgment. The number
displayed indicates the number of pending alarms. The configuration engineer can assign
functions to be executed when the alarm indicator is operated.

Usually, the alarm indicator is only used for error alarms. Refer to your system
documentation to check whether additional information on this subject is available there.
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9.3 Displaying alarms

Displaying alarms
Alarms are displayed in the alarm view or in the alarm window on the HMI device.

Alarm view
Depending on the configuration, the alarm view is displayed as follows:
® As a single line. Alarm numbers and alarm texts are displayed as single lines
® As simple alarm view
® As extended alarm view

In the simple or extended alarm views the configuration engineer specifies the alarm
information to be displayed.

Depending on the configuration, alarms from alarm logs are also displayed in the alarm view.

Simple alarm view

19.04.2005 11:41:37 ! 1

Motor 23 too hot

L RE . |

ﬂ 410

The buttons have the following functions:

Buttons Functions

Displaying infotext for an alarm.

Process alarm.

Acknowledge alarm.

Select the next or previous alarm in the list.

Scroll one page up or down.

=l =

MP 277 (WinCC flexible)
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Extended alarm view

| |N0. JTime Date Status
[ 12:04:59 19.04.2005 K

Motor 23 too hot

S ¢ | ® |

The buttons have the following functions:

Buttons Functions

Displaying infotext for an alarm.

|
& | Process alarm.
_F |

Acknowledge alarm.

Changing the column sequence and sorting in the extended alarm view

Depending on the configuration, you can change the column sequence and sorting order on
HMI devices with touch operation.

e Change column sequence
— Touch the column header which you wish to exchange with a different column header

— Keeping the touch screen pressed, move the column heading to the column heading
you wish to exchange it with

® Change sorting order

To change the sorting order of the alarms, touch the respective column header on the
touch screen

Alarm class layout
The various alarm classes are identified in order to distinguish between them in the alarm

view.
Symbol Alarm class
! Error
Without a symbol Operation
Symbol depending on the configuration | User-defined alarm classes
S7 SIMATIC or SIMOTION diagnostic alarms
$ System

The configuration engineer can change the symbols for the alarm classes. Please refer to
your system documentation to check whether additional information on this subject is
available there.
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9.4 Display infotexts for an alarm

Alarm window

The alarm window is independent of the process screen. Depending on the configuration,
the alarm window opens automatically as soon as a new alarm is pending for
acknowledgment. The alarm window can be configured so that it only closes after all the
alarms have been acknowledged.

The layout and the operation of the alarm window are the same as for the alarm view.

Please refer to your system documentation to check whether additional information on this
subject is available there.

9.4 Display infotexts for an alarm

Displaying infotext
The configuration engineer can also provide infotext for alarms.

Procedure using the touch screen
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

2. Touch the j button in the simple alarm view or in the enhanced alarm view.

If configured, the infotext assigned to this alarm is displayed.

3. Close the screen for displaying the Infotext by means of the button.

Procedure using the keys
Proceed as follows:

1. Select the desired alarm in the alarm view.

HELP
2. Press .

If configured, the infotext assigned to this alarm is displayed.

3. Close the infotext by pressing key .

See also
Displaying alarms (Page 212)
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9.5 Acknowledge alarm

Requirements

The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Procedure using the touch screen
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

2. Touch the j button in the simple alarm view or il in the enhanced alarm view.

Procedure using the keys

The alarm view and the alarm window have a tab sequence with which you can select
operating elements and the last selected alarm using the keyboard.

1. Select the desired alarm view or alarm window with .

2. Select the desired alarm. Use the , , E or IZ‘ keys.
3. Press .

Alternative operation

Depending on the configuration, you can also acknowledge an alarm with a function key.

Result
The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the
associated group are acknowledged.
More information on acknowledgment and on available alarm groups may be found in your
plant documentation.

See also

Displaying alarms (Page 212)
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9.6 Edit alarm

Introduction

The configuration engineer can assign additional functions to each alarm. These functions
are executed when the alarm is processed.

Note
When you edit an unacknowledged alarm, it is acknowledged automatically.

Requirements
The alarm to be edited is displayed in the alarm window or the alarm view.

Procedure using the touch screen
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window. The alarm is selected.

2. Touch the ﬂ button in the simple alarm view or Ll in the enhanced alarm view.
Procedure using the keys

Proceed as follows:

1. Select the desired alarm view or alarm window with .
20|V
2. Select the desired alarm. Use the , , IZ' or E keys.

3. Continue to press the key until the button ﬂ is selected in the simple alarm view or

Ll in the extended alarm view.

4. Confirm your entry by pressing the key .

Result

The system executes the additional functions of the alarm. Further information on this may
be available in your plant documentation

See also
Displaying alarms (Page 212)

MP 277 (WinCC flexible)
216 Operating Instructions, 03/2009, ASE02479740-01



Operating recipes 1

10.1 Overview

Introduction

Recipes are used when different variants of a product are manufactured with the same
process. In this case, the product variants differ in terms of their type and quantity of the
components, but not in terms of the manufacturing process sequence. The configuration
engineer can store the combination of each individual product variant in a recipe.

Field of application

Recipes can be used everywhere the same product components are used in variable
combinations to create different product variants.

Examples:

® Beverage industry

® Food processing industry
® Pharmaceutical industry

® Paint industry

e Building materials industry

e Steel industry

MP 277 (WinCC flexible)
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10.2

Recipes

218

Structure of a recipe

The recipe collection for the production of a product family can be compared to a file cabinet.
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet.

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe,
for example, for the flavors orange, grape, apple and cherry.

®

®

©

®

</
v/
' /
<« /
[
@ File cabinet Recipe collection
@ Drawer Recipe
® Drawer Recipe
@ Drawer Recipe
® Drawer Recipe

@

Recipes for a fruit juice plant
Orange flavored drinks
Grape flavored drinks

Apple flavored drinks
Cherry flavored drinks
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10.2 Structure of a recipe

Recipe data records

The drawers of the file cabinet are filled with suspension folders. The suspension folders in
the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example.

ONONONO

—

Drawer Recipe Product variants of apple flavored drinks
Suspension folder  Recipe data record Apple drink

Suspension folder  Recipe data record Apple nectar

Suspension folder  Recipe data record Apple juice

® 00

Elements

In the figure showing the file cabinet, each suspension folder contains the same number of
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data
record. All the records of a recipe contain the same elements. The records differ, however, in
the value of the individual elements.

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The
records for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in
production.

MP 277 (WinCC flexible)
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10.3 Recipes in the project

Overview

220

If recipes are used in a project, the following components interact:

® Recipe view / recipe screen

On the HMI device, recipes are displayed and edited in the recipe view or in a recipe
screen.

— The recipe data records from the internal memory of the HMI device are displayed and
edited in the recipe view.

— The values of the recipe tags are displayed and edited in the recipe screen.

Depending on the configuration, the values displayed in the recipe view are synchronized
with the values of recipe tags.

HMI device recipe memory

Recipes are saved in the form of data records in the HMI device recipe memory.
The recipe data can also be saved in recipe tags.

Recipe tags

The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe
values are stored in recipe tags. Depending on the configuration, the values of the recipe
tags are exchanged with the PLC.

The recipe tags can be synchronized with the recipe data records so that the same
values are saved in both.

Memory card

The memory card is an external storage medium for recipe data records. The recipe data
records are exported from the HMI device recipe memory and are saved on the memory
card in a *.csv file. The records can be reimported from the memory card to the recipe
memory.

MP 277 (WinCC flexible)
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Data flow
The following figure shows the data flow in a project with recipes.
HMI device m
Recipe view @ w
Recipe 1
> >
/ = @
1 @
Reci < > Recipe tag A
ecipe
screen @ T \\
. ® d
® Editing, saving or deleting a recipe data record
@ Display recipe data record
® Synchronize or do not synchronize recipe tags
@ Display and edit recipe tags in the recipe screen
® Write records from the recipe view to the PLC or read records from the PLC and
display them in the recipe view
® Recipe tags are sent to the PLC online or offline
@ Export or import recipe data record to memory card
MP 277 (WinCC flexible)
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10.4 Displaying a recipe

Displaying recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view

A recipe view is a screen object used to manage recipe data records. The recipe view shows
recipe data records in tabular form.

Depending on the configuration, the recipe view is displayed as follows:
® As enhanced recipe view
® As simple recipe view

The configuration engineer also defines which operating elements are displayed in the recipe
view.

Enhanced recipe view
The following figure shows an example of the enhanced recipe view.

Fecipe Mame:

Mo,
( >7|Orange j |1 4@
0.

Data Record Mame:

@7|Nectar j|2 4@

Entry Marme Yalue o
@7 Water ‘ 40—4@
Concentrate | o~

SocmcCiE

Selection box for the recipe
Selection box for the recipe data record

Element name
The element name designates a specific element in the recipe data record

Display field

This show the number of the selected recipe or the selected recipe data record
Value of the element

Buttons for editing a recipe data record

Status bar for display of the status messages

Qe © 606
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Simple recipe view

Display of values

The simple recipe view consists of three areas:
® Recipe list

® Record list

e FElement list

In the simple recipe view, each area is shown separately on the HMI device. Depending on
the configuration, the simple recipe view starts with the recipe list or data record list.

The following figure shows an example of the record list.

1 Juice
2 Beverage -~
Nectar

3
O]
®
®

Number of the recipe data record
Recipe data records
Buttons for changing the displayed list and calling the menu

NOTICE
Changing the recipe data record in the background

Applies to the processing of a recipe data record:
If values of the corresponding recipe data record are changed by a PLC job, the recipe view
is not updated automatically.

To update the recipe view, reselect the respective recipe data record.

MP 277 (WinCC flexible)

Operating Instructions,

03/2009, A5E02479740-01 223



Operating recipes

10.4 Displaying a recipe

Recipe screen

224

A recipe screen allows the correlation between the plant and the recipe data to be displayed
in graphic form. The configuration engineer combines 1/O fields and screen objects to form a
custom input screen. The configuration engineer can distribute the I/O fields of a recipe over
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe
screen can be operated using buttons configured accordingly.

The following figure shows an example of the recipe screen.

N N
40 - Recipe name No.:
70 - | Orange T 1
30 - Data record hname No.:
30 -) | Nectar W 2 )

e N
Save | Data from the PLC |

Load | Data to PLC |

® AD
Element name and associated values

The element name designates a specific element in the recipe data record
Buttons for editing a recipe data record

Modified recipe view
Buttons for transferring recipe data

®e0 O

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe
values are exchanged with the PLC immediately or later via these tags.

A configured recipe view can itself be a component of a recipe screen You must synchronize
the tags in order to synchronize data between the tags of the recipe screen and the recipe
data records displayed in the recipe view. Synchronization of tags is only possible in the
enhanced recipe view.

Further information on this may be available in your plant documentation
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10.5 Recipe values in the HMI device and the PLC

Introduction

You can change the values of a recipe on the HMI device and therefore influence the
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in
different ways:

® |f you are editing recipes with a recipe view in your project, the values are saved in recipe
data records

® |f you are editing recipes in a recipe screen in your project, the values are saved in recipe
tags

Differences may occur between the display values in the recipe view and the values saved in
the associated tags in an ongoing project when you edit recipes with a recipe view and in a
recipe screen. To prevent this, the recipe data record values must be synchronized with the
values of the recipe tags.

You have however the option to perform synchronization operations at any time.
Synchronization only takes place if the configuration engineer has activated the respective
settings for a recipe.

Note
Recipe tags can only be synchronized in the extended recipe view.

Synchronizing recipe tags
Synchronization of the recipe tags depends on the configuration:
e Automatic synchronization:

The values of the recipe view are synchronized with the associated recipe tags. In this
case, changes to values in the recipe view have an immediate effect on the values of the
associated recipe tags. The values are only synchronized, when an operating element
that is outside the recipe view is operated.

® Synchronization by the user:

The values of the recipe view and the associated recipe tags are not synchronized

automatically. The configuration engineer has assigned the same function to the & |
button or a different operating element in the recipe view. The recipe tags and the recipe
view are only synchronized when you operate the buttons or the appropriate operating

element.
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10.6 Operating the recipe view

Recipe tags online / offline

The configuration engineer can configure a recipe so that changes to the values of the recipe
tags do not have an immediate effect on the current process.

Synchronization of the recipe values between the HMI device and the PLC depends on
whether the configuration engineer has selected the settings "Tags online" or the setting
"Tags offline" for a recipe.

"Tags online™:
This setting has the following effect:

— When you change recipe values in the recipe screen, these changes are applied
immediately by the PLC and immediately influence the process

— If recipe values are changed in the PLC, the changed values are displayed
immediately in the recipe screen

"Tags offline™:

With this setting, changed recipe values are not synchronized immediately between the
HMI device and the PLC

In this case, the configuration engineer must configure operating elements for transferring
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values
are only synchronized between HMI device and PLC when you operate the appropriate
operating element

10.6 Operating the recipe view

10.6.1 Overview

Operation

The recipe view can be operated as follows:

226

Enter values for the recipe elements

Create recipe data records

Save recipe data records or save them under a new name

Delete recipe data records

Synchronize values of the recipe view with the associated recipe tags

Transfer recipe data records from the PLC and to the PLC

MP 277 (WinCC flexible)
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10.6 Operating the recipe view

The following table shows the operating elements of the recipe view.

Buttons

Key combination

Functions

{1
ore]

Creates a new recipe data record.
If a start value is configured, it is shown in the text box.

(@)

TRL|

+
m
z
5
m
X

Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

===

9]
5
x
P

+
.

The recipe data record is saved under a different name
irrespective of the recipe view. A dialog box opens in which
the name is entered.

INS
DEL

@]
=
P
2
+

The displayed recipe data record is deleted.

& |lx

n
=
X
—
+

The values of the recipe view are synchronized with the
associated recipe tags. The values changed during editing are
written to the associated recipe tags. Subsequently all the
values of the tags are read out and updated in the table.

The recipe values from the PLC are displayed in the recipe
view.
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The values of the set recipe data record displayed in the
recipe view are transferred to the PLC.

Operating the recipe screen

You operate the recipes in a recipe screen with the operating elements provided by the
configuration engineer.

Further information on this may be available in your plant documentation

10.6.2 Creating a recipe data record

Introduction

You create a new recipe data record by modifying an existing record. You then save the
modified data record under a new name.

Requirements

A screen with a recipe view is displayed

MP 277 (WinCC flexible)
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10.6 Operating the recipe view

Procedure using the touch screen

Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

Touch ﬂ

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

Touch E

Enter a name for the data record.
The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

Procedure using the keys
Proceed as follows:

Result

228

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

{ }
CTRL .
Press + !

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

CTRL
Press + .

5. Enter a name for the data record.

Confirm your entry.
The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

The new recipe data record is saved to the selected recipe.

MP 277 (WinCC flexible)
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10.6 Operating the recipe view

See also
Recipes in the project (Page 220)

10.6.3 Editing a recipe data record

Introduction
Edit the values of the recipe data records and save them in a recipe view.

Synchronization with the PLC
If you want to display the current recipe values from the PLC in the recipe view, you first

have to read the current values from the PLC with ﬂ

The values changed in the recipe view only become effective when the amended data record

is transferred to the PLC by means of theﬂl button.

Requirements
A screen with a recipe view is displayed

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.

3. Change the data record as required.

4. Save your changes by means of the El button.

If you want to save the recipe data record under a different name, touch the El key.

5. The recipe data record is saved.

MP 277 (WinCC flexible)
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10.6 Operating the recipe view

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.

3. Change the data record as required.
4. Save your changes with + .

. . CTRL
If you want to save the recipe data record under a different name, press + .

The recipe data record is saved.

Result
The edited recipe data record has now been saved in the selected recipe.

See also
Recipes in the project (Page 220)

10.6.4 Deleting a recipe data record

Introduction
You can delete all the data records of a recipe which are not required.

Requirements
A screen with a recipe view is displayed

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

3. Touch ﬂ

MP 277 (WinCC flexible)
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10.6 Operating the recipe view

Procedure using the keys

Result

See also

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

3. Press + H

The recipe data record is deleted.

Recipes in the project (Page 220)

10.6.5 Synchronizing tags

Introduction

Requirements

The values of the recipe elements can be saved to recipe tags, depending on the
configuration.

Differences may occur between the display values in the recipe view and the actual values of
tags in an ongoing project. Synchronize the tags to equalize such differences.

Synchronization always includes all the variables which belong to a recipe data record.

NOTICE

Changed tag name

Tags and the value of the recipe data record cannot be assigned to each other if the tag
name of the tag to be synchronized has been changed. The tags in question are not
synchronized.

Note
Recipe tags can only be synchronized in the enhanced recipe view.

A screen with a recipe view is displayed

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01 231



Operating recipes

10.6 Operating the recipe view

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Touch él

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

CTRL]
3. Press + IE'

Result
The elements of the recipe data record are synchronized with the recipe tags.

If the values of the recipe view and the tag do not match, the more current value is accepted.

See also
Recipes in the project (Page 220)

10.6.6 Reading a recipe data record from the PLC

Introduction

In the current project, the values which are also stored in the recipes in the HMI device can

be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the recipe data records saved
in the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements
A screen with a recipe view is displayed

MP 277 (WinCC flexible)
232 Operating Instructions, 03/2009, ASE02479740-01



Operating recipes

10.6 Operating the recipe view

Procedure using the touch screen
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record to which you want to apply the values from the PLC.

Touch El

The values are read from the PLC.

If you want to store the displayed values in the HMI device, touch the E button.

Procedure using the keys
Proceed as follows:

1.

Result

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record to which you want to apply the values from the PLC.

CTRL|
Press + IZI

The values are read from the PLC.

If you want to store the displayed values in the HMI device, press the keys + .

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.

See also

Recipes in the project (Page 220)
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10.6 Operating the recipe view
10.6.7 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a recipe view is displayed

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Touch El

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

CTRL]
3. Press + E

Result

The display values in the recipe view were transferred to the PLC and take effect in the
process.

See also
Recipes in the project (Page 220)

MP 277 (WinCC flexible)
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10.7

10.7.1

Introduction

Operation

Overview

Operating the simple recipe view

10.7 Operating the simple recipe view

The simple recipe view consists of three areas:

® Recipe list
® Record list

® FElement list

You can use the context menu to operate each of these display areas.

The simple recipe view can be operated as follows:

® Enter values for the recipe elements

® (Create recipe data records

® Save recipe data records or save them under a new name

® Delete recipe data records

® Transfer recipe data records from the PLC and to the PLC

Operating elements of the simple recipe view
Toggle between the display areas and the context menus to operate the simple recipe views.

The table below shows the operation of the display area.

Touch operation

Key control

Functions

Touching an entry

ENTER|

The next lower display area opens.

=

ESC

The next higher display area opens.

-+

-

The context menu of the display area opens.

The table below shows the operation of the context menu.

Touch operation

Key control

Functions

=

ESC

The menu is closed.
The display area opens.

Touch the menu
command

Input of the number
of the menu
command

The menu command is executed.

MP 277 (WinCC flexible)
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10.7 Operating the simple recipe view

Context menus of the simple recipe view

A number is assigned to each menu command which you can use to call the menu
command with key control.

With touch operation, touch the menu command to execute it.

Some menu functions can also be called directly in the lists of the simple recipe view using
the keys.

® Recipe list

No. |Menucommand Key combination | Functions
0 New A new recipe data record is created for the selected
recipe.
If a start value is configured, it is shown in the text box.
1 Displaying infotext The infotext configured for the simple recipe view is
displayed.
2 Open The record list of the selected recipe opens.
® Record list
No. |Menu command Key combination | Functions
0 New A new recipe data record is created for the selected
recipe.
If a start value is configured, it is shown in the text box.
1 Delete The selected record is deleted.
DEL
2 Save as The selected record is saved under a different name
irrespective of the simple recipe view. A dialog box
opens in which the name is entered.
3 Rename The selected record is renamed. A dialog box opens in
which the name is entered.
® FElement list
No. |Menu command Key combination | Functions
0 Save The selected record is renamed.
1 To PLC The display values of the selected record are
transferred from the HMI device to the PLC.
2 From PLC The recipe values from the PLC are displayed on the
HMI device in the recipe view.
3 Save as The selected record is renamed. A dialog box opens in
which the name is entered.

Touch operation of the menu
Touch the desired menu command. The command is executed.

Key control of the menu

Select the required entry using Iz' or IZ' Press .

Alternatively, press the numerical key with the number of the desired menu command.

236

The command is executed.
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10.7 Operating the simple recipe view

Operating the recipe screen

You operate the recipes in a recipe screen with the operating elements provided by the
configuration engineer.

Further information on this may be available in your plant documentation

10.7.2 Creating a recipe data record

Introduction

Create a new recipe data record in the recipe list or in the record list. Then enter the values
for the new record in the element list and save the record.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:
1. If the recipe list contains several recipes: Select the recipe for which you want to create a
new recipe data record.
2. Open the recipe list menu.
3. Select the menu command "0 New".
Creates a new record
The element list of the new record opens.
4. Enter values for the elements of the data record.
The tags of the record can be assigned default values depending on the configuration.
5. Open the element list menu and select the menu command "0 Save".
6. Enter a name for the new record.
7. Confirm your entries.
If you change the new data record number to an existing data record number, the existing
data record is overwritten.
Result
The new recipe data record is saved to the selected recipe.
See also

Recipes in the project (Page 220)
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10.7 Operating the simple recipe view

10.7.3 Editing a recipe data record

Introduction

Edit the values of the recipe data records in a simple recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the simple recipe view, you
first have to read the current values from the PLC with the menu command "2 from PLC" in
the element list.

The values changed in the recipe view only take effect in the PLC when you transfer the
edited data record to the PLC with the menu command "1 to PLC".

Requirements

A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:

1.

2B

Result

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.

Select the recipe data record you want to change.
Open the element list.

Change the values of the records as required.

Save your changes with the menu command "0 Save".

The recipe data record is saved.

The edited recipe data record has now been saved in the selected recipe.

See also

Recipes in the project (Page 220)
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10.7 Operating the simple recipe view

10.7.4 Deleting a recipe data record

Introduction
You can delete all the data records which are not required.

Requirements
A screen with a simple recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.
Select the data record you want to delete.

Open the menu.

o DN

Select the menu command "1 Delete".

Procedure using the keys
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Open the data record list.

3. Select the data record you want to delete.

INS
4. Press .

Result
The data record is deleted.

See also
Recipes in the project (Page 220)
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10.7 Operating the simple recipe view

10.7.5 Reading a recipe data record from the PLC

Introduction
The values of recipe elements are exchanged with the PLC via tags.

In the current project, the values which are also stored in the recipes in the HMI device can
be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the tags on the HMI device
possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:
1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.
2. Select the element list of the recipe data record to which you want to apply the values
from the PLC.
3. Open the menu.
4. Select the menu command "2 from PLC".
The values are read from the PLC.
5. If you want to save the display values in the HMI device, select the menu command "0
Save".
Result
The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.
See also

Recipes in the project (Page 220)
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10.7 Operating the simple recipe view

10.7.6 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the element list of the recipe data record whose values you want to transfer to the
PLC.

3. Open the menu.

4. Select the menu command "1 To PLC".

Result

The values of the recipe data record were transferred to the PLC and take effect in the
process.

See also
Recipes in the project (Page 220)
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10.8 Exporting a recipe data record

10.8 Exporting a recipe data record

Introduction

You can export one or more recipe data records to a CSV file, depending on the
configuration. After export, the values in the recipe data record can be further processed in a
spreadsheet program such as MS Excel. The degree to which you can influence the export
depends on the configuration:

Requirements
® A screen with a recipe view is displayed
® An operating element with the function "Export record" has been configured.

® The following tags are configured equally in the recipe view and for the "Export record"
operating element.

— Recipe number

— Data record number

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.
2. Select the recipe data record you want to export.
3. Operate the operating element which was configured for export, for example the "Export
data record" button.
The data record is exported as a CSV file to an external data medium.
Further information on this may be available in your plant documentation
Result
The recipe data record is exported.
See also

Recipes in the project (Page 220)
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10.9 Importing a recipe data record

Introduction

You can import values from a CSV file to a recipe data record, depending on the
configuration.

Requirements

® An operating element with the function "Import data record" has been configured, for
example a button

® A screen with a recipe view is displayed

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the recipe
data record to be imported.
2. Operate the operating element with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in
the recipe view after import.
Result

The imported recipe data record is saved on the HMI device.

Deviating structure

If the structure of the CSYV file differs from the structure of the recipe, deviations are handled
as follows:

® Any additional values in the CSV file will be rejected

® The system applies the configured default value to the recipe data record if the CSV file
contains an insufficient number of values

e |f the CSV file contains values of the wrong data type, the configured default value is set
in the recipe data record

Example:
The imported CSV file contains values that were entered as floating point numbers

However, the corresponding tag expects an integer value. In this case, the system
discards the imported value and uses the configured default

See also
Recipes in the project (Page 220)
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10.10 Examples

10.10

10.10.1

Introduction

Procedure

244

Examples

Entering a recipe data record

You would like to enter production data on the HMI device without interrupting the process in
the machine or plant. For this reason, the production data should not be transferred to the

PLC.

Proceed as follows:

1. Call the recipe view or a recipe screen.

w0 DN

Save the recipe data record.

Select the desired recipe data record.

Enter the values of the elements.

The recipe data record is saved in the internal memory of the HMI device.

The following figure shows the data flow schematically.

@
@

HMI device
Recipe view
Oo0——O
/ Recipe tag
Recipe
screen @

Recipe 1
Recipe 2
Recipe 3

PLC

Display recipe data record
Save recipe data record
Tags are synchronized

CECNORONC)

Tags are offline

Display and edit recipe tags in the recipe screen
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10.10.2 Manual production sequence

Introduction

10.10 Examples

You request the production data of different workpieces from the PLC and display this data
on the screen of the HMI device for inspection. You want to correct the transferred

Procedure

production data in the recipe view or the recipe screen if necessary.

A scanner connected to the PLC reads the barcode of a workpiece. The barcode names
correspond to the names in the recipe data record. Based on the barcode name, the PLC
can read the required recipe data record. The recipe data record is displayed for inspection
on the HMI device. You can now edit and save the recipe data record. Then transfer the
edited recipe data record to the PLC again.

The following figure shows the data flow schematically.

MP 277 (WinCC flexible)

/

Recipe view

Recipe
screen

@

HMI device

@

o0——o0

®

Recipe tag

W

Recipe 1
Recipe 2
Recipe 3

®e 6 O

®

PLC

T

The recipe data record is read from the PLC and written to the PLC again following

changes

Display and edit recipe tags in the recipe screen

Tags are synchronized

Recipe data records are saved in the recipe memory of the HMI device
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10.10 Examples
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11.1 Maintenance and care

Scope of maintenance
The HMI device is designed for maintenance-free operation. The touch screen and keyboard
membrane should nevertheless be cleaned regularly.

Preparation

A\cauTion

Inadvertent operation

Always switch off the HMI device before cleaning it. This will ensure that you do not trigger
functions unintentionally when you touch the keys.

Requirements
Use a cleaning cloth dampened with a cleaning agent to clean the equipment. Only use
water with a little liquid soap or a screen cleaning foam.

CAUTION

Do not clean the HMI device with compressed air or steam jet blowers. Never use
aggressive solvents or scouring powder.

Procedure
Proceed as follows:

1. Switch off the HMI device.
2. Spray the cleaning solution onto a cleaning cloth.
Do not spray directly onto the HMI device.
3. Clean the HMI device.
When cleaning the display wipe from the screen edge inwards.

MP 277 (WinCC flexible)
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11.2 Clean screen on MP 277 Touch

11.2 Clean screen on MP 277 Touch

Clean screen

The HMI touch screen can be cleaned when it is switched on and a project is running. An
operating element must be available in the project with which the clean screen can be called.
Once the clean screen is activated, touch screen operation is locked for a configured period
of time. The time the touch screen is locked can be set between 5 and 30 seconds. The time
remaining for the lockout is indicated by a progress bar.

A WARNING

Locking operating elements

Always open the clean screen or switch off the HMI device before you clean the touch
screen while the system is running!

It is important to note when the clean screen function is unlocked. Ignoring this instruction
may lead to inadvertent operation of a function.

11.3 Spare Parts and Repairs

Repairs

Spare parts

248

In case of repair, the HMI device must be shipped to the Return Center in Fiirth. Repairs
may only be carried out at the Return Center in Firth.

Depending on the work necessary to repair the device, the Center may decide to give you a
credit note. In this case, it is your responsibility to order a new device.

The address is:

Returns Center
Siemensstr. 2
90766 Furth
Germany

You can find spare parts and accessories for the HMI devices in the section Accessories
(Page 23).
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12.1 Dimension drawings

1211 Dimension drawings of the MP 277 8" Touch

The HMI device MP 277 8" Touch is available in two enclosure models with different product
versions. The product version is indicated on the back of the HMI device.

Dimensional drawing of MP 277 8" Touch up to and including product version 05
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12.1 Dimension drawings

Dimensional drawing of MP 277 8" Touch as of product version 15
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12.1 Dimension drawings

12.1.2 Dimension drawings of the MP 277 8" Key
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12.1 Dimension drawings

12.1.3 Dimension Drawings of the MP 277 10" Touch

The HMI device MP 277 10" Touch is available in two enclosure models with different
product versions. The product version is indicated on the back of the HMI device.

Dimension drawing of MP 277 10" Touch up to and including product version 06
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Dimensional drawing of MP 277 10" Touch as of product version 15
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12.1 Dimension drawings

12.1.4 Dimension drawings of the MP 277 10" Key
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12.2 Specifications
12.2 Specifications
12.2.1 Specifications of the MP 277 Touch
HMI device
MP 277 8" Touch MP 277 10" Touch
Weight without packaging Approx. 1610 g Approx. 2 650 g
Display
MP 277 8" Touch MP 277 10" Touch
Display area, active 153.7 mm x 115.8 mm (7.5") 211.2 mm x 158.4 mm (10.4")
Type LCD TFT
Resolution 640 x 480 pixels
Colors, displayable 64k
Brightness control Yes
Backlighting CCFL
Half brightness life time, 50 000 h
typical
Input device
MP 277 8" Touch MP 277 10" Touch
Type Touch screen, analog, resistive
Memory
MP 277 8" Touch MP 277 10" Touch
Application memory 6 MB
Ports
MP 277 8" Touch MP 277 10" Touch
1 x RS 422/RS 485 Max. 12 Mbps
2 x USB USB host; conforms to USB standard 1.1

(supporting low-speed and full-speed USB devices)
Maximum load 500 mA
1 x Ethernet RJ45 10/100 Mbps

MP 277 (WinCC flexible)
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12.2 Specifications

Supply voltage

MP 277 8" Touch

| MP 277 10" Touch

Rated voltage
Range, permissible

+24V DC

20.4 V10 28.8V (-15%, +20%)

Transients, maximum
permissible

35V (500 ms)

Time between two transients,
minimum

50s

Current consumption
e Typical

e Constant current,
maximum

e Power on current surge 2t

e Approx. 600 mA
e Approx. 1 000 mA
e Approx. 1 A%s

e Approx. 700 mA
e Approx. 1 100 mA
e Approx. 1 A2s

Fuse, internal

Electronic

Miscellaneous

MP 277 8" Touch

MP 277 10" Touch

Realtime clock, buffered "

Yes

Magnetic field intensity

50/60 Hz;100 A/m RMS

1)

Bridging time of the buffering, approx. 6 weeks.

12.2.2 Specifications of the MP 277 Key
HMI device
MP 277 8" Key MP 277 10" Key
Weight without packaging Approx. 2250 g Approx. 4 950 g
Display
MP 277 8" Key MP 277 10" Key
Display area, active 153.7 mm x 115.8 mm (7.5") 211.2 mm x 158.4 mm (10.4")
Type LCD TFT
Resolution 640 x 480 pixels
Colors, displayable 64k
Brightness control Yes
Backlighting CCFL
Half brightness life time, typical 50 000 h
MP 277 (WinCC flexible)
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12.2 Specifications
Input device
MP 277 8" Key MP 277 10" Key
Type Membrane keyboard
Function keys 26 function keys, 34 function keys,
of which 18 with LED of which 26 with LED
Memory
MP 277 8" Key MP 277 10" Key
Application memory 6 MB
Ports
MP 277 8" Key MP 277 10" Key
1 x RS 422/RS 485 Max. 12 Mbps
2 x USB USB host; conforms to USB standard 1.1
(supporting low-speed and full-speed USB devices)
Maximum load 500 mA
1 x Ethernet RJ45 10/100 Mbps
Supply voltage

MP 277 8" Key

| MP 277 10" Key

Rated voltage
Range, permissible

20,4V 10 28.8V (-15 %, +20%)

+24 V DC

Transients, maximum permissible

35V (500 ms)

Time between two transients,
minimum

50s

Current consumption

o Typical

e Constant current, maximum
e Power on current surge 12t

e Approx. 700 mA
e Approx. 1100 mA
e Approx. 1A?%s

e Approx. 800 mA
e Approx. 1200 mA
e Approx. 1 A?%s

Fuse, internal

Electronic

Miscellaneous

MP 277 8" Key

MP 277 10" Key

Realtime clock, buffered "

Yes

Magnetic field intensity

50/60 Hz;100 A/m RMS

N Bridging time of the buffering, approx. 6 weeks.

MP 277 (WinCC flexible)
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12.3 Bit assignment of the direct keys

12.3 Bit assignment of the direct keys

The following figures show the assignment of the keys and LEDs to the bytes in the PLC
process image.

Further information may be available in your plant documentation.

Note

Do not use the LED bits "ACK", "A-Z I", "A-Z r" and "HELP" when a project is running on the
HMI device.

Bit assignment of the direct keys for the MP 277 8" Key

| Button bits | LED bits
7 6 5 4 3 2 1 0 Byte 7 6 5 4 3 2 1 0
F8 |F7 |Fe |F5 |F4 |[F3 [F2 |F1 n Fs |F7 |6 |F5 |F4 |F3 [F2 |F1
F16 |F15 [F14 |F13 |F12 [F11 |F10 |Fo n+1 F10 |F9
K4 |K3 |K2 |Ki F18 [F17 | | n+2| |ka |k3 |k2 [Ki
ks |k7 |ke [Ks5 n+3 ks |k7 |ke [Ks5
ACK | ALT |CTRL [SHIFT] n+4 ACK |A-ZI| |A-Zr |HELP

Bit assignment of the direct keys for the MP 277 10" Key

| Button bits | | LED bits
7 6 5 4 3 2 1 0 Byte 7 6 5 4 3 2 1 0
F8 |F7 |F6 |F5 |F4 |F3 |F2 |F1 n F8 |F7 |F6 |F5 |F4 |F3 |F2 |F1
F16 |F15 |F14 |F13 |F12 |F11 |[F10 |Fo n+1 F12 |F11 |[F10 |Fo
Ka |[K3 |K2 |K1 |F20 |F19 [F18 [F17 | | n+2| [k |K3 [K2 [K1
K12 [k11 [k10 [k [k [k7 |ke [ks n+3| [k12 [k11 |k10 ke [k [k7 |ke [ks
Ack |ALT |cTRL[sHiFT{ K16 [ K15 | K14 [K13 | | n+4 | [Ack [az1 [azr |HELP K16 [K15 [K14 |K13

MP 277 (WinCC flexible)
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Bit assignment of the direct keys for the MP 277 8" Touch

Touch assignment

7 6 5 4 3 2 1 0 Byte
7 6 5 4 3 2 1 n

15 | 14 | 13 12 1 10 9 n+1
23 | 22 | 21 20 [ 19 | 18 | 17 | 16 n+2
31 30 | 29 28 | 27 | 26 | 25 | 24 n+3
39 | 38 | 37 36 [ 35 | 34 | 33 | 32 n+4

Bit assignment of the direct keys for the MP 277 10" Touch

Touch assignment

7 6 5 4 3 2 1 0 Byte
7 6 5 4 3 2 1 n

15 | 14 | 13 12 11 10 9 n+1
23 | 22 | 21 20 [ 19 | 18 | 17 | 16 n+2
31 30 | 29 28 | 27 | 26 | 25 | 24 n+3
39 | 38 | 37 36 [ 35 | 34 | 33 | 32 n+4

See also

Direct keys (Page 164)

MP 277 (WinCC flexible)
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12.4

12.4.1

12.4.2

260

Description of the ports

Power supply

Plug connector, 2-pin

1 2
Pin Assignment
1 +24 VDC (L+)
2 GND 24 V (M)

X10/IF 1B (RS 422/RS 485)

Sub-D socket, 9-pin, with screw lock

Pin Assignment for the RS 422

Assignment for the RS 485

1 n. c. n. c.

2 GND 24V GND 24V

3 TxD+ Data channel B (+)

4 RD+ RTS"

5 GND 5V, floating GND 5V, floating

6 +5 VDC, floating +5 VDC, floating

7 +24 VDC, out (max. 100 mA) +24 VDC, out (max. 100 mA)
8 TxD- Data channel A (-)

9 RxD- RTS"

1 On pin 4 or pin 9, can be set with DIP switch on the rear of the device

MP 277 (WinCC flexible)
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1243  X20, X21 (USB)

USB socket
1 4
|
Pin Assignment
1 +5 VDC, out (max. 500 mA)
2 USB-DN
3 USB-DP
4 GND

1244 X1 (Ethernet/LAN)
RJ45 plug connector

[

nannnnn
1 8

Pin Assignment

Tx+
Tx—

Rx+

n. c.

n. c.
Rx—

n.c.

O IN|oO|a|R|WIN]|~

n. c.

MP 277 (WinCC flexible)
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Appendix l \

A1 ESD guideline

What does ESD mean?

‘ All electronic modules are equipped with large-scale integrated ICs or components. Due to
their design, these electronic components are highly sensitive to overvoltage and thus to the
‘L-‘ discharge of static electricity. Such electronic components are labeled as Electrostatic

Sensitive Device.

Short description
The following abbreviations are commonly used for electrostatic sensitive devices:
o EGB - Elektrostatisch Gefahrdete Bauteile/Baugruppen (Germany)

® ESD - Electrostatic Sensitive Device (internationally recognized term)

Electrostatic charge

CAUTION

Electrostatic charge

ESDs may be destroyed by voltages far below the level perceived by human beings.
Voltages of this kind develop when a component or an assembly is touched by a person
who is not grounded against static electricity. Usually, it is unlikely that damage to an ESD
as a result of overvoltage is detected immediately but may become apparent only after a
longer period of operation.

Avoid electrostatic charge to your body before you touch the ESD.

MP 277 (WinCC flexible)
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A.1 ESD guideline

Anyone who is not connected to the electrical potential of their surroundings is subject to
electrostatic charge.

The following figure indicates the maximum electrostatic charge anyone is subjected to when
coming into contact with the materials shown. These values correspond to IEC 801-2
specifications.

(k]

Voltage

16
15
14
13
12

SNWhOON®O©

;
510 20 30 40 50 60 70 80 90 100 [%]
Relative humidity

@ Synthetic materials
® Wool
® Antistatic materials such as wood or concrete

Protective measures against discharge of static electricity

CAUTION

Grounding measures

No equipotential bonding is possible without ground. Electrostatic charges will not be
discharged and may damage the ESD.

When working with electrostatic sensitive devices, make sure that the person, the
workplace and the packaging are properly grounded.

As a rule, only touch the ESD if this is unavoidable. This may be the case for maintenance.
When you touch ESD modules, avoid touching the pins or the PCB tracks. This measure
prevents discharged energy from reaching and damaging components sensitive to voltage.

Discharge electrostatic electricity from your body if you are performing measurements on an
ESD. Do so by touching grounded metallic parts.

Always use grounded measuring instruments.

MP 277 (WinCC flexible)
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A2

System alarms

Introduction

A.2 System alarms

System alarms on the HMI device provide information about internal states of the HMI device

and PLC.

The following overview shows the causes of system alarms and how to eliminate the cause

of error.

Depending on scope of functions, only some of the system alarms described in this section

apply to the various HMI devices.

Note

System alarms are only indicated if an alarm window was configured. System alarms are
output in the language currently set on your HMI device.

System alarm parameters

System alarms may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the runtime software. These
parameters are output after the text "Error code:"

Meaning of the system alarms

Number | Effect/cause Remedy

10000 | The print job could not be started or was canceled due | Check the printer settings, cable connections and the
to an unknown error. Faulty printer setup. Or: No power supply.
authorization is available for accessing the network Set up the printer once again. Obtain a network printer
printer. authorization.

Power supply failure during data transfer. If the error persists, contact the Hotline!

10001 | No printer is installed or a default printer has not been | Install a printer and/or select it as the default printer.
set up.

10002 | Overflow of the graphics buffer for printing. Up to two | Allow sufficient intervals between successive print
images are buffered. jobs.

10003 | Images can now be buffered again. —

10004 | Overflow of the buffer for printing lines in text mode Allow sufficient intervals between successive print
(e.g. alarms). Up to 1000 lines are buffered. jobs.

10005 | Text lines can now be buffered again. —

10006 | The Windows printing system reports an error. Refer | Repeat the action if necessary.
to the output text and the error ID to determine the
possible causes. Nothing is printed or the print is
faulty.

20010 | An error has occurred in the specified script line. Select the specified script line in the configuration.
Execution of the script was therefore aborted. Note the | Ensure that the tags used are of the allowed types.
system alarm that may have occurred prior to this. Check system functions for the correct number and

types of parameters.

MP 277 (WinCC flexible)
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A.2 System alarms

Number | Effect/cause Remedy

20011 | An error has occurred in a script that was called by the | In the configuration, select the script that has been
specified script. called directly or indirectly by the specified script.
Execution of the script was therefore aborted in the Ensure that the tags used are of the allowed types.
called script. Check system functions for the correct number and
Note the system alarm that may have occurred prior to | types of parameters.
this.

20012 | The configuration data is inconsistent. The script could | Recompile the configuration.
therefore not be generated.

20013 | The scripting component of WinCC flexible Runtime is | Reinstall WinCC flexible Runtime.
not correctly installed. Therefore, no scripts can be
executed.

20014 | The system function returns a value that is not written | Select the specified script in the configuration.
in any return tag. Check whether the script name has been assigned a

value.

20015 | Too many successive scripts have been triggered in Find what is triggering the scripts. Extend the times,
short intervals. When more than 20 scripts are queued | e.g. the polling time of the tags which trigger the
for processing, any subsequent scripts are rejected. In | scripts.
this case, the script indicated in the alarm is not
executed.

30010 | The tag could not accept the function result, e.g. when | Check the tag type of the system function parameter.
it has exceeded the value range.

30011 | A system function could not be executed because the | Check the parameter value and tag type of the invalid
function was assigned an invalid value or type in the parameter. If a tag is used as a parameter, check its
parameter. value.

40010 | The system function could not be executed since the | Check the parameter types in the configuration.
parameters could not be converted to a common tag
type.

40011 | The system function could not be executed since the | Check the parameter types in the configuration.
parameters could not be converted to a common tag
type.

50000 | The HMI device is receiving data faster than it is —
capable of processing. Therefore, no further data is
accepted until all current data have been processed.

Data exchange then resumes.

50001 | Data exchange has been resumed. —

60000 | This alarm is generated by the “DisplaySystemAlarms” | —
function. The text to be displayed is transferred to the
function as a parameter.

60010 | The file could not be copied in the direction defined Restart the system function or check the paths of the
because one of the two files is currently open or the source/target files. Using Windows NT/2000/XP: The
source/target path is not available. user executing WinCC flexible Runtime must be
It is possible that the Windows user has no access granted access rights for the files.
rights to one of the two files.

60011 | An attempt was made to copy a file to itself. Check the path of the source/target file.

It is possible that the Windows user has no access Using Windows NT/2000/XP with NTFS: The user
rights to one of the two files. executing WinCC flexible Runtime must be granted
access rights for the files.

70010 | The application could not be started because it could | Check whether the application exists in the specified
not be found in the path specified or there is path or close other applications.
insufficient memory space.

MP 277 (WinCC flexible)
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A.2 System alarms

Number

Effect/cause

Remedy

70011

The system time could not be modified.
The error alarm only appears in connection with area
pointer "Date/time PLC". Possible causes:

e Aninvalid time was transferred in the job mailbox.

e The Windows user has no right to modify the
system time.

If the first parameter in the system alarm is displayed

with the value 13, the second parameter indicates the

byte containing the incorrect value.

Check the time which is to be set.

Using Windows NT/2000/XP: The user executing
WinCC flexible Runtime must be granted the right to
change the system time of the operating system.

70012

An error occurred when executing the function
"StopRuntime" with the option "Runtime and operating
system".

Windows and WinCC flexible Runtime are not closed.
One possible cause is that other programs cannot be
closed.

Close all programs currently running.
Then close Windows.

70013

The system time could not be modified because an
invalid value was entered. Incorrect separators may
have been used.

Check the time which is to be set.

70014

The system time could not be modified. Possible
causes:

e An invalid time was transferred.

e The Windows user has no right to modify the
system time.

o Windows rejects the setting request.

Check the time which is to be set.

Using Windows NT/2000/XP: The user executing
WinCC flexible Runtime must be granted the right to
change the system time of the operating system.

70015

The system time could not be read because Windows
rejects the reading function.

70016

An attempt was made to select a screen by means of
a system function or job. This is not possible because
the screen number specified does not exist.

Or: A screen could not be generated due to insufficient
system memory.

Check the screen number in the function or job with
the screen numbers configured.
Assign the number to a screen if necessary.

70017

Date/time is not read from the area pointer because
the address set in the PLC is either not available or
has not been set up.

Change the address or set up the address in the PLC.

70018

Acknowledgment that the password list has been
successfully imported.

70019

Acknowledgment that the password list has been
successfully exported.

70020

Acknowledgment for activation of alarm reporting.

70021

Acknowledgment for deactivation of alarm reporting.

70022

Acknowledgment to starting the Import Password List
action.

70023

Acknowledgment to starting the Export Password List
action.

70024

The value range of the tag has been exceeded in the
system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

MP 277 (WinCC flexible)
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Number | Effect/cause Remedy

70025 | The value range of the tag has been exceeded in the | Check the desired calculation and correct it if
system function. necessary.
The calculation of the system function is not
performed.

70026 | No other screens are stored in the internal screen —
memory.

No other screens can be selected.

70027 | The backup of the RAM file system has been started. | —

70028 | The files from the RAM have been copied in the Flash | —
memory.

The files from the RAM have been copied in the Flash
memory. Following a restart, these saved files are
copied back to the RAM file system.

70029 | Backup of the RAM file system has failed. Check the settings in the "Control Panel > OP" dialog
No backup copy of the RAM file system has been and save the RAM file system using the "Save Files"
made. button in the "Persistent Storage" tab.

70030 | The parameters configured for the system function are | Compare the parameters configured for the system
faulty. function with the parameters configured for the PLCs
The connection to the new PLC was not established. | and correct them as necessary.

70031 | The PLC configured in the system function is not an Compare the S7 PLC name parameter configured for
S7 PLC. the system function with the parameters configured for
The connection to the new PLC was not established. |the PLC and correct them as necessary.

70032 | The object configured with this number in the tab order | Check the number of the tab order and correct it if
is not available in the selected screen. necessary.

The screen changes but the focus is set to the first
object.

70033 | An e-mail cannot be sent because a TCP/IP Check the network connection to the SMTP server and
connection to the SMTP server no longer exists. re-establish it if necessary.
This system alarm is generated only at the first
attempt. All subsequent unsuccessful attempts to send
an e-mail will no longer generate a system alarm. The
event is regenerated when an e-mail has been
successfully sent in the meantime.

The central e-mail component in WinCC flexible
Runtime attempts, in regular intervals (1 minute), to
establish the connection to the SMTP server and to
send the remaining e-mails.

70034 | Following a disruption, the TCP/IP connection to the —
SMTP server could be re-established.

The queued e-mails are then sent.

70036 | No SMTP server for sending e-mails is configured. An | Configure an SMTP server:
attempt to connect to an SMTP server has failed and it | |, \WinCC flexible Engineering System
is not possible to send e-mails. using "Device settings > Device settings"

WinCC flexible Runtime generates the system alarm In the Wind CE " ¢
after the first attempt to send an e-mail. nl e" Incoys operating system .
using "Control Panel > Internet Settings > E-mail >
SMTP Server"
70037 | An e-mail cannot be sent for unknown reasons. Check the e-mail parameters (recipient etc.).
The contents of the e-mail are lost.
MP 277 (WinCC flexible)
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Number | Effect/cause Remedy

70038 | The SMTP server has rejected sending or forwarding | Check the domain of the recipient address or
an e-mail because the domain of the recipient is deactivate the authentication on the SMTP server if
unknown to the server or because the SMTP server possible. SMTP authentication is currently not used in
requires authentication. WinCC flexible Runtime.

The contents of the e-mail are lost.

70039 | The syntax of the e-mail address is incorrect or Check the e-mail address of the recipient.
contains illegal characters.

The contents of the e-mail are discarded.

70040 | The syntax of the e-mail address is incorrect or —
contains illegal characters.

70041 | The import of the user management was aborted due | Check your user management or transfer it again to
to an error. the panel.

Nothing was imported.

80001 | The log specified is filled to the size defined Store the file or table by executing a ‘move’ or ‘copy’
(in percent) and must be stored elsewhere. function.

80002 | Aline is missing in the specified log. —

80003 | The copying process for logging was not successful. —

In this case, it is advisable to check any subsequent
system alarms, too.

80006 | Since logging is not possible, this causes a permanent | In the case of databases, check whether the
loss of the functionality. corresponding data source exists and start up the

system again.

80009 | A copying action has been completed successfully. —

80010 | Since the storage location was incorrectly entered in Configure the storage location for the respective log
WinCC flexible, this causes a permanent loss of the again and restart the system when the full functionality
functionality. is required.

80012 | Log entries are stored in a buffer. If the values are Archive fewer values.
read to the buffer faster than they can be physically Or:
written (using a hard disk, for example), overloading Increase the logging cycle.
may occur and recording is then stopped.

80013 | The overload status no longer applies. Archiving —
resumes the recording of all values.

80014 | The same action was triggered twice in quick —
succession. Since the process is already in operation,
the action is only carried out once.

80015 | This system alarm is used to report DOS or database |—
errors to the user.

80016 | The logs are separated by the system function Reconnect the logs.

"CloseAllLogs" and the incoming entries exceed the
defined buffer size.
All entries in the buffer are deleted.
80017 | The number of incoming events cause a buffer Stop the copy action.

overflow. his can be caused, for example, by several
copying actions being activated at the same time.
All copy jobs are deleted.

MP 277 (WinCC flexible)
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Number | Effect/cause Remedy

80019 | The connection between WinCC flexible and all logs —
were closed, for example, after executing the system
function "CloseAllLogs".

Entries are written to the buffer and are then written to
the logs when a connection is re-established.

There is no connection to the storage location and the
storage medium may be replaced, for example.

80020 | The maximum number of simultaneously copy Wait until the current copying actions have been
operations has been exceeded. Copying is not completed, then restart the last copy action.
executed.

80021 | An attempt was made to delete a log which is still busy | Wait until the current copying actions have been
with a copy action. Deletion has not been executed. completed, then restart the last action

80022 | An attempt was made to start a sequence log, which is | In the project, check
not a sequence log, from a log using the system o if the "StartSequencelog" system function was
function "StartSequencelLog". No sequence log file is properly configured
created. o if the tag parameters are properly provided with

data on the HMI device

80023 | An attempt was made to copy a log to itself. In the project, check
The log is not copied. o if the "CopyLog" system function was properly

configured
¢ if the tag parameters are properly provided with
data on the HMI device

80024 | The "CopyLog" system function does not allow Edit the "CopyLog" system function in the project if
copying when the target log already contains data necessary. Before you initiate the system function,
("Mode" parameter). The log is not copied. delete the destination log file.

80025 | You have canceled the copy operation. —

Data written up to this point are retained. The
destination log file (if configured) is not deleted.
The cancellation is reported by an error entry
$RT_ERRS at the end of the destination log.

80026 | This alarm is output after all logs are initialized. Values | —
are written to the logs from then on. Prior to this, no
entries are written to the logs, irrespective whether
WinCC flexible Runtime is active or not.

80027 | The internal Flash memory has been specified as the | Configure "Storage Card" or a network path as the
storage location for a log. This is not permissible. storage location.

No values are written to this log and the log file is not
created.

80028 | The alarm returns a status report indicating that the —
logs are currently being initialized. No values are
logged until the alarm 80026 is output.

80029 | The number of logs specified in the alarm could not be | Evaluate the additional system alarms , related to this
initialized. The logs are initialized. alarm which is also generated.

The faulty log files are not available for logging jobs. | Check the configuration, the ODBC (Open Database
Connectivity) and the specified drive.
80030 | The structure of the existing log file does not match Delete the existing log data manually, in advance.
the expected structure.
Logging is stopped for this log.
80031 | The log in CSV format is corrupted. Delete the faulty file.
The log cannot be used.
MP 277 (WinCC flexible)
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Number | Effect/cause Remedy

80032 | Logs can be assigned events. These are triggered as | Close WinCC flexible Runtime, delete the log, then
soon as the log is full. If WinCC flexible Runtime is restart WinCC flexible Runtime.
started and the log is already full, the event is not Or:
triggered. Configure a button which contains the same actions as
The log specified no longer logs data because it is full. | the event and press it.

80033 | "System Defined" is set in the data log file as the data | Install MSDE again.
source name. This causes an error. No data is written
to the database logs, whereas the logging to the CSV
logs works.

80034 | An error has occurred in the initialization of the logs. No action is necessary. However, it is recommended
An attempt has been made to create the tables as a to save the backup files or delete them in order to
backup. This action was successful. A backup has make the space available again.
been made of the tables of the corrupted log file and
the cleared log was restarted.

80035 | An error has occurred in the initialization of the logs. It is recommended to save the backups or to delete
An attempt has been made to create backups of the them in order to release memory.
tables and this has failed. No logging or backup has
been performed.

80044 | The export of a log was interrupted because Runtime | The export resumes automatically.
was closed or due to a power failure. When Runtime
restarted, it was detected that the export needed to be
resumed.

80045 | The export of a log was interrupted due to an error in | The export is repeated automatically. Check:
the connection to the server or at the server itself. e The connection to the server

e If the server is running
o If there is enough free space on the server

80046 | The destination file could not be written while Check whether there is enough space on the server
exporting the log. and it you have permission to create the log file.

80047 | The log could not be read while exporting it. Check whether the storage medium is correctly

inserted.

80048 |— —

80049 | The log could not be renamed while preparing to Check whether the storage medium is correctly
export it. inserted and if there is sufficient space on the medium.
The job can not be completed.”

80050 | The log which shall be exported is not closed. Make sure the "CloseAll Logs" system function is
The job can not be completed. called before using the "ExportLog" system function.

Change the configuration as required.

90024 | No operator actions can be logged due to lack of Make more space available by inserting an empty
space on the storage medium for log. The operator storage medium or swapping out the log files on the
action will therefore not be executed. server using "ExportLog".

90025 | No user actions can be logged because of error state | Check whether the storage medium is correctly
of the archive. Therefore the user action will not be inserted.
executed.

90026 | No operator actions can be logged because the log is | Before further operator actions are carried out, the log
closed. The operator action will therefore not be must be opened again using the system function
executed. "OpenAliLogs". Change the configuration as required.

90029 | Runtime was closed during ongoing operation Ensure that you are using the correct storage medium.

(perhaps due to a power failure) or a storage medium
in use is incompatible with Audit Trail. An Audit Trail is
not suitable if it belongs to another project or has
already been archived.
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90030 | Runtime was closed during ongoing operation —
(perhaps due to a power failure).

90031 | Runtime was closed during ongoing operation —
(perhaps due to a power failure).

90032 | Running out of space on the storage medium for log. | Make more space available by inserting an empty
storage medium or swapping out the log files on the
server using "ExportLog".

90033 | No more space on the storage medium for log. As of | Make more space available by inserting an empty
now, no more operator actions requiring logging will storage medium or swapping out the log files on the
be executed. server using "ExportLog".

90040 | Audit Trail is switched off because of a forced user Activate the "Audit Trail" again using the system
action. function "StartLog".

90041 | A user action which has to be logged has been A user action requiring logging should only be possible
executed without a logged on user. with permission. Change the configuration by setting a

required authorization for the input object.

90044 | A user action which has to be confirmed was blocked, | Repeat the user action if necessary.
because there is another user action pending.

110000 | The operating mode was changed. "Offline" mode is —
now set.

110001 | The operating mode was changed. "Online" mode is —
now set.

110002 | The operating mode was not changed. Check the connection to the PLCs.

Check whether the address area for the area pointer
88 “Coordination" in the PLC is available.

110003 | The operating mode of the specified PLC was —
changed by the system function
"SetConnectionMode".

The operating mode is now "offline".

110004 | The operating mode of the specified PLC has been —
changed by the system function
"SetConnectionMode".

The operating mode is now "online".

110005 | An attempt was made to use the system function Switch the complete system to "online" mode, then
SetConnectionMode to switch the specified PLC to execute the system function again.

"online" mode, although the entire system is in "offline"
mode. This changeover is not allowed. The PLC
remains in "offline" mode.

110006 | The content of the "project version" area pointer does | Check:
not match the user version configured in WinCC e The project version entered on the PLC
flexible. WinCC flexible Runtime is therefore closed. « The project version entered in WinCC flexible

120000 | The trend is not displayed because you configured an | Change the configuration.
incorrect axis to the trend or an incorrect trend.

120001 | The trend is not displayed because you configured an | Change the configuration.
incorrect axis to the trend or an incorrect trend.

120002 | The trend is not displayed because the tag assigned Check whether the data area for the tag exists in the
attempts to access an invalid PLC address. PLC, the configured address is correct and the value

range for the tag is correct.

130000 | The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.

130001 | The action was not executed. Delete files no longer required from the hard disk.

MP 277 (WinCC flexible)
272 Operating Instructions, 03/2009, ASE02479740-01



Appendix

A.2 System alarms

Number | Effect/cause Remedy

130002 | The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.

130003 | No data medium found. The operation is canceled. Check, for example, if
e The correct data medium is being accessed
e The data medium is inserted

130004 | The data medium is write-protected. The operation is | Check whether access has been made to the correct

canceled. data carrier. Remove the write protection.

130005 | The file is read only. The operation is canceled. Check whether access has been made to the correct
file. Edit the file attributes if necessary.

130006 | Access to file failed. The operation is canceled. Check, for example, if
e The correct file is being accessed
e The file exists
¢ Another action is preventing simultaneous access

to the file

130007 | The network connection is interrupted. Check the network connection and eliminate the cause

Records cannot be saved or read over the network of error.
connection.
130008 | The storage card is not available. Insert the storage card.
Records cannot be saved to / read from the storage
card.

130009 | The specified folder does not exist on the storage Insert the storage card.

card.
Any files saved to this directory are not backed up
when you switch off the HMI device.

130010 | The maximum nesting depth can be exhausted when, | Check the configuration.

for example, a value change in a script results in the
call of another script and the second script in turn has
a value change that results in the call of yet a further
script etc.

The configured functionality is not supported.

140000 | An online connection to the PLC is established. —

140001 | The online connection to the PLC was shut down. —

140003 | No tag updating or writing is executed. Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.
140004 | No tag update or write operations are executed Verify the connection and check whether the PLC is
because the access point or the module configuration | switched on.
is faulty. Check the access point or the module configuration
(MPI, PPI, PROFIBUS) in the Control Panel with "Set
PG/PC interface".
Restart the system.
140005 | No tag updating or writing is executed because the Use a different HMI device address.

HMI device address is incorrect (possibly too high).

Verify the connection and check whether the PLC is
switched on.

Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.
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140006 | No tag updating or writing is executed because the
baud rate is incorrect.

Select a different baud rate in WinCC flexible
(according to module, profile, communication peer,
etc.).

140007 | Tag are not updated or written because the bus profile
is incorrect (see %1).

The following parameter could not be written to the
registry::

: Tslot

Tqui

Tset

MinTsdr

MaxTsdr

Trdy

Tid1

Tid2

: Gap Factor

10: Retry Limit

NGOl

Check the user-defined bus profile.

Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

140008 | No tag updating or writing is executed because baud
rate is incorrect. The following parameters could not

be written to the registry:

General error

Wrong version

Profile cannot be written to the registry.

The subnet type cannot be written to the registry.

: The Target Rotation Time cannot be written to the
registry.

5: Faulty Highest Address (HSA).

AN

Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

140009 | Tags are not updated or written because the module
for S7 communication was not found.

Reinstall the module in the Control Panel using
"Set PG/PC interface".

140010 | No S7 communication partner found because the PLC
is shut down.

DP/T:

The option “PG/PC is the only master” is not set in the
Control Panel under “Set PG/PC interface.”

Switch the PLC on.

DP/T:

If only one master is connected to the network, disable
"PG/PC is the only master" in "Set PG/PC interface".
If several masters are connected to the network,
enable these. Do not change any settings, for this will
cause bus errors.

140011 | No tag updating or writing is executed because
communication is down.

Check the connection and that the communication
partner is switched on.

140012 | There is an initialization problem (e.g. when WinCC
flexible Runtime was closed in Task Manager).

Or:

Another application (e.g.STEP7) with different bus
parameters is active and the driver cannot be started
with the new bus parameters (transmission rate, for
example).

Restart the HMI device.

Or:

Run WinCC flexible Runtime, then start your other
applications.

140013 | The MPI cable is disconnected and, thus, there is no
power supply.

Check the connections.

140014 | The configured bus address is in already in use by
another application.

Edit the HMI device address in the PLC configuration.
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140015 | Wrong transmission rate Correct the relevant parameters.

Or:

Faulty bus parameters (e.g. HSA)

Or:

OP address > HSA or: Wrong interrupt vector
(interrupt does not arrive at the driver)

140016 | The hardware does not support the configured Change the interrupt number.
interrupt.

140017 | The set interrupt is in use by another driver. Change the interrupt number.

140018 | The consistency check was disabled by SIMOTION Enable the consistency check with SIMOTION Scout
Scout. Only a corresponding note appears. and once again download the project to the PLC.

140019 | SIMOTION Scout is downloading a new project to the | Wait until the end of the reconfiguration.

PLC. Connection to the PLC is canceled.

140020 | The version in the PLC and that of the project The following remedies are available:
(FWXfile) do not match. Download the current version to the PLC using
Connection to the PLC is canceled SIMOTION Scout.

Regenerate the project using WinCC flexible ES, close
WinCC flexible Runtime and restart with a new
configuration.

150000 | No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC is
e The cable is defective operational, the correct port is being used.

« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload

150001 | Connection is up because the cause of the interruption | —
has been eliminated.

160000 | No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC is
e The cable is defective operational, the correct port is being used.

« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload

160001 | Connection is up because the cause of the interruption | —
has been eliminated.

160010 | No connection to the server because the server Check access rights.
identification (CLS-ID) cannot be determined.

Values cannot be read or written.

160011 | No connection to the server because the server Check, for example, if
identification (CLS-ID) cannot be determined. e The server name is correct
Values cannot be read or written. « The computer name is correct

e The server is registered

160012 | No connection to the server because the server Check, for example, if

identification (CLS-ID) cannot be determined.
Values cannot be read or written.

e The server name is correct
e The computer name is correct
e The server is registered

Note for advanced users:
Interpret the value from HRESULT.
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160013

The specified server was started as InProc server.
This has not been released and may possibly lead to
incorrect behavior because the server is running in the
same process area as the WinCC flexible Runtime
software.

Configure the server as OutProc Server or Local
Server.

160014

Only one OPC server project can be started on a
PC/MP. An alarm is output when an attempt is made
to start a second project.

The second project has no OPC server functionality
and cannot be located as an OPC server by external
sources.

Do not start a second project with OPC server
functionality on the computer.

170000

S7 diagnostics events are not indicated because it is
not possible to log on to the S7 diagnostics functions
at this device. The service is not supported.

170001

The S7 diagnostics buffer cannot be viewed because
communication with the PLC is shut down.

Set the PLC to online mode.

170002

The S7 diagnostics buffer cannot be viewed because
reading of the diagnostics buffer (SSL) was canceled
with error.

170003

An S7 diagnostics event cannot be visualized. The
system returns internal error %2.

170004

An S7 diagnostics event cannot be visualized. The
system returns an internal error of error class %2,
error number %3.

170007

It is not possible to read the S7 diagnostics buffer
(SSL) because this operation was canceled with an
internal error of class %2 and error code %3.

180000

A component/OCX received configuration data with a
version ID which is not supported.

Install a newer component.

180001

System overload because too many actions running in
parallel. Not all the actions can be executed, some are
rejected.

Several remedies are available:

¢ Increase the configured cycle times or basic clock
e Generate the alarms at a slower rate (polling)

¢ Initiate scripts and functions at greater intervals

If the alarm appears more frequently:
Restart the HMI device.

180002

The screen keyboard could not be activated. Possible
causes:

"TouchlnputPC.exe" was not registered due to a faulty
Setup.

Reinstall WinCC flexible Runtime.

190000

It is possible that the tag is not updated.

190001

The tag is updated after the cause of the last error
state has been eliminated (return to normal operation).

190002

The tag is not updated because communication with
the PLC is down.

Select the system function "SetOnline" to go online.

190004

The tag is not updated because the configured tag
address does not exist.

Check the configuration.

190005

The tag is not updated because the configured PLC
type does not exist for this tag.

Check the configuration.
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190006

The tag is not updated because it is not possible to
map the PLC type in the data type of the tag.

Check the configuration.

190007

The tag value is not modified because the connection
to the PLC is interrupted or the tag is offline.

Set online mode or reconnect to the PLC.

190008

The threshold values configured for the tag have been
violated, for example, by

e A value entered
e A system function
e A script

Observe the configured or current threshold values of
the tag.

190009

An attempt has been made to assign the tag a value
which is outside the permitted range of values for this
data type.

For example, a value of 260 was entered for a byte
tag or a value of -3 for an unsigned word tag.

Observe the range of values for the data type of the
tags.

190010

Too many values are written to the tag (for example, in
a loop triggered by a script).

Values are lost because only up to 100 actions are
saved to the buffer.

Increase the time interval between multiple write
actions.

190011

Possible cause 1:

The value entered could not be written to the
configured PLC tag because the high or low limit was
exceeded.

The system discards the entry and restores the
original value.

Possible cause 2:
The connection to the PLC was interrupted.

Make sure that the value entered lies within the range
of values of the control tags.

Check the connection to the PLC.

190012

It is not possible to convert a value from a source
format to a target format, for example:

An attempt is being made to assign a value to a
counter that is outside the valid, PLC-specific value
range.

A tag of the type Integer should be assigned a value of
the type String.

Check the range of values or the data type of the tags.

190100

The area pointer is not updated because the address
configured for this pointer does not exist.
Type

Warning alarms

Error alarms

PLC acknowledgment

HMI device acknowledgment

LED mapping

Trend request

Trend transfer 1

Trend transfer 2
0.
consecutive number shown in WinCC flexible ES.

ZoOoO~NOODWN

Check the configuration.

190101

The area pointer is not updated because it is not
possible to map the PLC type to the area pointer type.
Parameter type and no.:

see alarm 190100
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190102

The area pointer is updated after the cause of the last
error state has been eliminated (return to normal
operation). Parameter type and no.:

See alarm 190100

200000

Coordination is not executed because the address
configured in the PLC does not exist/is not set.

Change the address or set up the address in the PLC.

200001

Coordination is canceled because the write access to
the address configured in the PLC is not possible.

Change the address or set the address in the PLC at
an area which allows write access.

200002

Coordination is not carried out at the moment because
the address format of the area pointer does not match
the internal storage format.

Internal error

200003

Coordination can be executed again because the last
error state is eliminated (return to normal operation).

200004

The coordination may not be executed.

200005

No more data is read or written. Possible causes:
o The cable is defective

o The PLC does not respond, is defective, etc.
e System overload

Ensure that the cable is plugged in and the PLC is
operational.
Restart the system if the system alarm persists.

200100

Coordination is not executed because the address
configured in the PLC does not exist/is not set.

Change the address or set up the address in the PLC.

200101

Coordination is canceled because the write access to
the address configured in the PLC is not possible.

Change the address or set the address in the PLC at
an area which allows write access.

200102

Coordination is not carried out at the moment because
the address format of the area pointer does not match
the internal storage format.

Internal error

200103

Coordination can be executed again because the last
error state is eliminated (return to normal operation).

200104

The coordination may not be executed.

200105

No more data is read or written. Possible causes:
o The cable is defective

e The PLC does not respond, is defective, etc.
e System overload

Ensure that the cable is plugged in and the PLC is
operational.
Restart the system if the system alarm persists.

210000

Jobs are not processed because the address
configured in the PLC does not exist/has not been set

up.

Change the address or set up the address in the PLC.

210001

Jobs are not processed because read/write access to
the address configured in the PLC is not possible.

Change the address or set up the address in the PLC
in an area which allows read/write access.

210002

Jobs are not executed because the address format of
the area pointer does not match the internal storage
format.

Internal error

210003

The job buffer is processed again because the last
error status has been eliminated (return to normal
operation).

210004

It is possible that the job buffer will not be processed.

210005

A control request with an illegal number was initiated.

Check the PLC program.

210006

An error occurred while attempting to execute the
control request. As a result, the control request is not
executed. Observe the next/previous system alarms.

Check the parameters of the control request.
Recompile the configuration.

278

MP 277 (WinCC flexible)
Operating Instructions, 03/2009, ASE02479740-01



Appendix

A.2 System alarms

Number | Effect/cause Remedy
220001 | The tag is not downloaded because the associated Change the configuration.
communication driver / HMI device does not support
the download of Boolean/discrete data types.
220002 | The tag is not downloaded because the associated Change the configuration.
communication driver / HMI device does not support
write access to the data type BYTE.
220003 | The communication driver cannot be loaded. The Install the driver by reinstalling WinCC flexible
driver may not be installed. Runtime.
220004 | Communication is down and no update data is Check the connection.
transferred because the cable is not connected or
defective etc.
220005 | Communication is up. —
220006 | The connection between the specified PLC and the —
specified port is active.
220007 | The connection to the specified PLC is interrupted at | Check whether
the specified port. e The cable is plugged in
e The PLCis OK
e The correct port is used
¢ Your configuration is OK (port parameters, protocol
settings, PLC address)
Restart the system if the system alarm persists.
220008 | The communication driver cannot access or open the | Close all the applications which access this port and
specified port. The port may be in use by another restart the computer.
application or the port used is not available on the Use another port of the system.
destination device.
There is no communication with the PLC.
230000 | The value entered could not be accepted. The system | Enter a practical value or delete any unneeded users.
discards the entry and restores the previous value.
Either
e The value range has been exceeded
o lllegal characters have been entered
e The maximum permitted number of users has
been exceeded
230002 | The currently logged in user has not the required Log on as a user with appropriate authorization.
authorization. The system therefore discards the input
and restored the previous value.
230003 | Changeover to the specified screen failed because the | Configure the screen and check the screen selection
screen is not available/configured. The current screen | function.
remains selected.
230005 | The value range of the tag has been exceeded in the | Observe the range of values for the tag when entering
1/O field. a value.
The original value of the tag is retained.
230100 | During navigation in the web browser, the system Navigate to another page.

returned a message which may be of interest to the
user.

The web browser continues to run but may not (fully)
show the new page.
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230200 | The connection to the HTTP channel was interrupted | Check the network connection.
due to an error. This error is explained in detail by Check the server configuration.
another system alarm.

Data is no longer exchanged.

230201 | The connection to HTTP channel was established. —
Data is exchanged.
230202 | WININET.DLL has detected an error. This error Depending on the cause:

usually occurs when an attempt to connect to the When an attempt to connect fails or a timeout error
server fails or the server refuses to connect because | 5ocurs:

the client lacks the proper authorization.

An unknown server certificate may also be the cause if
the connection is encrypted by means of SSL.

e Check the network connection and the network
e Check the server address

The alarm text provides details. e Check whether the web server is actually running
This text is always in the language of the Windows on the destination computer

installation because it is returned by the Windows OS. | Faulty authorization:

Process values are no longer exchanged. e The configured user name and/or password do not

match those on the server. Establish consistency

When the server certificate is rejected:
Certificate signed by an unknown CA ( ):

o Either ignore this item in your project, or

¢ Install a certificate that has been signed with a root
certificate known to the client computer

If the date of certificate is invalid:

o Either ignore this item in your project, or

¢ Install a certificate with a valid date on the server
Invalid CN (Common Name or Computer Name):

o Either ignore this item in your project, or

¢ Install a certificate with a name that corresponds to
that of the server address

230203 | Although a connection can be made to the server, the | Error 503 Service unavailable: Check whether

HTTP server refuses to connect because e WinCC flexible Runtime is running on the server
server, or

e The HTTP channel is not supported (503 Service
unavailable)

Other errors can only occur if the web server does not
support the HTTP channel. The language of the alarm
text depends on the web server.

Data is not exchanged.

230301 | Aninternal error has occurred. An English text —
explains the error in more detail. This may be caused
by insufficient memory.

OCX does not work.

230302 | The name of the remote server cannot be resolved. Check the configured server address.
The attempt to connect failed. Check whether the DNS service is available on the
network.
230303 | The remote server is not running on the addressed Check the configured server address.
computer. Check whether the remote server is running on the
Wrong server address. target computer.

The attempt to connect failed
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230304 | The remote server on the addressed computer is Use a compatible remote server.
incompatible to VNCOCX.
The attempt to connect failed.
230305 | The authentication has failed because the password is | Configure the correct password.
incorrect.
The attempt to connect failed.
230306 | Error in the connection to the remote server. This may | Check whether
occur as a result of network problems. e The bus cable is plugged in
The attempt to connect failed. « There are network problems
230307 | The connection to the remote server was shut down —
because
e The remote server was shut down, or
e The user instructed the server to close all
connections
The connection is closed.
230308 | This alarm provides information on the connection —
status.
An attempt is made to connect.
240000 | WiIinCC flexible Runtime is operating in demo mode. Install the authorization.
You have no authorization or your authorization is
corrupted.
240001 | WinCC flexible Runtime is operating in demo mode. Load an adequate authorization / powerpack.
Too many tags are configured for the installed version.
240002 | WinCC flexible Runtime is operating with a time- Restore the full authorization.
limited emergency authorization.
240003 | Authorization failed. Restart WinCC flexible Runtime or reinstall it.
Without authorization, WinCC flexible Runtime will run
in demo mode.
240004 | Error while reading the emergency authorization. Restart WinCC flexible Runtime, install the
WinCC flexible Runtime is operating in demo mode. authorization or repair the authorization (see
Commissioning Instructions Software Protection).
240005 | The Automation License Manager has detected an Reboot the HMI device/PC. If this does not solve the
internal system fault. problem, remove the Automation License Manager
Possible causes: and install it again.
e A corrupt file
o A defective installation
e No free space for the Automation License
Manager etc.
250000 | The tag in the specified line in "Status force" is not Check the set address and then verify that the address
updated because the address configured for this tag is | is set up in the PLC.
not available.
250001 | The tag in the specified line in "Status force" is not Check the set address.
updated because the PLC type configured for this tag
does not exist.
250002 | The tag in the specified line in "Status force" is not Check the set address.

updated because it is not possible to map the PLC
type in the tag type.
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250003 | An attempt to connect to the PLC failed. The tags are | Check the connection to the PLC. Check that the PLC
not updated. is switched on and is online.

260000 | An unknown user or an unknown password has been | Log on to the system as a user with a valid password.
entered in the system.

The current user is logged off from the system.

260001 | The logged in user does not have sufficient Log on to the system as a user with sufficient
authorization to execute the protected functions on the | authorization.
system.

260002 | This alarm is triggered by the system function —

"TrackUserChange".

260003 | The user has logged off from the system. —

260004 | The user name entered into the user view already Select another user name because user names have
exists in the user management. to be unique in the user management.

260005 | The entry is discarded. Use a shorter user name.

260006 | The entry is discarded. Use a shorter or longer password.

260007 | The logon timeout value entered is outside the valid Enter a logon timeout value between 0 and 60
range of 0 to 60 minutes. minutes.

The new value is discarded and the original value is
retained.

260008 | An attempt was made to read a PTProRun.pwil file —
created with ProTool V 6.0 in WinCC flexible.

Reading the file was canceled due to incompatibility of
the format.

260009 | You have attempted to delete the user "Admin" or If you need to delete a user, because perhaps you
"PLC User". These users are fixed components of the | have exceeded the maximum number permitted,
user management and cannot be deleted. delete another user.

260012 | The passwords entered in the "Change Password" You have to log on to the system again. Then enter
dialog and the confirmation field are not identical. the identical password twice to be able to change the
The password has not been changed. User will be password.
logged off.

260013 | The password entered in the "Change Password" You have to log on to the system again. Then enter a
dialog is invalid because it is already in use. new password that has not been used before.

The password has not been changed. User will be
logged off.

260014 | User has unsuccessfully attempted to log on 3 times in | You can log on to the system with your correct
succession. password. Only an administrator can change the
The user has been locked out and assigned to group | assignment to a group.
no. 0.

270000 | A tag is notindicated in the alarm because it attempts | Check whether the data area for the tag exists in the
to access an invalid address in the PLC. PLC, the configured address is correct and the value

range for the tag is correct.

270001 | There is a device-specific limit as to how many alarms | —
may be queued for output (see the operating
instructions). This limit has been exceeded.

The view no longer contains all the alarms.
However, all alarms are written to the alarm buffer.
270002 | The view shows alarms of a log for which there is no | Delete older log data if necessary.
data in the current project.
Wildcards are output for the alarms.
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270003 | The service cannot be set up because too many Reduce the number of HMI devices which want to use
devices want to use this service. the service.
A maximum of four devices may execute this action.
270004 | Access to persistent buffer is not possible. Alarms If the problems persist at the next startup, contact
cannot be restored or saved. Customer Support (delete Flash).
270005 | Persistent buffer damaged: Alarms cannot be If the problems persist at the next startup, contact
restored. Customer Support (delete Flash).
270006 | Project modified: Alarms cannot be restored from the | The project was generated and transferred new to the
persistent buffer. HMI device; The error should no longer occur when
the device starts again.
270007 | A configuration problem is preventing the restore (a Update the operating system and then transfer your
DLL is missing, a directory is unknown, etc.). project again to the HMI device.
280000 | Connection is up because the cause of the interruption | —
has been eliminated.
280001 | No more data is read or written. Possible causes: Check whether
e The cable is defective e The cable is plugged in
o The PLC does not respond, is defective, etc. e The PLCis OK
e The wrong port is used for the connection e The correct port is used
e System overload Restart the system if the system alarm persists.
280002 | The connection used requires a function block in the —
PLC.
The function block has responded. Communication is
now enabled.
280003 | The connection used requires a function block in the Check whether
PLC. . e The cable is plugged in
The function block has not responded. e The PLC is OK
e The correct port is used
Restart the system if the system alarm persists.
Remedy depends on the error code:
1: The function block must set the COM bit in the
response container.
2: The function block must not set the ERROR bit in
the response container.
3: The function block must respond within the
specified time (timeout).
4: Go online to the PLC.
280004 | The connection to the PLC is interrupted. There is no | Check the connection parameters in WinCC flexible.
data exchange at present. Ensure that the cable is plugged in, the PLC is
operational, the correct port is being used.
Restart the system if the system alarm persists.
290000 | The recipe tag could not be read or written. It is Check in the configuration that the address has been

assigned the start value.

The alarm can be entered in the alarm buffer for up to
four more failed tags if necessary. After that, alarm
290003 is output.

set up in the PLC.
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A.2 System alarms

Number | Effect/cause Remedy
290001 | An attempt has been made to assign a value to a Observe the value range for the tag type.
recipe tag which is outside the value range permitted
for this type.
The alarm can be entered in the alarm buffer for up to
four more failed tags if necessary. After that, alarm
290004 is output.
290002 | Itis not possible to convert a value from a source Check the value range or type of the tag.
format to a target format.
The alarm can be entered in the alarm buffer for up to
four more failed recipe tags if necessary. After that,
alarm 290005 is output.
290003 | This alarm is output when alarm number 290000 is Check in the configuration that the tag addresses have
triggered more than five times. been set up in the PLC.
In this case, no further separate alarms are generated.
290004 | This alarm is output when alarm number 290001 is Observe the value range for the tag type.
triggered more than five times.
In this case, no further separate alarms are generated.
290005 | This alarm is output when alarm number 290002 is Check the value range or type of the tag.
triggered more than five times.
In this case, no further separate alarms are generated.
290006 | The threshold values configured for the tag have been | Observe the configured or current threshold values of
violated by values entered. the tag.
290007 | There is a difference between the source and target Insert the specified data recipe tag in the source
structure of the recipe currently being processed. The | structure.
target structure contains an additional data recipe tag
which is not available in the source structure.
The data recipe tag specified is assigned its start
value.
290008 | There is a difference between the source and target Remove the specified data recipe tag in the specified
structure of the recipe currently being processed. The | recipe from the project.
source structure contains an additional data recipe tag
which is not available in the target structure and
therefore cannot be assigned.
The value is rejected.
290010 | The storage location configured for the recipe is not Check the configured storage location.
permitted.
Possible causes:
lllegal characters, write protection, data carrier out of
space or does not exist.
290011 | The record with the specified number does not exist. Check the source for the number (constant or tag
value)
290012 | The recipe with the specified number does not exist. Check the source for the number (constant or tag
value)
290013 | An attempt was made to save a record under a record | The following remedies are available:
number which already exists. » Check the source for the number (constant or tag
The action is not executed. value)
o First, delete the record
e Change the "Overwrite" function parameter
290014 | The file specified to be imported could not be found. Check:
e The file name
e Ensure that the file is in the specified directory
MP 277 (WinCC flexible)
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A.2 System alarms

Number | Effect/cause Remedy
290020 | Alarm reporting that the download of records from the | —
HMI device to the PLC has started.
290021 | Alarm reporting that the download of records from the | —
HMI device to the PLC was completed.
290022 | Alarm reporting that the download of records from the | Check in the configuration whether:
HMI device to the PLC was canceled due to an error. |4  The tag addresses are configured in the PLC
e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290023 | Alarm reporting that the download of records from the | —
PLC to the HMI device has started.
290024 | Alarm reporting that the download of records from the | —
PLC to the HMI device was completed.
290025 | Alarm reporting that the download of records from the | Check in the configuration whether:
PLC to the HMI device was canceled due to an error. |4 The tag addresses are configured in the PLC
e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290026 | An attempt has been made to read/write a record Set the record status to zero.
although the record is not free at present.
This error may occur in the case of recipes for which
downloading with synchronization has been
configured.
290027 | Unable to connect to the PLC at present. As a result, Check the connection to the PLC.
the record can neither be read nor written.
Possible causes:
No physical connection to the PLC (no cable plugged
in, cable is defect) or the PLC is switched off.
290030 | This alarm is output after you selected screen which Reload the record from the storage location or retain
contains a recipe view in which a record is already the current values.
selected.
290031 | While saving, it was detected that a record with the Overwrite the record or cancel the action.
specified number already exists.
290032 | While exporting records it was detected that a file with | Overwrite the file or cancel the process.
the specified name already exists.
290033 | Confirmation request before deleting records. —
290040 | A record error with error code %1 that cannot be Check the storage location, the record, the "Data
described in more detail occurred. record" area pointer and if necessary, the connection
The action is canceled. to the PLC.
It is possible that the record was not installed correctly | Restart the action after a short time.
on the PLC. If the error persists, contact Customer Support.
Forward the relevant error code to Customer Support.
290041 | A record or file cannot be saved because the storage | Delete files no longer required.
location is full.
290042 | An attempt was made to execute several recipe Trigger the action again after waiting a short period.
actions simultaneously. The last action was not
executed.
290043 | Confirmation request before storing records. —

MP 277 (WinCC flexible)
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A.2 System alarms

Number | Effect/cause Remedy
290044 | The data store for the recipe has been destroyed and | —
is deleted.
290050 | Alarm reporting that the export of records has started. | —
290051 | Alarm reporting that the export of records was —
completed.
290052 | Alarm reporting that the export of records was Ensure that the structure of the records at the storage
canceled due to an error. location and the current recipe structure on the HMI
device are identical.
290053 | Alarm reporting that the import of records has started. | —
290054 | Alarm reporting that the import of records was —
completed.
290055 | Alarm reporting that the import of records was Ensure that the structure of the records at the storage
canceled due to an error. location and the current recipe structure on the HMI
device are identical.
290056 | Error when reading/writing the value in the specified Check the specified line/column.
line/column.
The action was canceled.
290057 | The tags of the recipe specified were toggled from —
"offline" to "online" mode.
Each change of a tag in this recipe is now immediately
downloaded to the PLC.
290058 | The tags of the specified recipe were toggled from —
"offline" to "online" mode.
Modifications to tags in this recipe are no longer
immediately transferred to the PLC but must be
transferred there explicitly by downloading a record.
290059 | Alarm reporting that the specified record was saved. —
290060 | Alarm reporting that the specified record memory was | —
cleared.
290061 | Alarm reporting that clearing of record memory was —
canceled due to an error.
290062 | The record number is above the maximum of 65536. | Select another number.
This record cannot be created.
290063 | This occurs with the system function Check the "ExportDataRecords" system function.
"ExportDataRecords" when the parameter "Overwrite"
is set to No.
An attempt has been made to save a recipe under a
file name which already exists.
The export is canceled.
290064 | Alarm reporting that the deletion of records has —
started.
290065 | Alarm reporting that the deletion of records has —
successfully completed.
290066 | Confirmation request before deleting records. —
290068 | Security request to confirm if all records in the recipe | —
should be deleted.
290069 | Security request to confirm if all records in the recipe | —
should be deleted.
290070 | The record specified is not in the import file. Check the source of the record number or record
name (constant or tag value).
MP 277 (WinCC flexible)
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A.2 System alarms

Number | Effect/cause Remedy

290071 | During the editing of record values, a value was Enter a value within the limits of the recipe tag.
entered which exceeded the low limit of the recipe tag.
The entry is discarded.

290072 | When editing record values, a value was entered Enter a value within the limits of the recipe tag.
which exceeds the high limit of the recipe tag.
The entry is discarded.

290073 | An action (e.g. saving a record) failed due to an —
unknown error.
The error corresponds to the status alarm
IDS_OUT_CMD_EXE_ERR in the large recipe view.

290074 | While saving, it was detected that a record with the Overwrite the record, change the record number or
specified number already exists but under another cancel the action.
name.

290075 | A record with this name already exists. Please select a different record name.
The record is not saved.

300000 | Faulty configuration of process monitoring (e.g. using | Change the PLC configuration.
PDiag or S7-Graph): More alarms are queued than
specified in the specifications of the CPU. No further
ALARM_S alarms can be managed by the PLC and
reported to the HMI devices.

300001 | ALARM_S is not registered on this PLC. Select a PLC that supports the ALARM_S service.

310000 | An attempt is being made to print too many reports in | Wait until the previous active log was printed.
parallel. Repeat the print job if necessary.
Only one log file can be output to the printer at a given
time; the print job is therefore rejected.

310001 | An error occurred on triggering the printer. The report | Evaluate the additional system alarms related to this
is either not printed or printed with errors. alarm.

Repeat the print job if necessary.

320000 | The movements have already been indicated by Deselect the movements on the other display units
another device. and select the motion control screen on the required
The movements can no longer be controlled. display unit.

320001 | The network is too complex. View the network in STL.
The faulty addresses cannot be indicated.

320002 | No diagnostics alarm selected. Select a diagnostics alarm from the ZP_ALARM alarm
The unit belonging to the alarm could not be selected. | screen.

320003 | No alarms exists for the selected unit. The detail view | Select the defective unit from the overview screen.
cannot visualize any networks.

320004 | The required signal states could not be read by the Check the consistency between the configuration on
PLC. The faulty addresses cannot be found. the display unit and the PLC program.

320005 | The project contains ProAgent elements which are not | In order to run the project, install the optional ProAgent
installed. ProAgent diagnostic functions cannot be package.
performed.

320006 | You have attempted to execute a function which is not | Check the type of the selected unit.
supported in the current constellation.

320007 | No error-triggering addresses were found on the Switch the detail screen to STL layout mode and
networks. check the status of the addresses and exclusion
ProAgent cannot indicate any faulty addresses. addresses.

320008 | The diagnostic data stored in the configuration are not | Transfer the project to the HMI device again.

synchronized with those in the PLC.
ProAgent can only indicate the diagnostic units.

MP 277 (WinCC flexible)
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A.2 System alarms

Number | Effect/cause Remedy
320009 | The diagnostic data stored in the configuration are not | Transfer the project to the HMI device again.
synchronized with those in the PLC. The diagnostic
screens can be operated as usual.
ProAgent may be unable to show all diagnostic texts.
320010 | The diagnostic data stored in the configuration are not | Transfer the project to the HMI device again.
synchronized with those in STEP7.
The ProAgent diagnostics data is not up-to-date.
320011 | A unit with the corresponding DB number and FB Check the parameters of the "SelectUnit" function and
number does not exist. the units selected in the project.
The function cannot be executed.
320012 | The "Step sequence mode" dialog is no longer Use the ZP_STEP step sequence screen from the
supported. corresponding standard project for your project.
Instead of calling the Overview_Step_Sequence_Mode
function, call the "FixedScreenSelection" function
using ZP_STEP as the screen name.
320014 | The selected PLC cannot be evaluated for ProAgent. | Check the parameters of the
The Alarm view assigned to the "EvaluateAlarmDisplayFault" system function.
"EvaluateAlarmDisplayFault" system function could
not be found.
330022 | Too many dialogs are open on the HMI device. Close all dialogs you do not require on the HMI device.
MP 277 (WinCC flexible)
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ANSI
CPU
CSv
CTS
DC
DCD
DHCP
DIL
DNS
DP
DSN
DSR
DTR

ESD
EMC

PPI
RAM

MP 277 (WinCC flexible)

American National Standards Institution
Central Processing Unit

Comma Separated Values

Clear To Send

Direct Current

Data Carrier Detect

Dynamic Host Configuration Protocol
Dual-in-Line (electronic chip housing design)
Domain Name System

Distributed I/O

Data Source Name

Data Set Ready

Data Terminal Ready

Input and Output

Components and modules endangered by electrostatic discharge
Electromagnetic Compatibility
European standard

Engineering System

Components and modules endangered by electrostatic discharge
Ground

High Frequency

Human Machine Interface

International Electronic Commission
Interface

Internet Protocol

Light Emitting Diode

Media Access Control

Metal Oxide Semiconductor

Multipoint Interface (SIMATIC S7)
Microsoft

Mean Time Between Failures

Not connected

Operator Panel

Personal Computer

Programming device

Point-to-Point Interface (SIMATIC S7)
Random Access Memory
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PELV
RJ45
RTS
RxD
SD Card
SELV
SP
PLC
STN
Sub-D
TAB
TCP/IP
TFT
TTY
TxD
UL
USB
WINS

Protective Extra Low Voltage
Registered Jack Type 45

Request to send

Receive Data

Security Digital Card

Safety Extra Low Voltage

Service Pack

Programmable Logic Controller
Super Twisted Nematic
Subminiature D (plug)

Tabulator

Transmission Control Protocol/Internet Protocol
Thin Film Transistor

Teletype

Transmit Data

Underwriter’s Laboratory
Universal Serial Bus

Windows Internet Naming Service

MP 277 (WinCC flexible)
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Glossary

Acknowledge

Acknowledgment of an alarm confirms that it has been noted.

Alarm logging

Output of user-specific alarms to a printer, in parallel to their output to the HMI device
screen.

Alarm, acknowledgment

Acknowledgment of an alarm confirms that it has been noted.

Alarm, activated

Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, deactivated

Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific

A user-specific alarm report specific operating states of a plant interconnected to the HMI
device via the PLC.

Automation device
An automation device is a PLC of the SIMATIC S5 series, for example the AG S5-115U

Automation system
An automation system is a PLC of the SIMATIC S7 series, for example SIMATIC S7-300

Boot loader

The boot loader is used to start the operating system and is started automatically after power
on of the HMI device. The loader is displayed after the operating system has loaded.

Configuration PC

A configuration PC is a programming device or PC on which plant projects are created using
an engineering software.

MP 277 (WinCC flexible)
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Configuration software

Controller

Configuration software is used to create projects used for the purpose of process
visualization. WinCC flexible is such a configuration software, for example.

PLC is a general term for devices and systems with which the HMI device communicates,
e.g. SIMATIC S7.

Degree of protection

Display duration

EMC

Event

Field

Flash memory

Function keys

292

The degree of protection specifies a standard of electronic equipment for a variety of
environmental conditions — and the protection of humans against potential danger when
using this equipment.

The degree of protection classified by IP differs from the protection class. But both involve
protection against touching dangerous electric voltage. The degree of protection also
classifies the protection of equipment against dirt and moisture.

Defines whether a system alarm is displayed on the HMI device and the duration of the
display.

Electromagnetic compatibility (EMC) refers to a usually desirable state, in which technical
equipment does not disturb one another with unwanted electrical or electromagnetic effects.
Electromagnetic compatibility deals with technical and regulatory questions of undesired,
mutual influence in electrical engineering.

Functions are triggered by defined incoming events. Events can be configured. Events which
can be assigned to a button include "Press" and "Release", for example.

Area reserved in configured screens for the input and output of values.

Flash memory is a non-volatile memory with EEPROM chips that is implemented either as
mobile storage medium, or as permanently installed memory module on the motherboard.

Function keys on the HMI device can be assigned user-specific functions. The functions
assigned to these keys are defined during configuration. The assignment of the function keys
may be specific to an active screen or independent of it.

MP 277 (WinCC flexible)
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Half Brightness Life Time

Hardcopy

HMI device

Time period after which brightness is reduced to 50% of the original value. The specified
value depends on the operating temperature.

Output of the screen content to a printer.

An HMI device is a device used for the operation and monitoring of machines and plants.
The machine or plant states are visualized on the HMI device by means of graphic objects or
signal lamps. The operator controls of the HMI device allow the operator to interact with the
processes of the machine or plant.

HMI device image

I/0 field

Info text

Object

Operator control

Plant

PLC job

The HMI device image is a file that can be transferred from the configuration PC to the HMI
device. The HMI device image contains the operating system for the HMI device and the
elements of the runtime software required to run a project.

An 1/O field enables the input or output of values on the HMI device which are transferred to
the PLC.

An infotext is a configured information on objects within a project. Infotext for an alarm, for
example, may contain information on the cause of the fault and troubleshooting routines.

An object is a project element such as a screen or an alarm. Objects are used to view or
enter texts and values on the HMI device.

An operator control is a component of a project used to enter values and trigger functions. A
button, for example, is an operator control.

General term referring to machines, processing centers, systems, plants and processes
which are operated and monitored on an HMI device.

A PLC job triggers a function for the PLC on the HMI device.
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Process visualization

Project

Project file

Process visualization is the representation of technical processes by means of text and
graphic elements. Configured plant screens allow operator intervention in active plant
processes using the input and output data.

A project is the result of a configuration using a configuration software. The project normally
contains several screens with embedded system-specific objects, basic settings and alarms.
A project configured in WinCC flexible is saved to a project file with the extension *.hmi.

You need to distinguish between a project on the configuration PC and an executable project
on an HMI device. A project on the configuration PC can be available in more languages
than can be managed on the HMI device. The project on the configuration PC can also be
set up for different HMI devices. You can only transfer an executable project to an HMI
device if it has been especially compiled for it.

A project file is a file from which the executable project file for use on the HMI device is
generated. The project file is usually not transferred and is retained on the configuration PC.

The file name extension of a project file is *.hmi.

Project file, compressed

Compressed format of the project file. The compressed project file can be transferred in
addition to the executable project file to the corresponding HMI device. For this purpose,
backtransfer must be enabled in the project on the configuration PC. The compressed
project file is usually saved to an external memory card.

A compressed project file has the extension *.pdz.

Project file, executable

Protection class

Recipe

294

An executable project file is the file generated from the project file for a specific HMI device.
The executable project file is transferred to the associated HMI device where it is used to
operate and monitor plants.

An executable project file has the extension "*.fwx".

The protection class is used in electrical engineering to classify and identify electrical
equipment in relation to existing safety measures designed to prevent electric shock.

There are four protection classes for electrical equipment.

A recipe is a combination of tags that form a fixed data structure. The configured data
structure can be assigned data in the configuration software or on the HMI device and is
then referred to as a record. The use of recipes ensures that all data assigned to a data
record is transferred synchronously to the PLC.
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Runtime software

The runtime software is a process visualization software used to test a project on a
configuration PC.

Screen

A screen is a form of visualization for all logically related process data in a plant. The
representation of the process data can be visually supported by graphic objects.

Screen object

A screen object refers to objects such as rectangles, 1/O fields, or alarm views which are
configured for visualization or operation of the plant.

STEP 7

STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and SIMATIC WinAC
PLCs.

STEP 7 Micro/WIN
STEP 7 Micro/WIN is the programming software for SIMATIC S7-200 PLCs.

Symboilic 1/O field

A symbolic I/O field is a field for the input and output of a value. Contains a list of default
entries from which one can be selected.

System alarm

A system alarm is assigned to the "System" alarm class. A system alarm refers to internal
states on the HMI device and the PLC.

Tab order

The tab order defined in the course of project engineering determines the sequence for
activating objects by pressing the <TAB> key.

Tag

A tag is a defined memory location to which values can be written and from which values can
be read. This can be done from the PLC or the HMI device. We distinguish between external
tags (process tags) and internal tags, depending on whether or not the tag is interconnected

with the PLC.
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Transfer
Transfer of a runtime project from the configuration PC to the HMI device.

"Transfer" mode

The "Transfer" operating mode is an operating mode of the HMI device in which an
executable project is transferred from the configuration PC to an HMI device.

WinAC MP
WinAC is a software PLC for multifunctional platforms.

MP 277 (WinCC flexible)
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/
/Audit, 28

A

ACK, 211
ACK key, 175
Acknowledge
Alarm, 175, 215
Error alarm, 215
Acknowledge key, 175
Acoustic feedback, 163
Acoustic signal
Inadvertent operation, 163
Acoustics
Feedback, 103
Activate
Password protection, 94
Address assignment
TCP/IP network, 122
Addressing, 120
Admin, 206, 207, 208
Alarm, 209
Acknowledge, 175, 215
Display, 212
Editing, 216
Functional scope, 26
Alarm buffer, 210
Functional scope, 26
Alarm class, 210, 213
Alarm event, 209
Alarm group, 210
Alarm indicator, 211
Alarm line, 212
Alarm log, 210
Alarm report, 210
Alarm view, 212
Extended, 213
Simple, 212
Alarm window, 214
ALARM_S, 26
Alphanumerical
Key assignment, 87, 175
Screen keyboard, 170
Alphanumerical value
Changing, 171, 179

MP 277 (WinCC flexible)
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Entering, 171, 179
ALT key, 87, 175
Applications

MP 277,13
Approval for Australia, 33
Approvals, 32
Audible signal, 169
Authorization, 197
Automatic

Transfer, 142
A-Z key, 87, 175

B

Backing up, 140, 146, 147, 149, 198
Registry information, 80
Registry Information, 98
Temporary files, 98
To memory card, 79
With ProSave, 149
With WinCC flexible, 147

Backlighting
Reducing, 100
Setting, 80

Backspace key, 86, 175

Backtransfer, 141, 144

Backup, 79, 133
to external storage device, 131

Bar, 182

Booting, 105

Bottom view, 14, 16, 18, 20

Brightness
Changing, 99

Browser
Home page, 79
Setting, 79

Bus connection, 29

Bus parameters
Profile, 114

C

Cable

Connecting, 49
Calibrating

Touch screen, 92
Cancel

Secure mode, 77
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Cancel key, 86, 175
Care, 247
CE approval, 32
Certificate
Delete, 129
Deleting, 79
Displaying, 79
Importing, 79, 129
Certificates, 79
Changing
Brightness, 99
User data, 206, 207
Character repeat, 79
Screen keyboard, 89
Charge
Electrostatic, 263
Clamping frame, 24
Clean screen, 248
Clearance
MP 277, 43
Climatic
Shipping conditions, 37
Storage conditions, 37
Closing
Project, 208
Column sequence
Alarm view, 213
Compatibility conflict, 146
Computer name
Setting, 80
Condensation, 37
Conductor cross-section, 53
Equipotential bonding, 51
Configuration graphic
Configuration PC, 58
Controller, 55
Equipotential bonding, 52
Power supply, 53
Printer, 62
Configuration PC
Configuration graphic, 58
Connecting, 58
Configuration phase, 137
Configure
Network, 120
Configuring
Data channel, 80, 115
Operating system, 73
PC/PPI cable, 59
RS-422/RS-485 interface, 57
Screen keyboard, 79, 88
Configuring PC, 137
Connecting
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Configuration PC, 58
Controller, 55
Equipotential bonding, 51
Mains terminal, 54
Power supply, 53, 54
Printer, 62
PROFINET, 56, 58
USB device, 61
Connection, 29
Connection sequence, 49
Connections to PLCs
Number, 29
Contact person, 5
Control cabinet
Working on, 31
Control keys
Keyboard unit, 85
Control Panel
MPI, 113
Open, 79
Operating, 82, 84
Password protection, 75
PROFIBUS, 113
Screen keyboard, 82
Controller
Configuration graphic, 55
Configuring the interface, 57
Connecting, 55
Conventions, 4
Converter RS 422-RS 232, 23
Cookies, 128
Creating
Recipe data record, 227, 237
Users, 203
CTRL key, 87, 175
Currency, 80
Cursor key, 86, 174

D

Data channel
Configuring, 80, 115
Enabling, 115
Locking, 115
Data flow, 221
Date, 79
Entering, 172, 180
Setting, 95
Synchronizing, 96
Date format, 80, 97
Date/time properties, 79, 95
Deactivating
Password protection, 95
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Decimal, 168
Default gateway, 122
Degree of protection, 42

Protection against ingress of solid foreign

bodies, 44
Protection against water, 44
Delay time
Setting, 80, 108
Delete
Certificate, 129
Recipe data record, 230, 239
Users, 208
Delete key, 86, 175
Device name
For network operation, 121
DHCP, 122
DIP switch
Setting, 57
Direct key, 164
Functional scope, 28
Direct keys
Assignment, 258
Display
Alarm, 212
MP 277 Key, 256
MP 277 Touch, 255
Display format, 178
Displaying
Certificate, 79
HMI device information, 80
Info text, 173, 181
Information on the MP 277, 106
UPS status, 80
Disposal, 5
Disturbance
Pulse-shaped, 35
Sinusoidal, 36
DNS, 122
DNS
Server, 120
Documentation
Additional, 5
Enclosed, 45
Double-click, 79
Setting, 91
Drop down list box
Open, 175

E
EC Declaration of Conformity, 32
Editing

Alarm, 216
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Recipe data record, 229, 238
Elbow adapter, 23
Electrical
Safe separation, 54
Electrical potential difference, 51
Electrostatic charge, 263
Element list, 223, 235
E-mail
Set, function overview, 80
Setting, 125
EMC directive, 32
Emission, 34, 36
Encryption, 128
END key, 86, 174
Enhanced recipe view, 222
Enter key, 86, 174
ENTER key, 86, 174
Entering
Alphanumerical value, 171, 179
Date, 172, 180
Key combination, 87, 175
Numerical value, 169, 178
Recipe data record, 244
Symbolic value, 172
Text box, 167
Time, 172, 180
Entry on the HMI device
By means of function key, 177
Using operating elements, 161
Environmental conditions
Climatic, 40
Mechanical, 39
Test, 40
Equipotential bonding
Cable, 52
Configuration graphic, 52
Connecting, 51
Requirements, 51
Equipotential bonding rail, 52
Error alarm
Acknowledge, 215
ESC key, 86, 175
ESD
Short description, 263
Ethernet settings
IP address, 122
Exporting
Recipe data record, 242
Extended alarm view, 213
Extended user view, 199
External
Keyboard, 81
Mouse, 81
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F

Feedback
Acoustic, 103, 163
Optical, 162
Fixation, 22
FM approval, 33
Fn key, 87,175
Front view, 14, 16, 18, 20
Function
Additional, 28
Function key
Labeling, 69
Function keys
Global assignment, 177
Local assignment, 177
Function test, 64
Functional scope
Alarm buffer, 26
ALARM_S, 26
Graphics list, 26
Info text, 28
Limit monitoring, 26
Log, 27
Messages, 26
Recipe, 27
Safety, 27
Scaling, 26
Screen, 26
Tag, 26
Text list, 26

G

Gauge, 182
Graphics list
Functional scope, 26

Group acknowledgement, 175

H

High frequency radiation, 31
HMI device
Cold restart, 105

EMC-compatible installation, 35

Information, 80
Interfaces, 50
Restarting, 80

Shutting down, 64
Specifications, 255, 256
Switching on, 63
Testing, 63
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HMI Input Panel
Options, 88
HOME key, 86, 174
Home page
Internet, 126
Host cable
Safety instruction, 60

Identification, 124
Importing

Certificate, 79, 129

Recipe data record, 243
Inadvertent operation

Acoustic signal, 163
Info text

Displaying, 173, 181

Functional scope, 28
Information

Additional, 5

For the HMI device, 106
Infotext

Key, 176

LED, 176, 214
Initial startup, 137
Input device

MP 277 Key, 257

MP 277 Touch, 255
Input Panel, 79
Installation as intended, 32
Installing

Option, 140, 155, 157
Instructions

General, 34
Insulation test

Test voltage, 44
Interfaces

MP 277, 50

Rated load, 61
Internet

Home page, 126

Options, 79

Search engine, 126

Security settings, 79

Service, 5

Settings, 125

Settings, overview of functions, 80

Internet options
Privacy, 128

IP address
Ethernet, 122
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Key
ACK, 175
ALT, 87,175
A-Z, 87,175
Backspace, 175
Cancel, 86
CTRL, 87, 175
Cursor, 86, 174
Delete, 86, 175
END, 86, 174
ENTER, 86, 174
ESC, 86, 175
Fn, 87,175
HOME, 86, 174
Infotext, 176
Scroll back, 86, 174
Scroll forward, 86, 174
SHIFT, 87, 175
TAB, 86, 174
Tabulator, 86
Key combination
Entering, 87, 175
Key control, 174, 177
Trend view, 188
Keyboard
External, 81
Safety instruction, 66
Keyboard properties, 79
Knowledge
Required, 3

L

Labeling
Approvals, 33
EC Declaration of Conformity, 32
Function key, 69
Labeling strips
Attaching, 71
Dimensions, 70
Printing, 69
LAN connection, 79
Language switching
Functional scope, 28
Layout
Slider control, 184
Sm@rtClient view, 193
Trend view, 186
LED
Infotext, 176, 214
Memory information, 107

MP 277 (WinCC flexible)
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System information, 107
LED ACK, 211
License key

Transferring, 140, 159

Transferring back, 140, 160
Limit monitoring

Functional scope, 26
Limit test, 168
Limit value

For password, 198

For user, 198

For user view, 198
Limit value test, 178
Loader, 73

Operating, 74
Locking

Operating element, 248
Log

Functional scope, 27
Logoff

Users, 201
Logoff time, 197
Logon

Users, 200
Logon data, 124

M

Main dimensions
MP 277 10" Touch, 252, 253
MP 277 8" Key, 251
MP 277 8" Touch, 249, 250
Mains terminal
Connecting, 54
Maintenance, 247
Manual
Production sequence, 245
Transfer, 141
Mechanical
Shipping conditions, 37
Storage conditions, 37
Memory
MP 277 Key, 257
MP 277 Touch, 255
Memory card, 24
First use, 131
Inserting, 67
Restoring file system, 98
Unplug, 68
Memory information
LED, 107
Memory management, 80, 136
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Menu command
Simple recipe view, 236
Monitoring mode
Sm@rtClient view, 193
Mounting
EMC-compatible, 35
Mounting clamp, 47, 48
Mounting clamp, 22
Mounting, 47, 48
Mounting cut-out
Dimensions, 43
Preparing, 43
Mounting location, 42
Mounting position, 41
Mouse
External, 81
Mouse properties, 79
MP 277
Applications, 13
Clearance, 43
Displaying information, 106
Interfaces, 50
Mounting, 46
Operator control, 65
Switching on, 63
Testing, 63
MP 277 10" Key
Bottom view, 20
Front view, 20
Overall dimensions, 254
Rear view, 21
Side view, 20
MP 277 10" Touch
Bottom view, 18
Front view, 18
Main dimensions, 252, 253
Rear view, 19
Side view, 18
MP 277 8" Key
Bottom view, 16
Front view, 16
Main dimensions, 251
Rear view, 17
Side view, 16
MP 277 8" Touch
Bottom view, 14
Front view, 14
Main dimensions, 249, 250
Rear view, 15
Side view, 14
MP 277 Key
Specifications, 256
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MPI

Setting, 80, 113
Multi-key operation, 162, 176
Multimedia card, 67

N

Name server, 122

Network
Configure, 120
Logon data, 79
Set up, 119
Setting, 122

Network & dial-up connections, 79

Network ID, 79

Network operation
Device name, 121
Options, 80, 125

Nominal voltage, 44

Non-isolated plant configuration, 54

Notice of protected rights, 4
Number format, 80, 97
Numerical
Key assignment, 87, 175
Screen keyboard, 167
Numerical value
Changing, 169, 178
Decimal places, 168
Display format, 178
Entering, 169, 178
Limit test, 168
Limit value test, 178

O

Office location, 5
Offline
Operating mode, 138
Recipe tag, 226
Test, 145
Online
Operating mode, 138
Recipe tag, 226
Test, 145
OP properties, 80
Device, 106
Memory monitoring, 136
Persistent storage, 98
Touch, 92
OPC server, 13, 28
Open
Control Panel, 79

MP 277 (WinCC flexible)
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Drop down list box, 175
Selection list, 86
Operating
Control Panel, 82
Feedback, 162
Key, 174,177
Loader, 74
Operating element, 174
Operator control, 86
Project, 161
Recipe screen, 227, 237
Slider control, 184
Switches, 183
Trend view, 187
With external keyboard, 162
With external mouse, 162
Operating element
Locking, 248
Operating, 174
Recipe view, 227
Simple recipe view, 235
Operating instructions
Purpose, 3
Scope, 3
Operating mode, 138
Changing, 138
Offline, 138
Online, 138
Transfer, 63, 138
Operating system
Configuring, 73
Safety instruction, 60
Update, 151
Update using ProSave, 154
Update using WinCC flexible, 153
Operation feedback, 162
Operator control
Memory card slot, 67
MP 277, 65
Operating, 86
Selecting, 86
Operator control options, 81
Optical feedback, 162
Option
Installing, 140, 155
Installing with ProSave, 157
Installing with WinCC flexible, 155
Removing, 140, 155
Removing with ProSave, 158
Removing with WinCC flexible, 156
Options, 28
Network operation, 80, 125

MP 277 (WinCC flexible)
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Overall dimensions
MP 277 10" Key, 254

P

Password, 197
Backing up, 198
Restoring, 198
Specifying, 94
Password list, 197
Password properties, 80, 94
Password protection, 75, 80
Activate, 94
Deactivating, 95
Windows CE taskbar, 75
PC/PPI
Cable, 23
Configuring the cable, 59
Setting the adapter, 59
PELV, 54
Peripheral
Rated load, 61
Permission in remote control, 194
Permissions in remote control, 196
Plant configuration
Non-insolated, 54
PLC
Number of connectable, 29
Protocol, 29
Reading recipe data record, 232, 240
Transferring recipe data record, 234, 241
PLC_User, 206, 207, 208
Ports
MP 277 Key, 257
MP 277 Touch, 255
Power failure, 146
Power supply
Configuration graphic, 53
Connecting, 53, 54
Printer
Configuration graphic, 62
Connecting, 62
Setting properties, 80
Printer connection
Setting, 102
Printer properties, 80, 102
Printing
Labeling strips, 69
Via network printer, 120
Process control phase, 137
Production sequence
Manual, 245
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PROFIBUS
Setting, 80
PROFIBUS DP
Setting, 113
PROFINET, 119
Addressing, 120
Connecting, 56, 58
PROFINET IO
Disabling direct keys, 117
Enabling direct keys, 117
Releasing, 80
Project
Closing, 208
in ProTool, 139
In WinCC flexible, 139
Offline testing, 145
Operating, 161
Reuse, 139
Testing online, 145
Transferring, 137, 140
Protected trademark, 4
Protection class, 44
Protective foil, 23
Protective measures
Static electricity, 264
Protocol
PLC, 29
Proxy
Server, 79, 125, 127
Setting, 79

R

Radiation
High frequency, 31
Radio interference, 34
Emission, 36
Rated load
Interface, 61
Reading out
Recipe data record, 232, 240
Rear view, 15, 17, 19, 21
Recipe, 218
Control, 219
Data flow, 221
Data record, 219
Field of application, 217
Functional scope, 27
Recipe screen, 222
Recipe view, 222
Synchronizing tags, 231
Recipe data record
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Creating, 227, 237

Delete, 230, 239

Editing, 229, 238

Entering, 244

Exporting, 242

Importing, 243

Reading from PLC, 232, 240

Synchronize with PLC, 229

Transferring to PLC, 234, 241
Recipe list, 223, 235
Recipe screen, 224

Operating, 227, 237

Overview, 224
Recipe tag

Offline, 226

Online, 226

Synchronizing, 225, 231
Recipe view, 222

Expanded, 222

Operating element, 227

Simple, 223
Recommissioning, 137
Record list, 223, 235
Recycling, 5

Regional and language settings, 80, 97

Regional settings, 97
Registered trademark, 4
Registry information
Backing up, 80
Registry Information
Backing up, 98

Regulations for the prevention of accidents, 31

Remote control
Forcing permission, 194, 196
Start, 194, 195
Removing
Option, 140, 155, 156, 158
Repairs, 248

Reset to factory state, 140, 153, 154

Restore, 79, 131

Restoring, 140, 146, 148, 150, 198

from external storage device, 133

From memory card, 79, 98
With ProSave, 150
With WinCC flexible, 148
Returns Center, 248
Reverse polarity protection, 54
RS-422/RS-485 interface
Configuring, 57
Ruler
Trend view, 187

MP 277 (WinCC flexible)
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S

S7 transfer settings, 80
Dialog, 113
Safe electrical isolation, 54
Safety
Functional scope, 27
Standards, 32
Safety instruction
Backlighting, 100
Changed tag name, 231
Cold restart, 105
Compeatibility conflict, 146
Compressed project file, 141
Damage to the HMI device, 49
Data channel, 152
Data loss, 131, 151
Direct key, 164
Electrostatic charge, 263
Equipotential bonding cable, 52
Grounding measures, 264
High frequency radiation, 31
Interface, 61
Keyboard, 66
License key, 146, 152, 155
Loss of data possible, 133
Memory card, first use, 68
Memory distribution, 107
Multi-key operation, 162
Path, 109
Power failure, 146
Preventing inadvertent operation, 247
Project file, 109
Recipe data record in background, 223
Remote control for channel 1, 115
Replacing the HMI device, 60
Storage, 37
Switching info text, 173, 181
Touch screen, 66
Transfer mode, 112, 117
Transfer mode channel 2, 117
Transport, 37
Unintentional action, 66, 176
Unintentional transfer mode, 116
Update operating system., 60
USB host-to-host cable, 60
Working on the control cabinet, 31
Safety regulations, 31
Scaling
Functional scope, 26
Scheduler
Functional scope, 28
Screen

MP 277 (WinCC flexible)
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Functional scope, 26
Screen keyboard, 79, 166
Alphanumerical, 170
Change layout, 83
Character repeat, 89

Configuring, 88
For Control Panel, 82
Keyboard level, 170
Language switching, 170
Numeric, 167
Representation types, 83
Screen saver, 101
Overview of functions, 80
Setting, 100
Screen settings
Changing, 80
Scroll back key, 86, 174
Scroll forward key, 86, 174
Search engine
Internet, 126
Secure mode, 77
Cancel, 77
Security settings, 79
Security system, 197
Selecting
Operator control, 86
Selection list, 172, 180
Open, 86
Service
In the Internet, 5
Service pack, 24
Set up
Network, 119
Secure mode, 77
Setting
Backlighting, 80
Browser, 79
Computer name, 80
Date, 95
Date format, 97
Date/Time, 79
Delay time, 80, 108
DIP switch, 57
Double-click, 91
E-mail, 80
E-mail connection, 125
Language, 165
MPI, 80, 113
Network, 122
Number format, 97
PC/PPI adapter, 59
Printer connection, 102
Printer properties, 80
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PROFIBUS, 80, 113 Status Force
PROFINET IO, 80 Touch operation, 189
Proxy, 79 Storage conditions, 37
Regional data, 97 storage device
Screen saver, 100 Restoring from external, 133
Time, 95 Storage device
Time format, 97 Saving to external, 131
UPS, 80, 109 Strain relief, 64
Volume, 80 Subnet mask, 122
Setting language, 165 Supply voltage
Setting the time zone, 95 MP 277 Key, 257
Settings MP 277 Touch, 256
Internet, 80 Switches, 183
Language, 80 Switching on
Regional, 80 MP 277, 63
S7-Transfer, 80 Symbolic value
Shift key, 87 Changing, 172
SHIFT key, 87, 175 Entering, 172
Shipping conditions, 37 Synchronizing
Shutting down Date and time, 96
HMI device, 64 Recipe tag, 225, 231
Side view, 14, 16, 18, 20 System, 107
Siemens HMI input panel options, 79 System alarms
Simple alarm view, 212 Parameters, 265
Simple recipe view, 223 System information, 80
Menu command, 236 LED, 107
Operating element, 235 System properties, 80
Simple user view, 199 Device name, 121
Slider control, 184 General, 107
Sm@rtAccess, 13, 28 Memory, 108
Sm@rtClient view, 193, 194
Monitoring mode, 193 T
Usage, 193
Sm@rtService, 13, 28 TAB key, 86, 174
SMTP server, 125 Tabulator key, 86, 174
Software options, 28 Tag
Sort order Functional scope, 26
Alarm view, 213 TCP/IP address, 122
Specifications Technical Support, 5
Display, 255, 256 Temporary files
Input device, 255, 257 Backing up, 98
Memory, 255, 257 Test
MP 277 Key, 256 For environmental conditions, 40
MP 277 Touch, 255, 256 Testing
Ports, 255, 257 MP 277, 63
Supply voltage, 256, 257 Text box, 167
Standard operating system, 13 Character mode, 174
Start Normal mode, 174
HMI device, 105 Text list
Static electricity Functional scope, 26
Protective measures, 264 Time, 79
Status / control, 188 Entering, 172, 180
Key control, 191 Setting, 95

MP 277 (WinCC flexible)
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Synchronizing, 96
Time format, 80, 97
Touch operation

Trend view, 187
Touch screen

Calibrating, 80, 92

Safety instruction, 66
Trademark, 4
Training Center, 5
Transfer, 137, 138, 141

Automatic, 142

Cancel, 63

Manual, 141
Transfer mode

Unintentional, 116

Via MPI, 112

Via PROFIBUS DP, 112
Transfer settings, 115

Channel, 115

Directories, 108

Overview of functions, 80
Transferring

License key, 140, 159

Project, 137, 140

Recipe data record, 234, 241
Transferring back

License key, 140, 160
Transport damage, 45
Trend view, 186

Key control, 188

Touch operation, 187
Trends

Functional scope, 28

Limit violation, 186

V)

UL approval, 33
Unintentional action, 66, 162
Unintentional transfer mode, 116
Update

Operating system, 151
Update operating system., 140
Updating

Using ProSave, 154

Using WinCC flexible, 153
UPS

Displaying status, 80

Setting, 80, 109
UPS properties

Configuration, 110

Current status, 111

MP 277 (WinCC flexible)
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USB device
Connecting, 61
Use
Conditions, 39
In residential areas, 34
Industrial, 34
With additional measures, 39
User data
Backing up, 198
Changing, 206, 207
Restoring, 198
User group, 197
User name, 124
User view, 198
Extended, 199
Simple, 199
Users, 197
Admin, 206, 207, 208
Changing, 202
Creating, key control, 203
Delete, 208
Logoff, 201
Logon, 200
PLC_User, 206, 207, 208

\Y

Value table
Trend view, 186
VBScript
Functional scope, 28
Volume, 103
Setting, 80
Volume & Sounds Properties, 80

W

Weight
MP 277 Key, 256
Weight of the MP 277 Touch, 255
WinCC flexible
Internet Settings, 80
WinCC flexible internet settings
E-mail, 125
Windows CE taskbar, 74
Password protection, 75
WINS, 122
Server, 120
Working on the control cabinet, 31
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